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Chapter 1. Environmental Informatics 

Dr. Zoltán Utasi 

This course is realized as a part of the TÁMOP-4.1.2.A/1-11/1-2011-0038 project. 

 

 

1. Foreword 

The textbook entitled Environmental Informatics is the continuation of Geoinformatic Applications the 

knowledge of which is required for the successful understanding and learning of this textbook. 

Based on the curricula in the geography masters, the Geoinformatic Applications introduces the fundamentals of 

digital map construction from presenting the theoretical bases through the vectorising of paper-based maps to 

the construction of simple thematic maps. It is an outline basically as only the essential information was 

included due to extent limits. 

The present textbook completes the previous one in several sections (e.g. regarding AutoCAD), however, 

several new applications are discussed as well (e.g. preparing digital elevation models). Moreover, those 

required working processes are overviewed that were regarded to be given (primarily the preparation of maps – 

starting from the mapping basics via the construction of raster maps to their georeferencing). Raster data 

analysis is discussed in more detail in accordance with the chapters of the textbook entitled “Analysing remote 

sensing data of satellites (Mika J. et al., 2011) written by the author of the present textbook. 

It presents basically the software AutoCAD and Arc View outlined in previous textbooks together with other 

software when their application is limited. 

2. Fundamentals of cartography 

As those analysing maps do not always have the basic information to read maps this chapter gives an outline of 

the fundamentals of cartography. Basic terms associated with projections are explained, the various possibilities 

of surface visualization are listed, profiling systems of maps together with the mapping surveys in Hungary are 

discussed. 

2.1. The fundamental question of mapping 

A map in a very simplified sense is the view of the Earth surface from above constructed on the basis of certain 

mathematic-geometric rules showing the relief and land coverage elements (e.g. vegetation, drainage network, 

roads, buildings) as well. â€śReality” cannot be simply redrawn on a piece of paper, the most important factor 
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impeding this is the shape of the Earth. The fundamental problem of map construction is how a sphere could be 

unfolded without crease. In simple, by no means - just imagine a flattened beech ball, it cannot be completely 

smoothed. Therefore mapping aims not to achieve â€ścreaselessness” (crease called distortion henceforward) 

just to reduce it as much as possible or to shape it in order to achieve defined goals. Since most of us cannot see 

the Earth from the space, we have no image of the real shapes, we see only their distorted image on the maps 

leading us to false pictures numerous times. Figure 1.1 visualizes a well-known more-or-less spherical form - a 

human head - unfolded into a plane on the basis of various mapping procedures. 

 

Figure 1.1: A human head in various projection types 

If these forms seem to be distorted then compare the different illustrations of the American double continent 

(Figure 1.2). 
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Figure 1.2: Illustration of North and South America in different projections 

None of these can be regarded good or wrong in absolute sense: all of them have different purposes. Differences 

are not so striking when smaller areas are depicted but great enough to make the work inaccurate of ignored. 

Before we proceed a few basic mapping terms have to be defined: 

• Base surface: the surface that is projected (e.g. Earth’s surface) 

• Image surface: the surface, on which projection takes place (either planar or spatial - discussed in more detail 

later) 

• Projection: the mathematic and/or geometric procedure on the basis of which the points of the base surface 

are matched with the points of the image surface unambiguously. (Unambiguous means in the mathematic 

sense that all points on the base surface are represented by one point on the image surface and vice versa.) 

2.2. Shape of the Earth 

2.2.1. Real shape of the Earth 

The real shape of the Earth is given by the surface that can be defined clearly along the boundary between the 

solid and gaseous (terrestrial surface and the atmosphere) and between the solid and liquid phases (oceanic floor 

and the water mass). It is a completely irregular form, however, thus its transformation directly into plane would 

be difficult (Figure 1.3). Relief differences of the surface (20 km between the deepest point of the Mariana 

trench and the peak of the Mount Everest) are insignificant compared to the size of the Earth (r = 6378 km) 

therefore elevations are measured not to the centre of the Earth but to a - seemingly - explicit, clearly defined 

surface, the level of the seas and oceans. 

 

Figure 1.3: Surfaces of the Earth 

2.2.2. Theoretical shape of the Earth 

When maps are constructed it is essential to know the accurate shape of the Earth as mathematic and/or 

geometric methods required to its projection can be determined only as a function of the shape. The shape of our 

planet is irregular, so called geoid that can be not or only with great difficulties transformed directly into plane 

therefore in a first step a simplification has to be made: surface elevation differences are ignored and we take as 

a basis a regular form that approaches reality as much as possible. If the planet was a body in rest with even 

mass distribution it would have a regular spherical shape due to gravity. None of the two conditions stand, 

however. Still assuming homogeneous distribution but taking the rotation of the planet into account a so called 

rotational ellipsoid would be obtained. This so called Newton type ellipsoid means a shape flattened at the poles 

and piking out along the Equator. Since this is only a theoretical shape (ignoring heterogeneity) the ellipsoid 

best approaching the geoid form cannot be determined directly, it can be deduced from numerous 

measurements. Therefore it was determined to be different at different time periods depending on the data and 

calculation methods available. The most important calculations are the following (Table 1.1): 
 

Name year of calculation semi-major axis oblateness 

Walbeck 1819 6 376 896 1/302.87 
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Bessel 1837 6 377 397.15 1/299.1518 

Hayford 1924 6 378 388 1/297 

Kraszovszkij 1940 6 378 245 1/298.3 

IUGG 67 1967 6 378 160 1/298.247 167 

WGS 84 1984 6 378 137 1/298.257 223 563 

ETRS 1989 6 378 137 1/298.257 222 101 

Table 1.1: Most important ellipsoids 

The rotational ellipsoid is regarded as the base surface hereinafter. In the course of map construction the 

transformation of Earth’s surface points into plane is made in two steps. First, the points (P) of the topographic 

surface (real shape) to be projected are connected - in theory - to the centre of the Earth with the so called 

leading straight (h). The point obtained in this way (P0) on the base surface (rotational ellipsoid) is projected 

onto the plane in the second step (Figure 1.4). 

 

Figure 1.4: Definitions of the shape of the Earth 

Significance of the different base surfaces is that different co-ordinates are obtained if the same surface point is 

related to different ellipsoids (Table 1.2). Differences seem to be not significant but in reality these few 

arcsecond differences mean several hundreds of metres in reality. 
 

Ellipsoid Geographical latitude Geographical longitude 

International 47° 17Â´ 32.9Â´Â´ 19° 36Â´ 09.6Â´Â´ 

Kraszovszkij 47° 17Â´ 31.0Â´Â´ 19° 36Â´ 12.5Â´Â´ 

WGS-84 47° 17Â´ 28.8Â´Â´ 19° 36Â´ 06.7Â´Â´ 

Table 1.2: Geographical co-ordinates of a given point on the Earth’s surface related to different base surfaces 

(Papp-VĂˇry Ă�. 2007) 

Due to the inhomogeneous mass distribution of the Earth, however, the so called geophysical level surface (the 

surface where gravity is equal) differs from the rotational ellipsoid creating the irregular shape called geoid. The 

difference of the two is measured as the geoid undulation (Figure 1.5). 
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Figure 1.5: Spatial differences in geoid undulation 

2.2.3. Determination of height above sea level 

In the course of mapping surveys in Hungary heights were measured to three different sea levels. 

The first was the base level of the Adriatic Sea meaning the mean sea level measured (1875) on the scale of the 

Morto Sartorio in Trieste (Italy). This location was chosen because Trieste was the largest port of the empire. 

Further base points were established in the interior of the country, however, only and the one in Nadap is found 

within the current borders. 

In 1960 the socialist countries changed their base level to the Baltic Sea adjusting to the Kronstadt pier in the 

Finnish Bay east of Saint Petersburg. This level is 67.47 cm higher than that of the Adriatic Sea. (This is why 

the height of the Kékes peak is 1015 m in older maps and 1014 m on newer ones - and partly due to rounding as 

well.) 

In 1994 Hungary accepted to change to the United European Levelling Network and thus to the base level at 

Amsterdam (only 14 cm below the Baltic one), however, its introduction is still in process. 

2.3. Projections 

Projection in mapping is the picturing of points, directions and figures of any rotational surface on another 

surface, plane or developable surface (Karsay F. 1962) 

2.3.1. Classification of projections 

Classification of projections can be made based on the following characteristics: 

• distortion 

• characteristics of mapping 

2.3.1.1. Classification of projections based on distortion 

When a spherical surface is illustrated in plane distortions appear. This includes the followings the value of 

which is given by the modulus: 

- distance (length) 

- angle (direction) 

- area 
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Projections can be classified into four groups based on distortion: 

- general distortion: all three quantities are distorted 

- area retaining: proportional in area while distances and angles are distorted 

- distance retaining (length retaining): area and angle are distorted and distance is proportional only in a certain 

direction, along lengths 

- angle retaining: angles are real, area and distance are distorted 

The grade of distortion of the three values is not independent from each other: decrease of one of them will 

increase the other two. Therefore those projections that are proportional in relation to one characteristic (area, 

distance and angle retaining projections) will distort the rest in high degree: they are applied generally to 

achieve a specific purpose (e.g. angle retaining projections in navigation). In the case of projections with general 

distortion all three values are increased only slightly therefore they are used in overview maps due to their 

values approaching reality. 

2.3.1.2. Classification of projections based on the characteristics of mapping 

Parameters of mapping are given by the following four aspects: 

Type of the image surface: 

- 3D: mapping takes place onto a sphere - distortion is minimal, these are the globes 

- 2D: mapping takes place onto a plane or onto a surface that can be projected onto a plane without crease - 

these are the maps. The image surface can be: 

- plane sheet → plane projection 

- cylinder surface → cylindrical projection 

- cone surface → cone projection 

According to the relative location of the base and the image surfaces: 

• hanging: they are distant away from each other with no touch or intersection 

• tangent: they touch each other in a point or along a line 

• intersecting: cross each other along one or two circles 

According to the orientation of the base and the image surfaces, i.e. the angle between their axes: 

• polar: they are parallel to each other, basically coincide with each other 

• transversal: perpendicular to each other 

• zenithal: they close an angle the value of which is between the previous two 

According to the method of mapping: 

• Perspective: can be prepared mathematically (with calculation) and geometrically (with projection lines) as 

well. Two subtypes can be separated according to the characteristics of the projection lines: 

• Parallel: projection lines are parallel to each other. If they reach the image surface in right angle then it is 

the orthographic type (orthogonal in other words), if they have any other angle with the image surface then 

the clinogonal type is obtained. 

• Central: projection lines diverge from a centre of projection the location of which in relation to the base 

surface (Earth’s surface) separates the following two subtypes: 

• external: outside 
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• stereographic: on the surface 

• internal: inside, except for the centre 

• central: in the centre 

• Conventional (in other words: non perspective or mathematic, or sinusoidal): it can be prepared solely in a 

mathematic way. 

2.3.2. Projection types 

Design of the grid network is very characteristic for the given projection types, these are discussed in this 

subchapter. 

2.3.2.1. Plane projections 

Plane projections are generally circular. Their most important characteristic is that distortion is the same in the 

same distance from the point of origin of the projection, i.e. objects with similar distance in the projection have 

the same distance in reality as well. 

In the case of the polar version, the pole is in the centre of the projection. Latitudes are circular, their distance 

depends on the type of projection. Longitudes are straights crossing each other with similar angles that are the 

same in reality. They are used generally to depict areas near the poles (Figure 1.6). 
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Figure 1.6: Stereographic polar tangent plane projection 

In its transversal version the Equator is in the middle (in the form of a straight line), used generally for the 

illustration of one hemisphere (Figure 1.7). 
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Figure 1.7: Stereographic transversal tangent plane projection 

2.3.2.2. Cylindrical projections 

Perspective and conventional cylindrical projections have different shape. The most frequently used versions of 

cylindrical projections have polar orientation. A common characteristic of these is that the longitudes are 

straight parallel lines and the distance between them depends on the method of mapping. Latitudes are 

perpendicular to longitudes forming rectangles in this way. The pole is either a section with the length of the 

Equator or cannot be depicted. These characteristics also apply to certain conventional cylindrical projections 

(Figure 1.8). 
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Figure 1.8: Mercator's projection 

Conventional cylindrical projections are variable in appearance. The projections most frequently used in 

military and civil topographic and cadastral mapping belong to them. The most important ones are the 

following: 

Gauss-Krüger projection 

The Gauss-Krüger projection is a transversally oriented, tangent, angle retaining cylindrical projection in which 

the Equator is uniform but depicts the surface in 6° wide belts (Figure 1.9). It was introduced to military 

mapping in Hungary at the beginning of the 1940s. 
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Figure 1.9: Situation of the ellipsoid and the cylinder in the case of the Gauss-Krüger projection and the 

developable dual angles 

United National Projection (EOV) 

The United National Projection is a zenithal oriented, intersectional, angle retaining cylindrical projection and it 

is the current official projection of civil mapping in Hungary (Figure 1.10). 

 

Figure 1.10: Location of the EOV (Varga J. 2005) 

UTM (Universal Transverse Mercator) 

The UTM projection is a transversal oriented, intersectional, angle retaining cylindrical projection (Figure 1.11). 
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Figure 1.11: Location of the UTM (Varga J.2005) 

Goode projection 

The Good projection is a complex projection type. The border between the Mollweide and Sanson projections, 

its components is the 40° latitude. All continents have their separate straight starting meridian thus the 

projection is divided into 5 or 6 parts. As it is area retaining and thanks to its dissection its distance and direction 

distortion are small it is used frequently to depict terrestrial features on global scale (Figure 1.12). 

 

Figure 1.12: Goode projection (Wikimedia Commons) 

2.3.2.3. Cone projections 

Cone projections have pie shape (all of the perspective type and the conventional types are similar as well) in 

the case of the most frequently used polar orientation the pole is located in the centre of the projection. It is easy 

to mistake it for the polar plane projections if only a part of it can be seen as the latitudes are circular while 

longitudes are straight. They intersect each other with similar but - different from plane projections - smaller 

angles than in reality (Figure 1.13). 
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They are very frequently used for maps with large scale (e.g. in atlases), generally central and low latitude areas 

are shown in them. 

 

Figure 1.13: Central polar tangent cone projection 

Following the overview of projections it is necessary to define the term scale (M) of maps. According to the 

popular but inaccurate definition: M = distance on map / real distance. As no maps are distance retaining in 

every direction (because it should be angle and area retaining at the same time) distances measured similar on 

the map will differ in reality. Based on this, the accurate definition is: M = distance on map / distance on 

projection. 

2.4. Segmenting 

Segments of topographic and cadastral maps (the area displayed) are not adjusted to natural or political 

boundaries (as in the case of most maps used in public) but the system is composed of map segments ordered in 

a well defined way. Requirements of segmenting: 

• Homogeneity: base surface, base level, projection, co-ordinate system, legend, contents of maps are the same 

in all segments. 

• Spatial continuity: joined without overlapping or gap, maps fill the entire area. 
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• Up-to-date: corrections, revisions are required at certain intervals. 

• Back-to-back state: members with different scale in the system are based on each other in the framework 

system, i.e. segments with greater scale form the mosaic of different size of the maps with smaller scale. 

Identification of the segments (geographical definition) can take place in two ways: on the basis of a segment 

number or segment name. Giving a name to a segment follows the following rules: 

• It may receive its name after the most significant settlement located in the segment or after any significant 

object (e.g. mountain peak) if no settlements are found in the segment. 

• Generally the name of two segments cannot be the same in a given scale (except for EOTR). If a settlement is 

divided on several segments then some kind of an indexing is required, like a segment called Cered and 

another segment called Cered (Szekrényke-puszta) are present. 

Naming the segments is simpler, however, less accurate as it may require significant topographic knowledge 

(e.g. it is difficult to determine the most significant denominative settlement for a user who does not know the 

area). 

Segment numbers define the location of the segment with the combination of letters and numbers according to a 

given system. This is more explicit although more difficult to use from certain aspects than the segment name 

(detailed knowledge of the system is necessary). Currently used and older segmenting systems in Hungary are 

overviewed in the followings: 

2.4.1. Segmenting system of military survey III (Austro-Hungarian Monarchy) 

The military surveys of the Austrian Empire and then the Austro-Hungarian Monarchy are discussed because 

these maps are still used today (e.g. studying changes of the land). 

The starting meridian of the survey was Ferro and the frame of the segments is given by the grid network (grid 

trapezes). Picturing was made on the following scales: 

- The scale of the initial segment is 1:200000, its size is 1° x 1°. This has no separate number. 

- The first deduced scale is 1:75000 obtained with the division of the initial segment into 2x4 parts. Numbers are 

obtained by the determination of the row and column (e.g. 1242), direction of numbering is east and south 

(Figure 1.14). 

- The second deduced scale is 1:50000, obtained by the N-S bisection of the previous segment (E, W). Its 

numbering: row-column-page (e.g. 1242 Ny). 
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Figure 1.14: Segmenting of the military maps of the Austro-Hungarian Monarchy 

2.4.2. Segmenting of the International World Maps (Gauss-Krüger projection 
system) 

The International World Map covers the entire Earth the starting meridian of which crosses Greenwich, its base 

surface is the IUGG/67 or the Kraszovszkij, its projection is the Gauss-Krüger (transversal, tangent, angle 

retaining cylindrical projection). The frame of the segments is given by the grid network (grid trapezes). 

- Scale of the initial segment is 1:1000000, its size: 6° x 4°. Its numbering is based on (hemisphere)-row-column 

(e.g. N-L-36). Direction of numbering: 

- Row: increases to the north and south from the Equator (A-Z) 

- Column: increases to the east from 180° (1-60) 

- In the case of the deduced scales the frame numbering of the first three (1:500000, 1:250000, 1:100000) is 

retained but the inner division is changed (Figure 1.15). 

- In the case of scales less than 1:100000 quartering is made in every steps, the location of these quarters is 

marked with retaining the frame number of the 1:100000 scale (Figures 1.15 and 1.16). 
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Figure 1.15: Segmenting system of the International World Map 
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Figure 1.16: Overview of the segments of the Gauss-Krüger maps with the scale of 1:100000 and the further 

division of the segments (Papp-VĂˇry Ă�. 2007) 

2.4.3. Segmenting of the United National Mapping Network (EOTR) 

The EOTR is used exclusively in Hungary, its projection is the EOV (United National Projection) that is a 

zenithal, intersectional, angle retaining cylindrical projection. Its starting meridian crosses Greenwich, its base 

surface is the IUGG/67. Its segments are framed by not the grid network but a kilometre network the starting 

point of which is the Gellért Hill, its numbering is shifted 651 km and 200 km to the west and south from the 

starting point respectively. 

- The scale of the initial segment is 1:100000 the size of which is 48x32 km. The segment number includes the 

number of the row (0 - 10) and the column (0 - 11) (e.g. 03, 56, 109, 910), direction of numbering is east and 

north (Figure 1.17). Two important differences compared to the rest of the systems have to be noted: 

- Numbering of rows and columns may start with 0 as well. 

- In case the number of both the row and the column is of one digit the segment number is composed of two 

digits but if one number is of two digits the segment number is of three that makes it hard to be interpreted 

sometimes. For example, 811 means row 8 and column 11, however, it could also mean row 81 and column 1: 

in this case the user have to know that the system is composed of only 11 rows! 

- Topographic deduced scales (from 1:50000 to 1:10000) are obtained by the repeated quartering of the initial 

segment (bisection in both directions). The segment number is obtained by the extension of the frame number 

with the number of the given quarter (e.g. 56-444) (Figure 1.17). 

- In the cadastral scale (under 1:10000) segments are still obtained by quartering and the segment number is 

composed according to the frame number - topography deduced scale - cadastral scale principle (e.g. 56-444-

444) (Figure 1.17). 



 Environmental Informatics  

 19  
Created by XMLmind XSL-FO Converter. 

 

Figure 1.17: Overview of the EOTR segments with the scale of 1:100000 and the further division of a given 

segment (Papp-VĂˇry Ă�. 2007) 

2.4.4. National segmenting 

Using the International World Maps discussed in chapter 1.4.2 is difficult in Hungary as the country is depicted 

in four 1:1000000 scale segments and the determination of the continuing segments is more complex at the 

corners (Figure 1.16). Therefore the segments are renumbered with retaining the parameters of the original map. 

This numbering is only valid for the area of the country. 

The initial scale is 1:100000 (like in the case of the EOTR as smaller scales are pointless), these segments are 

numbered with the row-column logic (like in the case of the military Survey III or the maps of the EOTR 

system), i.e. the segment number is composed of the row (1-9) and column (1-14) values (e.g. 113). Segment 

numbers have always three digits, the first representing the row value and the second and third indicate the 

column value - if the latter is smaller than ten it will start with zero (e.g. 506 represents row 5 and column 6). 

Deduced scales are obtained by quartering the initial frame, numbering is made according to the same logic as in 

the case of the EOTR (chapter 1.4.3). 

2.4.5. UTM (Universal Transversal Mercator) segmenting (NATO system) 

The UTM segmenting covers the entire World the starting meridian of which crosses Greenwich, its base 

surface is the WGS-84 and its projection is the universal Mercator projection (transversal, tangent, angle 

retaining cylindrical projection). Frame of the segments is given by the grid network (grid trapezes). 

- Scale of the initial segment is 1:1000000, its size is 6° x 8°. Its numbering is based on the row-column logic 

(e.g. T-33). Direction of numbering (Figure 1.18): 
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- Row: Increasing towards north from the South Pole (A-Z). 

- Column: Increasing towards east from 180°. 

Segments and numbering are differ a little at the poles. 

 

Figure 1.18: Segmenting of the UTM projection 

2.5. Content of maps 

Following the determination of the co-ordinates and the location of the projection of the points the elements of 

the surface are depicted. These elements can be the following: 

• Discrete elements: they have boundary lines. Their depiction is simple as the boundary line has to be 

depicted, measurement points have to be market on it (several or only a few in a unit section depending on 

curvature). In numerous cases, however, the boundary line of neighbouring well definable elements is not 

sharp, they have overlapping belts (so called fuzzy). For example in the case of detailed scale the boundary 

between a forest and a grassland is hard to be determined: the edge of the leafage or the trunk of the trees 

represent the boundary? 

• Continuous elements: elements with continuous distribution. Their depiction is more complex as the 

constructor of the map has to create value degrees with the help for example of isogons (lines connecting the 

points of identical values). Such lines â€śdo not exist” in reality. For example meteorological-climatological 

maps (precipitation, temperature, etc.), ethnic maps and the list could be extended. Relief also belongs to this 

category. 

Maps can be classified as follows based on their content: 

• Topographic maps: they show as many elements of reality as possible trying to achieve completeness 

(including for example relief, surface coverage, anthropogenic elements). 

• Thematic maps: highlights only one or some elements of reality (e.g. temperature map) or it contains deduced 

data (e.g. population density map where calculation is made on the basis of the ratio of area and population). 

• A special type of thematic maps is the cadastral map that contains basically the boundary of areas (parcels) 

and the points necessary for identification (e.g. triangulation points). 
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2.6. Relief illustration 

Most important task of relief illustration is to present the parameters of relief accurately. Specifics of the surface 

can be illustrated in two ways fundamentally: considering the height of surface or the angle of slopes. Generally 

different illustration methods focus on only one of these, the other cannot be or only hardly illustrated. 

2.6.1. Relief illustration by stripes 

Relief illustration by stripes was established in order to depict the quantitative characteristics of the surface 

accurately. The system founded by Lehmann in Prussia in the 18 th century was aimed for military purposes: the 

aims were the accurate depiction of slope steepness and good arrangement. 

Principle of illustration is striping parallel to the slope direction and with thickness proportional to slope 

steepness (Figure 1. 19). Based on these, gentle sloping areas remain white while steeper areas look darker due 

to dense striping (1.1. animation). The result is accurate and easy to read (even for a non-professional). 

Its disadvantages include the problem of depicting height above sea level: based on the principle, this cannot be 

determined (only sloping) therefore numerous height values help height orientation. These show generally the 

values of known places (peaks, road-junctions, important objects, etc.). Depicting land coverage also present a 

problem: due to dense striping map symbols almost shade into their surroundings or mask them out. The same 

causes make the depiction of plant cover also problematic. This latter was partly solved by applying colour 

technology (Figure 1.20). 

In summary the transformation of this method of illustration into vector digital files is very complicated (since 

digital elevation models require primarily the height values and sloping values are calculated from this by 

interpolation). Determination of vegetation boundaries is also problematic (as there is no boundary between the 

map symbols!). 

This type of illustration was replaced by relief illustration by contour lines (chapter 1.6.4) at the beginning of 

the 20th century but it was used for a long time. Figure 1.20 shows a partly updated segment: revision to contour 

line illustration was made north of the temporary country borderline represented by the red line while south of it 

the striping method is used. 

 

1.1. animation: Detailes of relief illustration by stripes 
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Figure 1.19: Relief illustration by stripes 

 

Figure 1.20: Map segment partly updated at the time of World War II 
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2.6.2. Topographic shading 

The principle of topographic shading is that light rays arriving vertically light the surface that is regarded to be 

homogeneous proportionally to slope steepness therefore steeper areas seem to be darker while more gentle 

slopes lighter (Figure 1.21). 

This makes an impression similar to striping but here filling is performed by homogeneous colouring. Its 

advantages and disadvantages are also very much the same as those of striping as it is simple to read, 

spectacular and slope steepness can be determined well, however, height is not depicted either (only height 

numbers at the most) and coverage can be depicted hardly as well. 

It is rarely used alone, mostly combined with height colouring. It is very difficult to vectorize this type. 

 

Figure 1.21: Topographic shading 

2.6.3. Height colouring 

Height colouring marks the surface with different colours for height classes (Figure 1.22). Boundary of the 

height zones is given by the line connecting the points of identical heights above sea level (asl.). Interval of the 

zones is not similar, it increases from the sea level (downwards as well). The reasons for this are on the one 

hand that one unit of height difference means greater change in lower heights and on the other hand that the 

primary area of human activity is found in lower heights, therefore their detailed presentation is justified. 

When selecting the colours the principle of progressivity has to be considered, heights become darker away 

from sea level (except for the dark green colour of dale-land) together with tradition on the basis of which 

lowlands are green, hills have yellowish brown and mountains brown colour. 

The number of zones (categories) is low generally (8-10) as the difference between the colour of neighbouring 

zones would be too small making their reading difficult. 

The method is generally applied together with a special type of topographic shading. Its advantage includes the 

easy determination of height asl. - within an interval - and it is easy to read and spectacular. Its disadvantages 

are the determination of slope angle is not possible and the difficulty in depicting land cover (with map symbols 

at the most). 

It is used frequently in the case of overview maps (e.g. atlases) but it cannot be used for detailed presentation 

(due to the limited number of categories). It can be vectorized, however, its application is limited (due to the 

small number of height zones). 
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Figure 1.22: Depicting relief with height colouring 

2.6.4. Depicting relief with contour lines 

Relief presentation with contour lines is still the most widespread method in detailed mapping as the elements of 

the Earth’s surface are illustrated in greatest ratio with this method. Contours represent the basis of depiction, 

contour lines connect the points of the surface that have identical heights above sea level (Figure 1. 23). 
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Figure 1.23: Relief depiction by contour lines 

Numbering of the contour lines always starts from seal level. It has several types (Figure 1.24): 

• Base contour line: its colour ranges from yellow to brown (occasionally black), it is a continuous thin line. 

Their height difference is the same. They cannot be broken, only in a few special cases (Figure 1.25). These 

are the following: 

• Deep linear form 

• Extended steep slope 

• Another map element masks it 

• Main contour line: base contours are thickened at certain - similar - height intervals in order to make 

readability simpler. Generally every fifth (e.g. in the case of 5 m base contour intervals the interval between 

the main contours is 25 m), however, if this would be not a round value main contours can have smaller 

intervals (e.g. in the case of base contour interval of 2.5 m every fourth is the main contour with intervals of 

10 m). Numbering of main contours also starts from the sea level. 

• Auxiliary contour lines: when orography requires (mainly in the case of small height differences in greater 

areas) the height interval of base contours can be halved by a bisecting auxiliary contour line (generally long 

dashed lines with colour and thickness similar to the base contours) or it can be quartered by a quartering 

auxiliary contour line (generally shorter dashed with colour and thickness similar to base contours). 
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Figure 1.24: Contour line types 

 

Figure 1.25: Types of contour line breaking 

The interval between base contour lines depends on the scale. It is sensible that with the decrease of resolution 

(decrease of scale) contours would become closer to each other and they would merge together at a certain 



 Environmental Informatics  

 27  
Created by XMLmind XSL-FO Converter. 

resolution therefore the interval between the base contours has to be increased. For example on International 

World Maps the base contour intervals are 2.5 m, 5 m and 10 m on the scales of 1:10000, 1:25000 and 1:50000 

respectively. 

Base contour intervals - and thus main contour intervals as well - are similar on most of the topographic maps 

therefore height determination is relatively simple. In contrast in the case of the EOTR the base contour interval 

depends on the dissection of relief. Base contour interval is 5 m, however, in extended, gentle sloping areas it 

changes into base contour intervals of 1 m (value of the bisecting auxiliary contours is 0.5 m). At the location of 

change the base contour is thickened and its value is written - increased attention, however, is essential to 

recognise it (in Figure 1.25 this change is seen in the lower part). In summary, this solution increases 

topographic accuracy but in the meantime it also increases the significance of map reading (Figure 1.26). 
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Figure 1.25: Change of base levels in EOTR maps (1.) 
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Figure 1.26: Changes in base contour intervals in EOTR maps (2.) 

Relief depiction by contour lines combines nearly all of the advantages of the methods discussed above 

(striping, topographic shading, height colouring): 

• Height above sea level can be determined accurately 

• Slope angle can be determined accurately 

• Land cover can be shown clearly 

Unfortunately the "price" of accuracy and completeness is readability: its usage requires practice and 

experience. 

2.7. Land cover and geographical names 

Relief is only one - doubtless important - element of reality, various elements are found on it that are called land 

cover. This includes both natural and artificial elements, biotic and abiotic environment as well. 

Showing vegetation depends on the purpose of the map. In certain cases the primary aim is to present the 

morphology: on overview maps (e.g. in atlases) when height colouring is used in order to illustrate surface 

specifics as much as possible the presentation of vegetation is very limited (with map symbols at the most). In 

the case of detailed maps it is a fundamental requirement to show vegetation. Fullness of representation, 

however, is variable: in contrast to the few categories of tourist maps available for the public (e.g. forest - 

bushes - area with low vegetation) survey maps can depict several tens of categories by colours and several 

dozens of vegetation types within them using map symbols. Generally the hue of colour corresponds to the 

height of the vegetation: from the dark green of forests through the middle green of bushes to the white of 

cultivated lands or grasslands. Exception is the orienteer map where hue represents the penetrability of the 

vegetation: darkest ones are most difficult and white areas are least difficult to overcome. 

Illustration of anthropogenic elements is also variable. Map symbols of linear elements (e.g. transport network) 

generally use colour, line thickness and type to show the specifics. Map symbols of buildings indicate their 

building material (e.g. type of brickwork, fire resistance) and their function. 

Names illustrate the specifics of the named object by their letter type, style, placing, colour, size. 

• Names of relief elements are generally parallel to the strike of the landforms, the letter size is proportional to 

the real extent of the form. 
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• In the case of rivers their names are oriented parallel to the rivers and their direction points - generally - into 

flow direction. Lake names are either parallel to the strike of the lake bed or horizontal. The names are mostly 

blue, however, other colours are also used. 

• Name of anthropogenic elements is generally horizontal their size and letter type are proportional to the size 

and significance of the given element (e.g. in the case of settlements letter size is increased and letter style is 

changed with the number of inhabitants and with the place of the settlement in the public administration 

hierarchy). 

2.8. Cadastral maps 

A special, however, widespread type of thematic maps is the so called cadastral (land surveying) map. The 

primary aim of this is to register property boundaries. Its content is very poor compared to topographic maps: 

only the boundary of areas, buildings and points necessary for orientation (e.g. triangulation points are shown). 

On certain versions contour lines also appear. 

The projection system of the cadastral maps used in Hungary today is the EOV (chapter 1.3.2.2), its segmenting 

is the EOTR (chapter 1.4.3). 

Cadastral maps of the non-built-up areas of settlements (Figure 1.27) show only the legally non-built-up areas 

while the built-up area of settlements remains empty (Figure 1.27). It contains not only the land register 

reference of the areas but the cultivation types as well. 

Cadastral maps of the built-up areas of settlements (Figure 1.28) contain the profile of buildings as well besides 

the borderline of plots. Apart from land register reference they may contain street-numbers as well. 

 

Figure 1.27: Cadastral map of non-built-up areas of settlements (section) 
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Figure 1.28: Cadastral map of built-up areas of settlements (section) 

2.9. Surveys in Hungary 

2.9.1. Military surveys 

The detailed systematic topographic mapping in the Austrian Empire - Hungary was part of it at that time - 

started in the middle of the 18th century with military purposes. Several survey series were completed by today, 

however, only military surveys I - III were complete as they covered the entire country in a - relatively - short 

period of time (Table 1.3). From the beginning of the 20th century only the update of the existing files was 

carried out, comprehensive operations were not performed. 
 

  
I II III 

Period of survey in the Hungarian Kingdom 

(without Transylvania, Croatia, Slavonia and 

the defended frontier region) 

1766-1785 1806-1869 1872-1884 

Scale of the complete survey 1:28 800 1:28 800 1:25 000 

Size of one segment 24x16 inch 

(63x42 cm) 

24x16 inch 

(20x20 inch outside Hungary) 

76x55 cm 

Size of the area depicted in one segment, km2 216 216 

(230 outside Hungary) 

261 
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Number of segments 963 1078 1353 

Unit fathom fathom metre 

Availability secret survey maps are secret, deduced 

maps are open 
open 

Table 1.3.: Overview of military surveys in Hungary (Papp-VĂˇry Ă�.) 

2.9.1.1. First military survey of Hungary (Josephinian map) (1766 – 1785) 

The first military topographic mapping that depicts the entire historical Hungary below settlement level. The 

scale of 1:18800 of the maps constructed in fathom system is explaneed by that 1 inch on the map equals 40 

fathoms in reality (1 Vienna fathom (1.8964838 m) = 6 feet, 1 foot = 12 inches, i.e. 40x12x6 = 2880). Relief is 

shown using stripes, the maps also contain hydrological elements (rivers, lakes, roads, settlement and 

geographical object names and the cultivation type of agricultural areas just for information. The survey was not 

united in the empire so it is composed of separate sections and the location of the survey was determined by the 

risk of threat (this is why Silesia was completed first) (Figure 1.29). Accuracy of the work without a projection 

system is satisfactory in general within the individual segments, however, at the connections significant 

differences (up to 200 metres) are also found. No height measurements of levelling were performed in the 

course of the survey and the maps contain no height data. Georeferencing of the maps is very complicated due 

to its inaccuracy. 

 

Figure 1.29: The Josephinian military survey (Arcanum) 

2.9.1.2. Second military survey in Hungary (Franciscan map) (1806 – 1869) 

The second survey was performed on the basis of the Josephinian maps, they were actualized and corrected 

(Figure 1.30). The survey was ordered by Francis I in 1806 as the effect of the war with Napoleon. The aim was 

to compile maps where the survey and depiction of the empire are performed according to united principles. 

Cassini’s projection and segmenting system was used with slight modifications. This is as a matter of fact, the 

Cassini-Soldner projection due to its inaccuracy it is frequently referred to as the system without projection. 
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The second triangulation base point network of Hungary was established in this time period. This served as the 

basis for both military topography and civil cadastral mapping. Out of the ten systems of the Empire three 

covered the area of Hungary (Figure 1.31). Height measurements were also carried out. 

The map is extremely difficult to read at places due to the method of the dark tone relief depiction. Its 

georeference, however, is easier - due to its higher accuracy - than that of the previous one (Figure 1.32). 

 

Figure 1.30: The Franciscan military survey (Arcanum) 
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Figure 1.31: Systems without projection in Hungary (Varga J., 2005) 
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Figure 1.32: The area of Battonya on the maps of the first and second military surveys 

2.9.1.3. Third military mapping in Hungary (Franciscan-Josephine map) (1872 – 1884) 

The maps were constructed following the introduction of the metric system therefore their scale is different from 

the 1:28800 applied before (in the case of both the Josephinian and Franciscan maps). The introduction of the 

scale 1:25000 into military topographic mapping turned out to be long-term, still applied today. The second 
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triangulation base point network completed between 1808 and 1861 was used with appropriate increase of base 

point numbers. Its method of depiction is different from the previous two surveys as graphic data related to 

relief and drainage network have smaller significance. In the meantime, the most important road names and 

object symbols occur on the maps together with height data. 

2.9.1.4. Recent topographic maps 

Military and civil mapping after harmonizing until World War I, separated sharply following World War II. The 

aim was to establish two completely independent systems that are not compatible to each other. 

At the beginning of the 1940s military high command decided to introduce the Bessel ellipsoid based Gauss-

Krüger projection in which topographic maps were published only in German prior to World War II. Following 

the war the system was changed to Kraszovszkij ellipsoid. Survey maps were prepared on the scale of 1:25000 

with international segmenting (chapter 1.4.2) and of course areas over the border were also shown in the 

segments. 

Civil mapping also established its own system. This was also based on the Kraszovszkij ellipsoid but it applied 

stereographic projection and a segmenting different from the military one (chapters 1.4.3 and 1.4.4). Areas over 

the border were not shown. Following the regime change in 1990 the United National Mapping System used 

exclusively in Hungary (and its projection, the EOV) became the official system and contents of maps were 

started to be transformed into it. At present the transformation is complete but map contents have not been 

updated therefore it is possible that the â€śmost recent” EOTR map of an area was constructed in the 1990s but 

it is based on data taken from 20-30 years older maps! Areas over the border are still white patches. 

The European Union brought changes in mapping as well: the new ETRS 1989 LAEA standard will (may) 

become the official mapping system of the member states in the future. 

2.9.2. Cadastral maps 

The first cadastral survey in Hungary was ordered by Joseph II and carried out between 1786 and 1789. It was 

slow due to the opposition from the nobles as they feared the data would be used for their taxation as well. Later 

the survey came to a halt and the already prepared maps were destroyed after the death of the king. 

The second cadastral survey was carried out between 1856 and 1894 on the scale of 1:2880 in the fathom 

system. The reason for the 1:2880 scale is that 1 inch on the map equals 40 fathoms in reality and 1 Vienna 

fathom (1.8964838 m) = 6 feet, 1 foot = 12 inches, i.e. 40x12x6 = 2880. 

The third cadastral survey was performed between 1900 and 1938 still in fathom system and on the scale of 

1:2880 (1:1440 in towns). 

Following World War II the change to the metric system took place in civil mapping as well. The new cadastral 

maps are constructed in the EOV system on the scales of 1:8000, 1:4000 and 1:2000 (see chapter 1.4.3). 

Controlling questions 

Self controlling questions: 

What projection systems are used in Hungary as well? 

What segmenting systems are used also in Hungary? 

What advantages and disadvantages does contour line relief depiction have? 

Test: 

Which name means base surface (ellipsoid)? 

a, Gauss-Krüger 

b, Kraszovszkij 

c, Goode 
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What relief depiction method was used in the course of military mapping I and II? 

a, Striping 

b, Contour lines 

What is the meaning of cadastral map? 

a, Military topographic map 

b, Base map for land registering 

3. Preparation of map files 

The chapter discusses the practical issues of transforming paper based maps to raster digital format, the frequent 

errors of vector files and the basics of georeferencing raster map files. 

3.1. Data sources 

Object data can be acquired from several sources that can be classified into two groups regarding originality: 

primary and secondary data acquisition methods. 

Primary data acquisition methods include all methods in which determination of the parameters of the objects 

and the Earth surface is direct. Sources can be the following: 

• traditional land geodesy 

• Satellite positioning 

• Remote sensing 

• Photogrammetrics 

In the course of secondary data acquisition maps composed on the basis of field survey are conversed 

(reworked, modified) - occasionally at several times - using the following methods: 

• Manual scanning already existing maps (raster) 

• Manual digitizing of existing paper based maps (vector) 

• Takeover of existing digital maps (raster, vector) 

• Data derived from existing digital data (e.g. runoff, slope orientation and inflection maps, raster, vector from 

digital elevation models) 

Secondary data acquisition is always accompanied by data loss (regarding accuracy and content completeness as 

well) the minimizing of which is among the most important aims. With the number of conversions the problems 

increase. For example the repeated processing of a scanned, modified and printed map in a publication shall be 

avoided, the original source should be used. 

3.2. Transforming paper maps into raster format 

One of the most frequent preparations in our work is the digitizing of the paper maps resulting in a raster file 

that will be the basis for further work processes (e.g. vectorizing). 

3.2.1. Scanning paper maps 

The sub-chapter discusses the problems of scanning and their possible solutions. 

3.2.1.1. Preparation of paper maps 
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Paper maps require careful handling before scanning. Most frequent problems and their possible solutions are 

the followings: 

• The map is folded or even torn: due to improper storage the paper is not flat completely and this may result in 

distortion. The most frequent types and reasons of this: 

• The map was stored rolled up in a cylindrical form: rolling it u pin the opposite direction can flatten the 

map to a certain degree. 

• Bent along an edge: this can be reduced by preliminary pressing at best and it is almost impossible to 

eliminate completely. If multiple bending took place with crossing edges significant folds can appear in the 

cross-points the smoothing of which is very difficult. 

• Irregularly folded: only preliminary pressing may help, however, perfect results cannot be expected. 

• Torn map sheet: if possible (e.g. not a piece from a museum) stick the pieces together, however, perfect 

joining cannot be expected. 

• Up-warped due to moisture: curliness can be reduced by pressing at best. 

Please, note that similar scanning of a given map sheet cannot be performed twice (as some kind of folding 

appears even if the maps handled with maximum care). 

3.2.1.2. Original scanning of map sheets 

In the course of scanning maps the size of the sheets presents the greatest problem as using the most frequent 

A/4 sized scanners the maps of average size can be scanned only in parts (in the case of a normal topographic 

map this can be 8-10 parts) and at the subsequent adjustment of the parts errors arise almost every time (for 

reasons and possibilities see later). Using a larger scanner can be a solution, however, this increases the costs as 

well: even the A/3 size (more expensive by a magnitude) is not enough and the A/0 size scanning means two 

magnitudes greater cost. 

Besides the size of scanning the rest of the parameters are important, however, not as mush as in the case of 

scanning photos for example: resolution is adequate until a maximum 600 DPI, colour depth is not important (as 

maps contain less colour compared to photos). Software modification of the scanned image could be important, 

like reducing granularity or - if necessary - increasing contrast. In the case of publications with less quality 

granularity caused by the printing technology is visible at high resolution and increases the size of the file 

unnecessarily. The following figure series (Figures 2.1 - 2.4) show the same map segment modified by various 

techniques. Readability differences among the versions are visible: since increasing the contrast increases file 

size as well we have to find the optimum solution. In practice the solution shown in Figure 2.3 is the best 

generally. 
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Figure 2.1: Map part scanned with default settings 

 

Figure 2.2: Map part scanned with increased contrast 

 

Figure 2.3: Map scanned with reduced granularity 
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Figure 2.4: Map part scanned with reduced granularity and increased contrast 

In the case of uncompressed format (e.g. bmp format) there is no significant difference between the sizes of the 

files. However, in the case of compressed format the difference can be significant: considering the sample files 

the increased contrast version (Figure 2.2) is one and a half times while the granularity reduced versions 

(Figures 2.3 and 2.4) are half as great as the default one (Figure 2.1) 

3.2.1.3. Repeated scanning of map sheets 

It is possible that the original scanning produces a file of poor quality therefore a repeated scanning of the map 

would seem to be sensible. This presents a problem if the original version has already been processed (e.g. 

vectorizing was performed on its basis). In this case the replacement of the map is very difficult: it is almost 

impossible to crop exactly the same part therefore even if the positioning of the map was according to known 

points the new one will not cover the original one completely (e.g. due to the folding mentioned before). Due to 

the above it is possible that though a part of the vectorizing had been completed based on the map to be replaced 

then this map is replaced by the new version but its content (lines, points) do not fit exactly to the vectorized 

objects. In conclusion repeated scanning is only recommended if no processing has been performed. 

Figure 2.5 shows digitizing on the original base map: vectorized lines overly exactly the lines of the map. 

Figure 2.6 illustrates the same vectorized elements placed onto a re-scanned and inserted map: some lines 

overly exactly the original lines while others (especially in the central part of the map) do not. 
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Figure 2.5: Vectorizing on the original map 
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Figure 2.6: Original vectorized content on a re-scanned map 

3.2.2. Joining raster (digital) content 

In case the map cannot be scanned as a whole there are several possibilities to join the parts. 

• Effective merging of the raster files that can be performed either: 

• manually or 

• automatically 

• Placing each image beside each other in a vectorizing software 

3.2.2.1. Effective merging of raster files manually 

Manual merging means in practice that the size of the first part is increased in order to place the rest of the 

pieces beside it - using the measure taken by the eye. This procedure requires great care as the pieces were not 

scanned in exactly the same position: it is virtually impossible to place the map on the scanner at exactly the 

same position, it will rotate towards the left or right compared to the previous position. In the course of the 

merging the parts have to be rotated the grade of which has to be determined very accurately. (At the same time 

rotation always involves the deterioration of image quality!) Even at greatest care the maps will not fit perfectly 

to each other: the map folds a bit differently at each time it is placed onto the scanner and this cannot be 

eliminated. According to the experience of the author, however, if the map is handled with care (spare them 

from folding - e.g. they are not folded, only rolled up to a cylindrical form) this type of joining yields reasonable 

results. Discussing image editor software is not included in the aims of this textbook (due to the limited extent) 

but any software of reasonable quality is capable of the task (e.g. Paint Shop Pro, Adobe Photoshop). Figure 2.7 

shows the limits of manual merging: on the left side of the figure fitting is accurate while on the right side 

certain lines are drifted. 
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Figure 2.7: Errors of completely manual merging (Paint Shop Pro) 

3.2.2.2. Effective merging of raster files automatically 

For this any general image editor software that supports the making of panorama images or any special software 

designed especially for the purpose (e.g. Panorama Factory) can be used. The procedure is based on that the 

software merges the images on the basis of finding identical points on the overlapping parts of the images. In the 

course of the rubber-sheet procedure the images are distorted until they fit perfectly. This procedure in theory 

able to eliminate errors not only of different positions but of folding as well, however, according to the 

experience of the author the overlapping zone is frequently ghost image. This not striking in the case of photos - 

for the merging of which the software is designed - but in the case of the linear elements of maps this is 

confusing. More detailed discussion of this procedure would exceed the limits and the fundamental aims of this 

textbook. Figure 2.8 shows the automatic fitting of the area presented in the previous sub-chapter (Figure 2.7): 

connecting points are more accurate but the image is much noisier, less clear. 

 

Figure 2.8: Automatic fitting (manual document merging option, Panorama Factory) 

3.2.2.3. Fitting image sin a vectorizing software 

In simple cases merging can take place virtually as well, i.e. the parts are not merged in reality they are only 

placed next to each other at the appropriate position in the given vectorizing software. In the case of AutoCAD 

discussed in the textbook the image parts are measured and positioned separately (see chapter 10.3 of 

Geoinformatic Applications). This method may cause problems in the overlapping parts as these parts do not 

overlap each other accurately (due to the reasons discussed in the chapter on scanning, e.g. due to the folding of 

the paper) therefore it is important which parts the vectorizing were based on. 

3.2.3. Determination of the segment of maps 

Either a map was scanned in one or in parts we have to decide whether the frames are needed or not. There are 

arguments pro and contra so decision shall be made following the careful analysis of the exact task. 

Arguments for retaining the frame: 

• The frame of a map contains numerous important information the more important of which are: 

• Segment name and number: less important as they can be displayed in the file name. 

• Neighbouring segments: also less important as they can be looked in an overview map at any time. 

• Values of the grid (degree, kilometre): very important as they are required for the appropriate positioning 

of the maps (georeferencing). Very few or no data related to this can be found in the inner parts of the map. 

• Complementary maps (overview maps, data survey maps, etc.) may contain numerous useful information. 

Arguments against retaining the frame: 
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• Increases file size. 

• Wide overlapping areas will occur when neighbouring maps are joined and these cover each other. This can 

be disturbing in the course of vectorizing (can be eliminated by changing their order in AutoCAD). 

• Results in inaccuracy in the case of georeferenced maps. This can be explained by that georeferencing is 

based on t he co-ordinates of the corners related to the map. When the map has a frame co-ordinates are 

shifted and cannot be given accurately. 

Figure 2.9 shows the vectorizing of the inserted map first: lines run exactly until the frame of the map while the 

frame is visible on the map itself (with the values of the grid and kilometre network). Figure 2.10 presents the 

neighbouring map - from the east - on top: lines digitized from the other map and running until the edge of the 

neighbouring map are clearly visible. The lines could be continued but the frame of the overlying map masks the 

western margin of the map below. 

If we decide to cut the framed we have to consider that the sides of the maps will not be exactly vertical and 

horizontal (as in most segmenting systems the grid network gives the border of the segments, except for the 

EOTR system) therefore a belt without map content will remain. 

 

Figure 2.9: Neighbouring segment underneath 
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Figure 2.10: Neighbouring segment on top 

3.3. Preparation of the original raster files 

The textbook discusses in brief the preparation of the satellite image from the popular Google Earth Internet 

service that is available for anyone for free and suitable for several types of analysis. 

Following the start of Google Earth set the image so that it includes as much information important for us as 

possible. Steps of the setting are the following: 

• Increase the image to the greatest available size as only the part that is currently visible will be saved. To 

achieve maximum size open the window to full window size and close the windows within the software like 

the left side column (seek, locations, layers can be found here) (Figure 2.11). 

• Switch off every layer that is unnecessary or disturbing regarding future analysis (as they mask out a part of 

the image). Such are for example the signs of various links (photos, videos, webcams, etc), alternative 

geographical names, etc. Layers that would help our future work shall be retained, like traffic network (roads, 

railways), borders, etc. 

• If there are several features making analysis difficult on the latest version (e.g. cloud cover, snow cover) 

select an image from an earlier date. 

• Finally, set the required segment (zoom). 

Following these save the image using the command File → Save → Save Image… (Figure 2.12). 
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Figure 2.11: Window of Google Earth with various layers and the side column 

 

Figure 2.12: Satellite image of a study area set properly (Google Earth) 

3.4. Problems of vector files 

Vector digital maps are prepared mostly by digitizing paper maps and in a smaller extent directly from the data 

of field survey (characteristic mainly for recent times). Errors may occur in the course of digitizing (vectorizing) 

the paper maps or they may arise from the improper digital database 

3.4.1. Errors in vectorizing paper maps 

Vectorizing from paper maps may take place using single or multiple conversion. Single conversion means that 

vectorizing is performed directly from the paper map (e.g. on a digitizing table) while multiple conversion is 

based on a scanned map (on screen digitizing). Each conversion results in data loss and accuracy decrease, in 

several cases the digital map shows serious errors or differences to reality. Several problems may arise in both 

methods, these are overviewed in this subchapter. 

Errors in the course of digitizing are made mostly by the person performing the process while other errors occur 

from using improper paper maps. Since errors made by the digitizing person can vary in a wide range only a few 
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typical errors are discussed. Corrections can be performed in the course of vectorizing (in the case of apparent 

errors) or in the course of a field survey (simple survey or if this is not enough on the basis of measurements)  

• A frequent error is that the common borderline of two objects do not cover each other, there is a gap or 

overlap between them. Figure 2.13 shows an example where the borders of a lot boundary and a road do not 

cover each other. (The illustration is from an official database showing that careful control is necessary even 

in the case of theoretically completely reliable datasets.) 

• Missing lines also represent a large portion of errors. This type of error is much more frequent in datasets 

where vectorizing was performed using the line segment type instead of the multiline or - if necessary - the 

polygon type. Figure 2.14 presents an apparent error like this where the result of careless vectorizing is that 

the sides of a building are missing! 

 

Figure 2.13: Error in the base map: overlapping areas (lines) 

 

Figure 2.14: Error on the base map: lines are not closed (AutoCAD 2009 software) 
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Independent from the person performing the vectorizing errors may arise even at greatest care that are not the 

fault of the digitizing person but result from the changing of reality. Some of such changes are the following 

without demanding completeness: 

• Changing of the relief (e.g. as a result of mining or earthwork). 

• Changing of the land cover: e.g. changing of the vegetation is frequent. 

• Changing of the cadastre content (lot boundaries) (due to for example fusion, division, boundary 

modification). 

• Changing of the buildings: administration of building built or demolished illegally can be late, detection of 

objects built without permission or in a form that was not permitted is not a simple task. 

3.4.2. Digital datasets with improper data structure 

Serious problem is presented by the improper use of the tree object types (point, line, polygon) and this is 

independent from the - above mentioned - accuracy. Most frequent errors are: 

• Line segment instead of multiline: linear objects are only seemingly continuous lines, they are as many 

objects as the number of their sides (number of breakpoint minus one) (see chapter 5.1 of Geoinformatic 

Applications). In such cases significant difficulties arise during geoinformatic data analyses. Some of these 

problems are the following: 

• The number of data in the attribute table has to be the same as the number of line segments (e.g. in the case 

of a road drawn with 1000 breakpoints the number of the road has to be attributed to it 1000 times)! 

• Certain queries are much more difficult (e.g. the length of the road mentioned before can be determined 

only if the length of each segments is queried and then summed). 

This is frequent in the case of older utilities maps or cadastral maps. Automatic solution is only available in new 

softwares. In the case of old ones only manual re-digitization can solve the problem (this can be made faster and 

more accurate with using the Osnap function - see chapter 4.5). 

• Line instead of polygon: spatial data cannot be attributed to the object. (In recent geoinformatic softwares a 

function building area /polygon/ from lines is included.) 

3.4.3. Data structure errors 

Inaccuracy may occur when data are classified. Errors occur mostly due to poorly defined classes when a given 

element can be classified into several groups and only the person taking the data decides in which group it is 

included. 

Correction can be made using various automatic procedures, however, these are available only in more recent 

softwares therefore this error mostly requires systematic personal work to be corrected. 

3.4.4. Georeferencing 

Georefferring in the closer sense means the attribution of co-ordinates to the image without them. However, this 

in itself is not enough generally and the image has to be transformed to make distortions appropriate for the 

selected projection type - this process is called rectification. As a consequence, the wider sense of 

georeferencing is applied in practice: meaning not only the attribution of co-ordinates to the image and placing it 

into a projection system but also the transformation between different projection systems. 

Arcview on its own is not suitable for georeferencing for this the module image Warp 2.0 is also required that 

can be downloaded for free from the homepage of ESRI. However, the module works only if the extension 

called Spatial Analyst is installed. Following installation make sure the extension is switched on (by ticking 

Image Warp and JPEG (JFIF) Image Support in the window File → Extensions)! 

The process of georeferencing is presented in the textbook on the example of the transformation of a satellite 

image (for the preparation of this see sub-chapter 2.3). The procedure of transformation between maps of 

different projection systems is practically the same. For the procedure a file with known projection system - 
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already georeferenced - is required called reference map (or reference in short) henceforward apart from the 

raster file to be transformed. In the course of the transformation a mathematical function is determined that 

connects the co-ordinate system of the image and the map on the basis of the given connection points (GCPs, for 

details see later) (2.1. animation). 

 

2.1. animation: The process of georeferencing 

3.4.4.1. Opening the files 

Following the start of ArcView select the command ImageWarp → ImageWarp Session (Figure 2.15). 

 

Figure 2.15: Starting ImageWarp 

In the ImageWarp Session Setup window (Figure 2.16) set the following files: 
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• Image to be rectified: raster file to be transformed. 

• Theme to rectify to: reference theme (shape or image), this can be vector file as well as raster file. 

 

Figure 2.16: Initial step to open the file to be rectified and the reference image 

In the file selection pop-up window appearing after clicking on the folder sign (Figure 2.17) make sure the Data 

Source Types are given. These can be the following: 

• Feature Data Source: vector file (point, line, polygon) - possible formats are e.g. shp, dwg 

• Image Data Source: raster file 

• Grid Data Source: Grid (rectangle) elevation model 

• TIN Data Source: TIN (irregular triangle) elevation model 

• Image Analysis Data Source: result of image editing (raster) 

If the setting of the data type is missed we might will not be able to see the required file - for example when 

selecting the reference file (theme to rectify to) the default option is the Feature Data Source therefore the raster 

file of the reference map cannot be seen in the list. 
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Figure 2.17: Selecting the file to be rectified and the reference image 

After setting the sample files the file selection window is presented in Figure 2.18: 

 

Figure 2.18: File to be rectified and the reference map are selected 

After accepting the selection the setup of the projection system is next in the Set Projection window (Figure 

2.19). Older software versions do not include EOV, the official Hungarian system. The EOV is a plane co-

ordinate system therefore accuracy will be acceptable without its setup so select option No. 

 

Figure 2.19: Co-ordinate system setup options 

3.4.4.2. Setting connection points 

Next is the Table of connection points (identification points) (Figure 2.20). In the Load Ground Control Point 

Table window select the New GCP Table option and clicking on the folder sign select the location for save. 
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Figure 2.20: Setup of connection point save 

Three windows appear after this (Figure 2.21): 

• FROM: the map to be georeferenced 

• TO: the reference map 

• TO** * * ROAM: identification points on the reference map. 
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Figure 2.21: Windows for setting the connection points of the map to be georeferenced and that of the reference 

map 

Always data pairs have to be selected in the course of the procedure - this is the case in all similar software. In 

the course of selection only the toolbar of the Image WARP 2.0 window is used (Figure 2.22)! In the later 

description the position of the buttons is given in row/column format, i.e. the left upper icon is marked 0/1 - due 

to the shift as a result of the different size of the buttons the upper column numbering applies only for row 0 and 

the lower is for rows 1-3. 

 

Figure 2.22: Toolbar of ImageWarp 2.0 (for explanation of each buttons see the text) 

Select the identification point in the TO window first using the GCP Pick Tool (3/1 on Figure 2.22). For 

navigation on the reference map the 1/2 - Pan, 2/2 - Zoom Out and 3/2 - Zoom In buttons (Figure 2.22). After 
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selecting the point by a left click the software asks whether the point can be saved (Figure 2.23) - apparently 

accept (Yes) or cancel (No) in the case of false selection. 

 

Figure 2.23: Confirmation of the saving of the selected point 

After accepting the point a small cross appears on the image with the number of the GCP point next to it. In the 

next step find the same point in the FROM window on the map to be georeferenced and then select it with the 

GCP Pick Tool icon (3/1 button in Figure 2.22) similarly to the above. The software asks again if the point can 

be saved (Figure 2.23) - apparently accept it or cancel. Following this, another cross appears here with the same 

number as on the reference map (TO) (Figure 2.24). If the number of the two points selected on the map to be 

georeferenced and on the reference map for the same position differ, an error was made in the selection. The 

most probable reasons for this are the following: 

• Selection was made first on the FROM map: points â€śshift by one unit” (e.g. for point 2 on the FROM map 

point 1 on the TO map is connected) - this will not make future procedures impossible but will yield 

completely wrong results. 

• Zooming is set alternately in the two windows (FROM and TO) and the point is selected after this: numbering 

will be shifted again as above or points are not even saved. 

The appropriate location has to be set on the TO map first then the GCP point has to be selected and then the 

same procedures can be performed in the FROM window as well! In the course of the procedure identification 

points are visible in the TO** * * ROAM window as well. When the identification point is selected the other 

window will be active automatically. At least four points have to be selected, however, the greater is the number 

of selected points the more accurate transformation will be achieved. Generally 10 points yield reasonable 

results. Make sure that the points are scattered on the complete area of the map. This is difficult in many cases 

due to the lack of clearly identifiable points (e.g. in the case of extended continuous vegetation cover). 
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Figure 2.24: GCP points on the map to be georeferenced (FROM) and on the reference map (TO) 

(identification points in the centre of the image are marked by 9) 

After the selection of each points the accuracy of selection can be controlled by using the Calculate from GCP 

button (0/1 button in Figure 2.22). The point selected in the TO window appears in the calculated place in the 

FROM window. If the point given by us is located further away from this point we can either delete or correct it. 

For correction use the Select Tool button on the ImageWarp panel (2/1 button in Figure 2.22) select the GCP to 

be moved then after pushing the Move button (1/1 button on Figure 2.22) click on the spot where we want to 

move the point to. 

After giving the appropriate number of points, calculation of the RMS Error (Root Mean Square - average error) 

is next. This reveals the number of errors in the course of the transformation and this has to be less than the half 

of the resolution in the ideal case. Generally the value around maximum 1 is appropriate, however, in certain 

cases 2-3 can be accepted as well. In the Choose Order window (Figure 2.25) appearing after the Calculate 

RMS button (3/4 button in Figure 2.22) was pressed the software asks the order of polynomial to be used for 

georeferencing. In case the GCPs cover only a small area of the map higher order than three is pointless because 

greater accuracy would be achieved around the GCPs but errors would be very significant elsewhere. Let’s 

select first order polynomial as an example. 

 

Figure 2.25: Selection of polynomial order 

In the window appearing after pressing OK the grade of RMS error becomes visible (Figure 2.26). 

 

Figure 2.26: Grade of RMS error 



 Environmental Informatics  

 57  
Created by XMLmind XSL-FO Converter. 

After pressing OK the software offers the saving of the values into a Report File - we can save them if necessary 

(Figure 2.27). 

 

Figure 2.28: Preparing a report 

Grade of error could be decreased by deleting the points with greatest error from the GCP table. For this open 

the GCP table (Figure 2.28), identify the highest XError and YError values using the Toggle beetwen Table and 

Views button (button 2/4 in Figure 2.22) and select them on the map. Press the Delete Selected GCP button 

(button 1/5 in Figure 2.22) on the ImageWarp panel and finally re-calculate the RMS error. 

 

Figure 2.28: parameters of GCP points 

3.4.4.3. Transformation of the map to be georeferenced on the basis of the given parameters 

As a closing step to prepare a georeference file, select the Go Write the new Image file button (button 0/3 in 

Figure 2.22). The software asks the nape of the file to be georeferenced first in the Pick Image Theme window 

(Figure 2.29). 
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Figure 2.29: Selecting the image to be georeferenced 

Three options can be selected in the Resample Method window appearing after pressing OK (Figure 2.30). 

Resample means that the original pixel numbers have to be recalculated in accordance with the transformation. 

The method of the recalculation influences the result significantly: 

• Nearest neighbor: attributes the old value found nearest to the new pixel. It is a fast method, however, 

significant errors may arise in transforming linear objects. It is recommended when scanned maps are 

georeferenced. 

• Bilinear interpolation: value of the new pixel is obtained by the linear interpolation of the values of the 

nearest four neighbours. The results are even, however, the value of the pixels changes significantly. 

• Cubic convolution: value of the new pixel is obtained by the non linear interpolation of 4x4 pixels. This 

method changes pixel values less significantly and strengthens the existing trends. This is applied when pixel 

size changes are great or in the case of satellite images. 
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Figure 2.30: Methods of calculating transformation 

Determine the type of the output image (Figure 2.31). Selecting tif format is practical and in this case a tfw 

format description file is formed beside the raster image. 

 

Figure 2.31: Selecting the file type of the transformed image 

After giving the file type, pixel size has to be determined as well. In the Cell Size window (Figure 2.32) 

information is obtained on the possibilities. The greater the size of the pixel is (smaller resolution) the less 

utilizable the result will be (because practically nothing can be seen on it). However, greater size will result in 

greater file size as well (which will also limit its utilization). Selecting value 0 the software will calculate with 

the value closest to the original pixel size (Figure 2.33). 
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Figure 2.32: Information on determining cell size 

 

Figure 2.33: Determination of pixel size 

After giving the pixel size, select the location of save (Figure 2.34). Transformation may require significant 

amount of time depending on the size of the dataset. Information on the actual stages can be obtained throughout 

the process (updated from top to bottom, Figures 2.35 and 2.36). 
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Figure 2.34: Setting the location of saving the transformed image 

 

Figure 2.35: Information on the actual steps of transformation (start) 
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Figure 2.36: information on the actual steps of transformation (closing) 

The end of the process is indicated by a message (Figure 2.37). 

 

Figure 2.37: Message indicating the end of the transformation 

Accuracy of the transformation could be controlled by placing the reference map onto the transformed 

(deficiencies of which are discussed in chapter 5) map. If edges continued properly on the border lines the 

results can be accepted (Figure 2.38). 
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Figure 2.38: Placing the georeferenced image (smaller satellite image) onto the reference map (greater map) 

Controlling questions 

Self-controlling questions: 

How is it possible to obtain an appropriate raster file from paper maps? 

How is it possible to save a satellite image using the Google Earth service? 

How the georeferencing of the raster files is performed? 

Test: 

What does georeferencing (rectification) mean? 

a, Preparing a report on geological data 

b, Giving projection co-ordinates and transformation of an image with co-ordinates 

What does GCP mean? 

a, Connection point 

b, Colour code 

Which transformation type is recommended in the case of georeferencing scanned paper maps? 

a, Nearest neighbor 

b, Bilinear interpolation 

c, Cubic convolution 

3.5. Field measurements 
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The chapter discusses the surface and satellite geodetic methods and the possibilities of integrating field 

measurements into a digital database. 

3.5.1. Aims of field measurements 

It is possible that our work has to be based on primary data source, i.e. field measurements as well. The aims of 

these can be the following: 

• No maps are available for the area (or at least the difference between the desired and available resolutions is 

too large). This is quite rare nowadays, it is highly unlikely that the target group of this textbook will face this 

problem. 

• Lack of data, new data are required. This is the case if the available maps are not detailed enough. Some 

possibilities are the following: 

• Micro-forms cannot be identified frequently and occasionally meso-forms cannot be recognised either 

using the most detailed topographic maps (for example a strongly transformed river terrace can be 

identified difficultly even on maps with the scale of 1:10000). 

• Position of new survey points cannot be given accurately based on the reference points. For example, the 

location of a soil profile or an outcrop can be determined only roughly compared to the drawn map 

elements. 

• Change of reality. Available maps are frequently not up-to-date - to put it mildly - unfortunately numerous 

areas are shown only on maps presenting conditions decades ago. (Note that the publication, survey and 

update of maps can differ significantly!) 

3.5.2. Theoretical background of field measurements 

In the course of traditional field measurements the following data are determined compared to the measuring 

device (reference point) (Figure 3.1): 

• Azimuth: angle between the direction of the measurement point and the reference direction (this is generally 

north). 

• Vertical (or height) angle: angle between the direction of the measurement point and the horizontal (for the 

measurement the height compared to the surface of the optics of the measuring device has to be determined 

and has to be tilted to an angle with which it „sees” the same height on the measuring rod or prism). 

• Oblique distance: real distance between the measuring device and the measurement point (measured in bee 

line). 
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Figure 3.1: Measured and deduced values 

From the above data several values can be calculated the aim of which is the display of the measured points. In 

the case of modern geodetic devices these calculations are made automatically. 

The important calculated parameters are the following (Figure 3.1): 

• Horizontal distance: horizontal projection of the oblique distance. It can be calculated from the oblique 

distance and the vertical angle by trigonometric methods. This distance is displayed in the projection system. 

• Height: relative height difference compared to the reference point. This can be calculated from the oblique 

distance and the vertical angle by trigonometric methods. The real height (above sea level) of the measured 

point can be determined if the height above sea level of the reference point is known. 

• X, Y, Z co-ordinates: location of the measured point is determined in an orthogonal co-ordinate system 

compared to the reference point. They can be matched directly to the EOV co-ordinates (as it is also a plane 

co-ordinate system) if the measuring device is set adequately (it is orientated towards north and the co-

ordinates of the reference point are known). 

• Using the most modern devices transformations directly to map co-ordinates are also possible. 

A few important factors have to be regarded in the course of measurement: 

• Always select points with known co-ordinates as reference point otherwise the entire survey would be without 

foundation, i.e. they cannot be integrated into the already existing files later. This can be realized in several 

ways: 

• The best method is to set the device above a triangulation point or at a place from where a triangulation 

point can be measured (we determine our position compared to a point with known co-ordinates.) 

• Our position is measured to objects that can be identified clearly on the map. Make sure these objects are 

really fix and with position unchanging for a long time (therefore a building would not be the best choice). 

• The direct determination of the co-ordinates of the reference point using satellite navigational devices is 

also possible. For this geodetic GPS is necessary as the accuracy of an average hand device is not enough 

(their error can be even in the magnitude of a metre). 

• All measurements should be performed with similar settings from a reference point because it is almost 

impossible to place the device into the same position (for example in the case of a measurement lasting for 

several days) and the subsequent correction of the data is difficult. 
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3.5.3. Field measurement devices 

For field surveys the traditional surface geodesy methods, satellite navigation devices and the combination of 

the two can be applied. 

3.5.3.1. Surface geodesy devices 

Traditional geodetic devices have a common measurement principle: the sign set in the point to be measured has 

to be adjusted into the centre of the view using a telescope that can be moved freely along two axes (vertical and 

horizontal), azimuth and height angle can be determined from the magnitude of the movement of the axes. 

Determination of the distance is performed by an optic method: view angle of the sign (section) set on the point 

to be measured is proportional to distance: the further it is the smaller it will look like. Distance measurement 

can have metre accuracy if a measurement rod is applied. In the case of rulers with a telescope (collimateing 

with a telescope - Figure 3.2) display of the horizontal map of the measurement points is carried out in the field 

(height values will be regarded later) while in the case of a theodolite (Figure 3.3) the map is constructed 

subsequently using the measured values. Range of the traditional devices is a few hundred metres (as the size of 

the signs decreases with distance) and objects in the way (e.g. plants) can make measurement very difficult (the 

measuring rod has to be seen completely and clearly). In the case of an optical theodolite (laser theodolite, 

Figure 3.4) determination of the angles is similar to the traditional theodolite (naturally with the automatic 

determination of the values) measurement of the distance is based on the velocity of the laser light (the beam 

released by the device is reflected by the prism placed in the measurement point and the distance can be 

calculated from the time passed). Its measurement distance is in the magnitude of kilometre and dense land 

cover presents less disturbance. 

The disadvantage of surface geodesy is that the accurate position of the device has to be determined in any case 

(e.g. either by measuring to a triangulation point or by a GPS) and the measured points can be adjusted to this. 

Furthermore this method is relatively slow. Nowadays satellite positioning gradually supersedes it, however, it 

will not disappear for a long time (numerous measurement tasks cannot be solved by GPS). 

 

Figure 3.2: Ruler with a telescope 
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Figure 3.3: Theodolite 
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Figure 3.4: Optical theodolite 
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3.5.3.2. Satellite positioning system 

Satellite positioning system was developed initially in the 1980s for military purposes: for logistics first then for 

supporting directly military operations. Both mega-powers at that time developed their own programme. Today 

only the GPS (Global Positioning System) developed by the United States of America operates. The Soviet 

Glonass was suspended with the collapse of the empire. A few of its satellites operate integrated into the 

American system. Since these are controlled by the army the European Union (and other associated states) 

decided to establish a system for civil purposes called Galileo, however, it does not operate yet. The Beidou 

system of China is still under construction. 

The positioning system, is composed of three principal elements: land base stations, satellites and receiver 

devices (positioners) (Figure 3.5). Detailed presentation of the system is not included in the aims of this 

textbook. The important things for the users are: reliability and accuracy. Both values were improved 

significantly over the last two decades and the initial 100m error limit has been reduced to centimetres even in 

the civil system as well. 

The method provides vector data files. The greatest advantage of the satellite positioning system is its 

universality: it can be used anywhere on Earth. There are significant cost differences considering the various 

devices, the digital maps necessary for their use represent significant costs generally for the basic devices. The 

primary factors to be considered when purchased are accuracy and the possibilities of data transport (e.g. 

possibility of direct connection to computers for loading data and if yes what procedures can be used for 

processing the data). 

By today the geodetic measurement stations have been established by combining satellite positioning and 

surface geodesy. 

 

Figure 3.5: GPS device 

3.5.4. Integrating measurement results into vector base maps 

In the course of field measurements one of the most important sources of error is the improper position of the 

measurement device. Including the inaccuracy of the horizontal setting and the azimuth. 

The most frequent cause of azimuth inaccuracy is found in the procedure of setting: in the case of traditional 

measurement devices (e.g. theodolite, ruler with telescope) a classic compass is used for the determination of 

north. The compass can be deflected by the metal body of the device (if the compass is too close to it) or from a 

greater distance the transmitting of the direction into the measurement device is not possible. In this way, 

although the distance values and the relative direction angles - compared to each other - are good the result of 

the measurement is rotated compared to the right position. In such cases â€śrotation back” is possible compared 

to fix field objects (e.g. triangulation points) with known co-ordinates. 
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In the course of this, a separate vector file is prepared from the measured points (Figure 3.6) that is fit onto the 

georeferenced base map (see chapter 4.8: the insertion of vector maps using AutoCAD) so that the reference 

point is placed in the corresponding point with known co-ordinates. Following the insertion select another point 

with known co-ordinates on the base map and in the vector file as well and determine the direction angle of the 

two compared to the reference point. Then rotate the inserted vector file with this value (Figure 3.7). Base point 

of the rotation has to be the reference point. In the case of practical implementation make sure that the 

measurement points are on a separate layer otherwise their selection for rotation will be difficult! 

In Figure 3.7 the reference point is the triangulation point of the Mise Hill located in the northeastern corner. 

The reference point is the triangulation point (IX. 6. border stone) in the salience of the border in the 

northwestern corner. 

 

Figure 3.6: Field measurement pints withouth correction and insertion onto a base map 
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Figure 3.7: Field measurement points with correction and insertion onto a base map (with negative rotation of 

4.11°) 

In the case of surveys on extended areas the map constructed from the measurement results has to be 

georeferenced using the methods presented in chapter 3. 

Controlling questions 

Self controlling questions: 

In which cases are field surveys required? 

What are the possible devices and methods of geodesy? 

How is it possible to insert field measurement results into an already existing database? 

Test: 

Which values can be measured directly? 

a, Horizontal distance 

b, Oblique distance 

Which is the measurement device of surface geodesy? 

a, Theodolite 

b, GPS device 

What does the expression azimuth mean? 

a, Horizontal angle with the main direction 

b, Height angle with the horizontal 

3.6. Further useful functions in AutoCAD 
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The chapter is a continuation and extension of the textbook entitled â€śGeoinformatic applications” (Utasi Z. 

2011). Numerous functions and possibilities of the AutoCAD software are presented that were not discussed in 

the mentioned textbook - due to extent limits - but may prove to be useful when maps are vectorized or 

constructed. Detailed discussion of the fundamental characteristics and logic of the software is ignored, only 

action we have to note is that parameters (e.g. commands or their abbreviations, co-ordinates, other numbers) 

are accepted by pressing ENTER 

3.6.1. Other drawing elements 

Drawing elements required for the vectorizing of basic object types (point, line, polygon) and generally 

sufficient for a simple task were presented in the previous textbook. Since thematic maps are compiled using 

ArcView their final formation in AutoCAD (Layout) was not presented. This chapter therefore discusses the 

drawing elements with the help of which further usual map elements (frame, network, legend, etc.) can be 

drawn. Furthermore it gives an overview of modifications related specially to the given object type. 

3.6.1.1. Multiline 

Using the multiline command parallel lines can be drawn. Process of vectorizing is very similar to that in the 

case of simple lines (Line, Polyline, 3D Polyline), however, the result is not one but several (2-7) parallel lines. 

Seemingly it is very useful in digitizing linear map symbols that are composed on two lines and the filling of the 

space in-between (e.g. covered roads, wider rivers) as both lines can be drawn by clicking over the symbol only 

once (4.1 animation). Its drawback is that when the vectorized map is exported into another geoinformatic 

software it will interpret the two lines as two separate objects - for example a wide road will become two 

parallel roads. Therefore if we intend to continue with data analysis outside AutoCAD all linear map symbols 

should be drawn by only one line (with the command Polyline). In case data exportation into a different 

software is not planned the Multiline command can be useful. 

In the course of digitizing only one line has to be followed, this is called the main line the rest are automatically 

drawn parallel side-lines. In the case of selection nippers appear only on the main line (Figure 4.1). Side-lines 

are associative with the main line, i.e. changing the main line (e.g. drawing the nippers away) changes the side-

lines (they follow the main line) as well, i.e. for example only one cannot be deleted. 

 

4.1. animation: Drawing and editing of multiline 
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Figure 4.1: Multiline selected (nippers appear on the main line) 

Construction of multiple lines is composed of two main steps: following the drawing of the lines modification of 

the style of the multiple line junctions possibly crossing each other. 

3.6.1.1.1. Construction of multiple lines 

The Draw → Multiline command is followed by the message: 

Justification = Top, Scale = 1.00, Style = STANDARD 

Justification/Scale/STyle/<From point>: 

Justification gives the location of the side-line in relation to the main line, while Style indicates line style. 

Generally only the Scale parameter is required that gives the distance between the parallel lines: following the 

input of an s letter and then pressing ENTER the software asks for the parameter: 

Set Mline scale <1.00>: 

The number in brackets is the last used value (or in the case of first use the default value). Inputting the 

appropriate number it is accepted by pressing ENTER. Then setting options in the starting row appear again: 

Justification/Scale/STyle/<From point>: 

Breakpoints can be drawn by moving the mouse and pushing the mouse bottom. Similarly to other lines the 

following initial menu is found: 

Close/Undo/<To point>: 

The command can be completed in two ways: 

• To finish the line (breaking) right click or ENTER are required. 

• To close the line into a polygon a letter Z have to b written and then the letter c shall be written (abbreviation 

of close) and then ENTER. 

3.6.1.2. Modifying the junction 

In the case of double lines crossing each other the parallel lines may continue within the junction. However, in 

many cases â€śopening” the junction may become necessary. There are several options for this to be selected 
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from the Multiline Edit Toolswindow (Figure 4.2) appearing after the Modify → Object →Multiline 

command. 

 

Figure 4.2: Options for editing multiline 

Continuous lines show the modification of the two marginal lines, the central ones show the modification of the 

rest of the - possible - inner lines. Selecting the desired type (left mouse button) its name will appear in the left 

bottom corner of the dialog window. Clicking OK the following command will appear in the command line: 

Select first mline: 

Highlight the first multiline (left click on one of the parallel lines - does not matter which one). This line is 

symbolised by the upright in the icon of the selected type. 

Select second mline: 

Highlight the second multiline (left click on any of the parallel lines - again does not matter which). This line is 

symbolised by the horizontal in the icon of the selected type. The command will be accomplished right away 

(Figure 4.3). 

 

Figure 4.3: Editing the junction of multiline (left side: original state, right side: result obtained by selecting 

Open Cross style) 

3.6.2. Rectangle 
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Drawing a regular rectangle in the course of vectorizing is may become necessary only in the finalizing of the 

map (drawing the frame of the map, compiling a legend). It is important to note that the line of the rectangle is 

of Polyline (line chain) type while the rectangle itself is a polygon (closed line chain) as well. 

The Draw → Rectangle command is followed by the message: 

Command: _rectang 

Chamfer/Elevation/Fillet/Thickness/Width/<First corner>: 

Apart from the first option (First corner) the rest is not required generally, they are more useful in technical 

drawing. One corner of the rectangle (no matter which) is highlighted by a left click (or by entering the co-

ordinates and pressing ENTER). 

Other corner: 

After moving the mouse highlight the opposite corner of the rectangle by a left click (or entering the co-

ordinates and pressing ENTER): the command is accomplished right away. 

3.6.3. Polygon 

In this case the Polygon represents not only an object type (i.e. a closed line chain, an area) but indicates that is a 

symmetric form. Therefore do not let the command to disturb us: the object polygon can be constructed from a 

chain of lines as well (furthermore this is the sole procedure in the course of vectorising maps - see: chapter 5.3, 

Geoinformatic applications). 

The Draw → Polygon command is followed by the message: 

Command: _polygon Number of sides <4>: 

Giving the number of sides of the polygon is the first step. Input of the value is accepted by pressing ENTER. 

(Naturally, the value can be 3 or higher but maximum 1024.) 

Edge/<Center of polygon>: 

Centre of the polygon can be given by either a left click at the right spot or entering the co-ordinates (and then 

pressing ENTER). 

Inscribed in circle/ Circumscribed about circle (I/C) <I>: 

Two types of auxiliary circles can be used for the drawing, however, they are opposing the terms used in 

geometry (Figure 4.4): 

• Inscribed: The symmetric polygon is drawn in the inside of the auxiliary circle so that all corners are on the 

circle. 

• Circumscribed: The auxiliary circle is in the inside of the polygon so that the middle points of the polygon 

sides touch the circle. 

Radius of circle: 

Giving the radius of the auxiliary circle is possible wither by a left click at the appropriate spot or entering the 

particular value (and pressing ENTER). The command is accomplished right away. 
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Figure 4.4: Constructing a symmetric polygon (left side: inscribed, right side: circumscribed) 

3.6.4. Circle 

Drawing a circle is required rarely therefore only the simplest variation is presented. 

Regarding the several sub-commands of Draw → Circle the followings may prove to be useful: 

• Center, Radius 

• Center, Diameter 

• 2 Points: two opposing end points of a diameter 

• 3 Points: the circle is fit on the three points 

The first version is used most often therefore it is discussed in detail in the following: 

The centre of the circle has to be given first following the Draw → Circle → Center, Radius command: 

Command: _circle 3P/ 2P/ TTR/<Center point>: 

The radius of the circle can be given by either left clicking at the appropriate spot or entering the particular 

value (then pressing ENTER). After this the previous command line is completed by the following question: 

Command: _circle 3P/ 2P/ TTR/<Center point>: Diameter/<Radius> <5>: 

Giving the radius of the circle is next. It is again possible by left clicking in the appropriate distance or by 

entering the particular value (then pressing ENTER). Between the last relation sign pairs the value used last is 

offered automatically. 

3.6.5. Arc 

Drawing arcs is still very rarely necessary therefore only the simplest version is presented. Following the Draw 

→ Arc → 3 Points command the starting point of the arc has to be given first either by a left click or entering 

the particular value (then pressing ENTER): 

Command: _arc Center/<Start point>: 

At this time a straight line from the starting point appears, its end point will be on the arc (it is a cord basically). 

Center/End/<Second point>: 

The second point can be given by either a left click or entering the particular value (then pressing ENTER). 

Following this the arc will become visible. 
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End point: 

The end point of the arc again can be given by either a left click or entering the particular value (then pressing 

ENTER). 

3.7. Other function buttons 

This sub-chapter the options appearing at the bottom of the working window are presented (Figure 4.5). 

 

Figure 4.5: Icon row in the bottom part of the working window of AutoCAD 

3.7.1. Grid 

By double clicking on the GRID flap it can be switched on (and off) which is indicated by the flap turning black 

and the appearance of the following message above the active command row: 

Command: <Grid on> 

A point network appears. The density of points can be changed only by a separate command and its default 

value is 0.5. This function is useful primarily when technical drawings are prepared where generally unit 

distances are used. It is mostly unnecessary when maps are digitized. Although it has no significance on its own 

when the Snap function is on it may prove to be very useful when fix errors (chapter 4.2.2). 

3.7.2. Automatic alignment (Snap) 

By double clicking on the SNAP flap it can be switched on (and off) which is indicated by the flap turning black 

and the appearance of the following message above the active command row: 

Command: <Snap on> 

As a result the cursor can be moved only with the unit distance given at the Grid. In the course of map 

digitizing, however, the cursor has to move freely with any distance therefore we have to make sure that - as in 

the default setting - the function is switched off. 

3.7.3. Alignment to objects (Osnap) 

It is similar to the Snap function but with free movement of the cursor and alignment is made to already existing 

breakpoints. 

The function can be switched on and off - by double clicking - with the Osnap shortcut key at the bottom of the 

working window. On and off state of the function are indicated by black and grey colours respectively. During 

one particular work the Osnap Settings pop-up window appears only at the first activation (Figure 4.6), later it 

can be accessed from the Tools → Object Snap Settings command row. 
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Figure 4.6: Alignment to object - selection of options 

Selecting the Running Osnap flap in the upper part of the Osnap Settings window the alignment options can be 

selected in the appearing window (Figure 4.6). Switched on state is indicated by a tick in the square next to the 

type when clicked on. 
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Figure 4.7: Alignment to object - other parameters 

In the window appearing (Figure 4.7) when the AutoSnap(TM) flap is selected in the upper part of the Osnap 

Settings window the characteristics of alignment can be set. When the Magnet option is on during drawing if a 

new breaking point approaches an already present one within a unit distance it will be fit on it automatically (the 

cursor â€śjumps” onto the older point). This function is very useful in technical drawings as joining points are 

fit perfectly (no gap or overlap), however, it may cause significant errors in map digitizing - for example 

digitizing a contour map contour lines close to each other can be fit onto each other. 

3.8. Separate modifications 

This sub-chapter includes the modifications that can be carried out in relation to several object types. 

3.8.1. Array 

Array means a multiple copy when the new elements are arranged in a symmetric form in relation to the 

original. 

After the Modify ď‚® Array command the object (or objects) to be copied has to be highlighted (using one of 

the methods described in the textbook Geoinformatic applications): 

Select objects: 
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Successful highlighting is acknowledged by the following message: 

Select objects: 1 found: 

Closing the highlighting is made by a right click after which Array type is asked: 

Select objects: 

Rectangular or Polar array (<R>/P): 

By typing letter r parallel (Rectangular) while typing letter p circular (Polar) Array can be selected. The two 

possible continuations are presented in the following two sub-chapters. 

3.8.1.1. Parallel (Rectangular) Array 

Rectangle Array means multiple copy of the original object horizontally and/or vertically parallel to itself, 

practically in rows and columns (Figure 4.8). After selecting this option the parameters have to be given. First, 

the number of rows has to be given: 

Number of rows (---) <1>: 

After entering the value (then pressing ENTER) the number of columns has to be given: 

Number of columns ( III ) <1>: 

After giving the value the distance between rows has to be given: 

Unit cell or distance between rows (---): 

Note that Array takes place in positive direction, i.e. upwards from the highlighted object. Note also that the 

value of shifting is adjusted to the left bottom corner of the object and not the distance of the elements from each 

other is regarded! For example, in the case of a 20x10 square if we want the distance between the top and 

bottom of the squares copied above each other to be 5 units we have to enter 15 units in the box of distance. 

Finally, the distance between the columns has to be given: 

Distance between columns ( III ): 

Similarly to the above, note that Array takes place in positive direction, i.e. right from the highlighted object. 

And the distance of shift is adjusted to the left bottom corner of the object and not the distance of the elements 

from each other is regarded! For example, in the case of a 20x10 square if we want the distance between the 

sides of the squares copied next to each other to be 5 units we have to enter 25 units in the box of distance. 

When the value is given the command is executed (Figure 4.8.). 

 

Figure 4.8: Rectangular Array (the original object is highlighted by red colouring) 
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3.8.1.2. Circular (Polar) Array 

Polar Array means that the original object is copied multiple around a centre. After selecting this option the 

centre of the Array has to be given first: 

Base/<Specify center point of array>: 

Defining the centre is performed by a left click at the appropriate place or by giving the co-ordinates (x,y) (then 

pressing ENTER). Following this, the number of copied elements is given: 

Number of items: 

After entering the value the angle difference of the copied elements has to be given: 

Angle to fill (+=ccw, -=cw) <360>: 

Value of rotation is given by an indirect method: it fills the area with dividing the given angle value into equal 

parts. (Pressing ENTER once calculates with the default 360°, i.e. the complete circle is divided into equal 

parts.) Then it has to be determined whether the copied objects are rotated or not: 

Rotate objects as they are copied <Y>: 

Possibilities are the following: 

• Y (yes): the objects will be rotated. 

• N (no): the objects will not be rotated. 

After giving the parameters (and pressing ENTER) the command is executed (Figure 4.9). 

 

Figure 4.9: Polar Array without rotating the objects (left side) and with rotation (right side) (the original object 

is highlighted by red colouring) 

3.9. Measurements and settings 

3.9.1. Line parameters (List) 

The Tools → Inquiry → List command lists the characteristic data of the highlighted line. 

After giving the command one line has to be selected by a left click: 

Command: _list 

Select object: 
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Closing the selection by a right mouse click the data of the line appear in a separate window. If a longer line is 

selected we can turn the pages by pressing ENTER. The following information can be seen (Figures 4.10 and 

4.11): 

• Layer 

• Space: location 

• Handle: individual identity of the object 

• Open: the object is a line (open), in the case of a polygon Closed appears. 

• Constant width: (0 is the default value) 

• at point X=… Y=… Z=…: co-ordinates of the breaking points 

• area: it is calculated in the case of a line as if the start and the end points were connected, i.e. if it was a 

polygon 

• length 

 

Figure 4.10: Line parameters (first window) 
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Figure 4.11: Line parameters (last window) 

If the points are so numerous that they cannot fit into one window, they will appear in several windows among 

which we can advance by pressing ENTER. It is important to note that turning the pages can go only forward 

and scrolling is not possible (i.e. only total pages can be turned)! 

3.9.2. Saving the actual drawing window 

The function is similar to the Print Screen with two important differences: 

• Only the content of the drawing window is saved (i.e. the icon rows, menu rows and command window are 

not) 

• The data is not placed on clipboard, it is saved directly as a raster file (image) 

In the Save Image window appearing after the Tools → Display Image → Save… command the parameters of 

the saving can be set (Figure 4.12). 
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Figure 4.12: Setting the parameters of the image saving 

Content and settings of the Save Image window are the following: 

• Format: type of the raster file can be given 

• Portion: size and location of the area to be saved can be defined 

• Size: size of the default image (in pixel), that is the actually visible part of the drawing window 

• Offset setting (frame): highlighting can be extended outside the actual part (giving the value in pixel) 

• Size: size of the total area to be saved can be given 

When the parameters are given and the OK is pressed the Image File window appears in which the location of 

saving and the type of file can be given (Figure 4.13). It has to be noted that the highlighted objects are saved in 

their default state - i.e. for example the line will not be dashed and nippers will not be visible. 
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Figure 4.13: Setting the location of image saving 

It has to be noted that during the processing of the image in bmp format saved in this way significant changed 

may appear regarding the colours if the following saving is performed in a different format - jpg for example. 

Figure 4.14 shows the result of converting into jpg an image in bmp format obtained in the above way. Figure 

4.15 shows the image obtained by traditional Print Screen. 
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Figure 4.14: Image obtained by saving the actual drawing window following conversion into jpg 
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Figure 4.15: Image in jpg format obtained by Print Screen 

3.10. Rejoining of vector map portions 

In the case of vectorizing maps it is frequent that the digital map of a given area is prepared in several portions. 

There can be several reasons for this: 

• Scanning of the original paper map - due to its size - is performed in several portions and then digitizing took 

place on the portions as well. It is practical - and relatively simple - to avoid this problem: the portions should 

be rejoined. One possibility for this is the joining of the raster image portions (using an image editing 

software) or virtual rejoining using the vectorizing software (for more details see chapter 2). 

• Vectorizing of the originally - in raster form as well - united map took place in portions because for example 

several people were involved in the process. The map presented in Figure 4.16 was digitized in four portions, 

the top left part is the work of one person. 

• Sue to the extent of the study area it is found in several map segments. In this case the segments can be 

rejoined virtually in a vectorizing software so that digitizing can be performed in one file. This method 

requires the georeference of the map segments (setting them into the appropriate position and size), for more 

details see chapter 10.3 and further related parts of the textbook entitled Geoinformatic Applications (Utasi 

Z.). However, separate digitizing of map segments is also frequent due to practical reasons: a particular 
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segment can be applied in several works and thus it is not necessary to cut smaller parts from a greater file for 

the newer analysis only the smaller parts have to be selected and rejoined that are required for the new work. 

 

Figure 4.16: Map segment vectorized partly (left top quarter) 

Rejoining of vector maps includes two main steps: inserting the vector maps is followed by the correction of the 

rejoined files. 

3.10.1. Insertion 

In the course of insertion not only vector contents are inserted but raster ones as well (e.g. maps). Parameters 

can be modified during the process similarly to those mentioned when the raster contents were discussed 

(chapter 10 in Geoinformatic Applications). 

The file into which insertion takes place is called base file henceforward, the file to be inserted will be called 

inserted file. 

Structure of the inserted file - selecting the appropriate option - remains. This means that both the object types 

and the layers remain unchanged. In case a layer with the same name exists in the base file, the content of the 

layer with the same name of the inserted layer is placed on this layer automatically. Parameters of the layer (e.g. 

colour, open/closed state, etc. - for details see chapter 7 of Geoinformatic Applications) are determined by the 

base file, its settings are carried forward. 
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Inserted content - independent from the real time of their preparation - will be regarded newer than the original 

content of the base file. The significance of this is found in for example the order of the drawing elements as 

newer content is always placed on the former content (masking it out). 

Starting step of the process is the command Insert → Block…, in the pop-up Insert window the button File… 

has to be selected (Figure 4.17), the rest is not interesting at the moment. 

 

Figure 4.17: Basic settings of the Insert window 

In the pop-up Select Drawing File window the file to be inserted has to be selected (by clicking on the name of 

the file) (Figure 4.18). Note, that the file is only selected if its name is highlighted by blue colouring and 

appears in the Preview window part on the right hand side as well. A frequent error is that it is missed (e.g. if 

only one file is present in the folder) and the software blocks advancement, however, no separate error message 

is given. Only one new file can be inserted at a time. 

 



 Environmental Informatics  

 90  
Created by XMLmind XSL-FO Converter. 

Figure 4.18: Selecting the file to be inserted 

Following the highlighting of the file if the Open is selected we get back to the previous Insert window the 

content of which is modified according to the parameters of the selected file (Figure 4.19). 

 

Figure 4.19: The Insert window with modified settings 

Content and settings of the Insert window appear divided into the following 3 main units: 

• Block: the file to be inserted 

• Block…: Name of file to be inserted 

• File…: Access route of the file to be inserted. It has to be noted that in case the file to be inserted contents 

raster content (base map) then it appears after insertion if the access route can identified (either it is located in 

the original folder of the file to be inserted or in the folder of the base file - similarly to the insert of raster 

images for the details of which check chapter 10.1 of the textbook Geoinformatic Applications). 

• Options: parameters of insertion 

• Specify Parameters on Screen: subsequent determination (on screen) of parameters: This can be switched 

on by clicking in the white square, as a result a tick will appear. There are two options the advantages of 

which are the following: 

• The function should be switched off when the co-ordinate system of the file to be inserted is the same as 

that of the base file - in this case the repair of the attached files has to be performed only (see later). 

Practically the new content is placed beside the old one as Figures 4.16 and 4.20 are showing. For 

appropriate settings see chapter 10.1 in the textbook Geoinformatic Applications. Generally this is the 

recommended state. 
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• in the switched on state all parameters have to be given subsequently and this is difficult and inaccurate: 

therefore make sure that all map sections are vectorized in the same co-ordinate system (see chapter 10.1 

of Geoinformatic Applications). 

• Insertion point: place of insertion (according to the base file). Co-ordinates X, Y - and Z in the case of 

spatial works - belong to the co-ordinate system of the base file. All three co-ordinates have two states: 

• They are not active when the Specify Parameters on Screen option is switched on as all values have to be 

given subsequently (the window is grey). 

• The values are active when the Specify Parameters on Screen option is switched off. In case the co-

ordinate system of the base file and that of the file to be inserted are the same (as described in the 

previous parts of the textbook) default settings must remain unchanged (all three values are 0)! 

• Scale: scale of insertion (according to the base file) 

• They are not active when the Specify Parameters on Screen option is switched on as all values have to be 

given subsequently (the window is grey). 

• The values are active when the Specify Parameters on Screen option is switched off. In case the co-

ordinate system of the base file and that of the file to be inserted are the same (as described in the 

previous parts of the textbook) default settings must remain unchanged (all three values are 1)! 

• Rotation: rotation of the inserted content 

• They are not active when the Specify Parameters on Screen option is switched on as all values have to be 

given subsequently (the window is grey). 

• The values are active when the Specify Parameters on Screen option is switched off. In case the co-

ordinate system of the base file and that of the file to be inserted are the same (as described in the 

previous parts of the textbook) default settings must remain unchanged (all three values are 0)! 

• Explode: type of insertion: make sure it is not confused with the Modify → Explode command (for this latter 

see chapter 8.6.2). 

• When the function is switched off. All objects are summed up in total, i.e. it is regarded to be one object 

regardless the original number of elements and all elements are placed on one layer (similarly to texts 

where letters are physically separate but they form a unit logically). This function is a useful tool in 

technical drawing, however it can be catastrophic in map construction! With the function switched off the 

later separation of map symbols will not be possible making the map unusable for any type of application 

therefore make sure the function is always switched on! 

• When the function is switched on it brings the original object and layer structure therefore this is the 

appropriate option when maps are constructed! 

In summary, the co-ordinate systems and other parameters of the base file and the inserted file are the same in 

an optimal case when the default settings of the Options should be retained (Specify Parameters on Screen is 

switched off, all three co-ordinates (X, Y, Z) are 0, Scale is 1 and Rotation is 0 and the Explode option is 

switched on. 
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Figure 4.20: Partly vectorized map segment with an inserted part (upper part) 

3.10.2. Correction in snapped files 

Correction covers two major contents: revision of raster files along their joining. Continuity of the selected 

objects and their adjustment is continuous (connecting lines, closing polygons). 

3.10.2.1. Revision of raster files 

As it was mentioned before when vector files are being inserted the raster contents in (maps) are also inserted. 

In the frequent case of maps vectorized in several parts (as shown in Figures 4.16 and 4.17) the base map is 

inserted again and again - with the insertion of each file - i.e. it is placed several times over itself with similar 

parameters. At the first glance it seems to be no serious problem as the map is placed at the same location every 

time. When analysed in detail, however, we realize the problem has to be dealt with. The essence of the problem 

is illustrated via a particular task. 

The base file in which the base map was inserted is given vectorizing took place after the insertion of the base 

map. Therefore the objects drawn mask out the base map, i.e. the objects are visible. Following insertion - as 

mentioned before - the inserted material is the most recent (regardless of the time of its actual construction) 

therefore it masks out the vectorized objects of the base map. If the user does not know the phenomenon he/she 

will only observe that the vectorized content of the file vanished after insertion. The repeated insertion of the 

base file is a frequent error as objects will be duplicated. It is fundamental in later analyses to have equal 

number of elements and data. Taking a simple example: one map contains the borders of the settlements of 
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county „A” with for example 300 settlements (polygons). When county „B” is inserted (having 400 settlements) 

a total of 700 settlements with 700 polygons will be in the file. If county „A” is reinserted then more of 1000 

polygons (as its polygons are added to the previous ones) are obtained. During further analysis (e.g. construction 

of a thematic map in Arcview) more than 1000 polygons would be associated with 700 objects and this will 

make the construction of the map impossible! Solutions to the problem are the following: 

• Fast solution: sending the map in the back (chapter 8.3 in Geoinformatic Applications). This is not enough, 

however, due to two reasons: 

• On the one hand, the shifting of the map is temporary, lasts only until we leave the work. When the file is 

opened again the original order (at the time of formation) resumes. 

• On the other hand, the action has to be performed at every installation and this slows the effective work. 

(For example if the given map was constructed from 10 parts the order of the drawing elements has to be 

set nine times.) 

• Final solution is only obtained if only one base map remains. This can be achieved in two ways: 

• The base map has to be deleted after the insertion is completed. This method requires great care not to forget 

about the delete (after long, monotonous work decreases attentiveness) and to delete the unnecessary map 

only. 

• The file to be inserted can be modified before insertion by deleting the raster contents. (In practice, save the 

modified file as a new file with different name and leave the original raster file as well for safety - in many 

cases it might be needed later!) 

3.10.2.2. Correcting the joining parts 

The question arises frequently whether lines should be merged at the border of the map segments after their 

digitization and Snap or it is enough to simply place the end points over each other (for the methods of 

correction see chapter 5 of the textbook Geoinformatic Applications). Both methods have their advantages and 

disadvantages to be considered one by one when working on a particular problem: 

Advantages: 

• Identification and correction of false lines is simpler. For example the contour lines with the same value have 

to meet at the border of two neighbouring segments. If they differ the problem is identified when the lines are 

merged in AutoCAD right away (for details see chapter 5.2 of Geoinformatic Applications). 

• Since a particular contour line is composed of fewer parts (eventually a contour line running on a closed form 

is composed of only one piece) the identification and handling of errors is simpler. 

Disadvantages: 

• The processing of a given map segment in a different project is simpler as the Snap of the separate segments 

is much easier than to cut the map of the area from a greater area. (Also if a different analysis requires only 

parts of the previous work it is unnecessary for example to pay for useless data.) 

• Processing of large objects - i.e. containing numerous breakpoints and thus many data - can be very slow in 

certain cases. 

In conclusion the author does not recommend the merging of the lines at the segment boundaries only to place 

the end points onto each other along the border of the map segments. 

Controlling questions 

Self controlling questions: 

What are the possible ways of constructing parallel lines? 

What are the advantages and disadvantages of the Snap function? 

How to correct joining contents after insertion? 
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Test: 

What is the command for Paralell Line? 

a, Line 

b, Multiline 

c, Consctruction line 

What does the Snap function mean? 

a, Automatic adjustment 

b, Rectangular drawing 

Which command copies a rectangle in regular rows and columns? 

a, Osnap 

b, Array 

4. Creating vector database in ArcView 

The chapter outlines the initial steps of vectorizing, discusses the insertion of georeferenced raster maps and the 

application of the most important graphical elements (point, line, polygon). 

4.1. A few terms in ArcView 

Vectorizing raster base maps can be made directly using the ArcView software, however, this is a bit more 

difficult especially with older versions than using AutoCAD. One of the most important differences between the 

two is that in AutoCAD the transformation of line and polygon object types into each other is relatively simple it 

has to be pre-defined in ArcView and no modifications are possible later. Similarly modifications between 

similar type graphical elements - like dissection, joining - are more complex in the latter one. 

Some terms and functions that are discussed in more detail in the Geoinformatic Applications textbook are 

reviewed below in order to make the understanding of the rest easier. Map database in ArcView is organized 

into three levels: 

- The base is presented by the themes that have roles similar to the layers of AutoCAD, however, in ArcView 

one layer can contain only one type of object (point, line, polygon or raster element). 

- The layers are organized into a complete map in a view. A view represents a map. (A state similar to that of the 

dwg format files of AutoCAD.) 

- Several views are summarized by a project file which is basically the series of maps belonging to one work. 

(This level is missing in AutoCAD.) 

The smallest unit that cannot be divided any more is called feature. For example a line, a point, a polygon and a 

raster file can be this. One feature is associated with a Record. 

The main menu icon row changes in accordance with the working window, i.e. icons will be different for maps, 

data tables, print view, etc. Function of the icons is presented in the actual sub-chapters. Figure 5.1 present the 

icon row of a frequently used View. 
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Figure 5.1: Icon row for the View 

(1. Save Project; 2. Add Theme; 3. Theme Properties; 4. Edit Legend; 5. Open Theme Table; 6. Find; 7. Locate 

Address; 8. Query Builder; 9. Zoom to Full Extent; 10. Zoom to Active Theme(s); 11. Zoom to Selected; 12. 

Zoom In; 13. Zoom Out; 14. Zoom to Previous Extent; 15. Zoom to Image Resolution; 16. Rotate Image; 17. 

Select Features Using Graphics; 18. Clear Selected Features, 19. Histogram; 20. Help; 21. Identify; 22. 

Pointer; 23. Vertex Edit; 24. Select Feature; 25. Zoom In; 26. Zoom Out; 27. Pan; 28. Measure; 29. Hot Link; 

30. Area of Interest; 31. Label; 32. Text; 33. Draw (Point); 34. Seed Tool; 35. Align Tool; 36. Contour; 37. 

Interpolate Line; 38. Scale) 

4.2. Insertion of a raster file (base map) 

To start digitizing (vectorizing) a base map is required, this is mostly a raster file. A fundamental requirement 

for the map is to â€śhave a foundation” in the shape of co-ordinates in order to be located in space, i.e. it has to a 

georeferenced map (for the process of this see sub-chapter 2.5). 

4.2.1. Opening the raster file 

Georeferenced raster filescontain the co-ordinate data, in this case the appropriate insertion of the image is 

important. The most frequent is the GeoTIFF (tif) format that contains the co-ordinate data in itself, however, an 

auxiliary file (tfw format) beside it also contains the values. 

The first step of inserting the map is the import of the raster file. For this select the View →Add 

Theme…command (or the appropriate icon). In the pop-up Add Theme window the appropriate parameters can 

be set (Figure 5.2). 

• In the Data Source Types scroll down menu select the Image Data Source option otherwise the raster file will 

not be shown in the list. Make sure the image description files (tfw format) also appear and do not confuse 

them with the image files (tif). If a file with improper format an error message will be received (Figure 5.3). 

 

Figure 5.2: Opening the raster file 
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Figure 5.3: Error message when opening a file with improper format 

Co-ordinates of the inserted raster file can be controlled with selecting the Definition menu item (Figure 5.4) in 

the Theme Properties window appearing after the Theme → Properties command. The content of the menu item 

is the following: 

• Theme Name: name of the file inserted. 

• Source: access route of the inserted file 

• Extent Limit: 

• Image default: default size 

• Display: actual size 

• View: complete view 

• Theme: theme as a whole 

• Specified: individually defined 

• Left: value of the left boundary line (co-ordinate x) 

• Right: value of the right boundary line (co-ordinate x) 

• Bottom: value of the lower boundary line (coordinate y) 

• Top: value of the top boundary line (coordinate y) 

• Comments: description of the image can be completed by any type of information. Values in Figure 5.4 are 

the parameters of a map in the EOTR system, they are meant in metres (this will be important later). (Rough 

control of the metre or kilometre setting of the base raster file is possible based on the co-ordinates.) 
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Figure 5.4: Base data of the raster file 

The two extreme values of zoom can be given in the Display menu item of the Theme Properties window 

(Figure 5.5): 

• Minimum Scale (minimum resolution): ratio of smallest zoom 

• Maximum Scale (maximum resolution): ratio of greatest zoom 
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Figure 5.5: Setting the extreme values of zoom 

After the parameters of the insertion were identified and accepted by pressing OK the raster file is inserted into a 

new shape file. 

4.2.2. Setting the parameters 

Once the raster base map is imported its parameters have to be given. For this select the View → Properties… 

menu item and the following window will be opened (Figure 5.6). 

Elements and settings of the window from top to bottom: 

• Name: name of the view, it can be anything. (In our example: MagyarorszĂˇg /Hungary/.) 

• Creation date: automatically generated date according to the clock of the computer. 

• Creator: name of the user can be given, it is not a compulsory field. 

• Map Units: unit of measure network of the map meaning the distance of one unit - it can be selected from a 

scroll down menu: 

• unknown 

• decimal degrees 

• inches 

• feet 

• yard 

• miles 

• millimeters 

• centimeters ( 

• meters 

• kilometers 

The base map generally has metre or kilometre setting. Make sure that this parameter is set properly otherwise 

the resolution of a raster file can be very poor. 

• Distance Units: unit of measurement applied for the display. It can be selected freely independent from the 

previous one: 

• unknown 

• inches 

• feet 

• yard 

• miles 

• nautical miles 

• millimeters 

• centimeters 

• meters 
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• kilometers 

 

Figure 5.6: Properties of the map 

The improper use of the map unit and the distance unit is a frequent mistake. In the case of the map unit, its 

accurate definition is essential as every other deduced content is based on it and if the basic setting is wrong all 

of the future results will by false (for example in the case of confusing metre and kilometre). Distance unit is 

related only to the display and can be modified at any time. Illustrating the two parameters by a simple example: 

if vectorizing is performed in SI (metre) system the map unit will be metre or kilometre, however, if the 

resultant map is prepared in Anglo-Saxon environment the elements will be displayed according to this (for 

example the scale intervals will be mile based). 

• Projection…: setting of the projection system. Opens the following window (Figure 5.7): 
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Figure 5.7: Projection parameters of the View with standard parameters 

In the upper part of the window the Standard or Custom type of the projection system can be given. Generally 

the options offered in the Standard version are sufficient but in certain cases the setup of a Custom system is 

required. 

Further options of the Standard setting are reviewed first. 

•  

Figure 5.7 shows the parameters of Mercator’s projection that are displayed in the lower part of the window 

after selecting the options (until that this part is united grey). 

Options in the Custom setting: 

•  
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Figure 5.8: Settings of a Custom projection system (Transverse Mercator) 

•  

In case the projection of the base map is unknown or a smaller region is in the analysis the simple rectangle type 

without projection system shall be selected - in this case parameters to be determined become simpler as well 

(Figure 5.9). 
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Figure 5.9: Setting Custom projection system (Orthographic) 

•  

• Area Of Interest: selecting a part of the map. Default settings remain unchanged generally, however, the 

following parameters are given if necessary (selecting a smaller area from a greater file) (Figure 5.10): 

 

Figure 5.10: Definition of the area to be displayed 

•  

• Background Color: background colour of the map content. Choosing the Select Color… button the demanded 

colour can be selected from the window popping out when the software was open (Figure5.11). 
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Figure 5.11: Window of colour selection 

• Comments: other relevant information. 

It is possible that the map disappears after giving and accepting these settings: it was not lost at this time simply 

its size and/or position change so that no parts are visible in the actual view. It can be displayed again by 

selecting the full size zoom option. 

4.3. Creating objects (vectorizing) 

For starting the vectorizing the definition of a new theme is required. For this select the View → New 

Theme…command. Select the object type of the layer to be created from the pop-up window. This can be point, 

line or polygon (Figure 5.12). 

 

Figure 5.12: Creating new theme 
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The icons in the drawing elements icon row will be in active (black) or switched off (grey) settings according to 

the active theme (Figure 5.13). 

 

Figure 5.13: Icon row of drawing elements (Draw) (icon 33 in Figure 5.1 is opened) 

(1. Draw Point; 2. Draw Line 2 points; 3. Draw Line 2 or more points; 4. Draw Rectangle; 5. Draw Circle; 6. 

Draw Polygon; 7. Split Line; 8. Split Polygon; 9. Appends a New Polygon) 

4.3.1. Line 

For the vectorizing of linear features generally the polyline line type is appropriate. Drawing can be started after 

the base map was loaded and the line theme was created or opened. For the drawing the theme has to be made 

active by the Theme → Start Editing command. In case the theme is not active, drawing is possible but the 

elements will not be involved in the theme and data cannot be attributed to it (it will have no foundation)! 

4.3.1.1. Drawing polyline 

In the lower row of the main menu row the draw icon row is located (icon 33 in Figure 5.1). Drawing elements 

can be selected with a left click on the right bottom corner (Figure 5.13). Select the polyline icon (icon 3 in 

Figure 5.13). 

In the course of drawing a line, left clicks locate the breakpoints and straight line segments are drawn between 

them. Driving the cursor along the line to be vectorized the curve of the line has to display the breakpoints with 

appropriate density, i.e. along curved sections denser while along straight sections rarer breakpoints are 

required. We do not have to press the mouse button between two breakpoints (in contrast to line drawing in 

several other softwares)! 

In case a breakpoint is located in a wrong place and the cursor is not too far away from it the simplest correction 

is to withdraw the last point. For this press and hold the right mouse button and this action will open the window 

below (Figure 5.14) then dragging the cursor over the Delete Last Point command leave the mouse button - in 

this way the last placed point has been withdrawn. This procedure can be performed as many times as we want 

(in case the withdrawal of several points is required). 
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Figure 5.14: Options that can be selected when a line is drawn 

If necessary we can navigate on the base map during drawing: for this - similarly to the above - press and hold 

the right mouse button. It is very important that at which part of the display screen the button of the mouse is 

pressed because procedures are positioned in relation to this point. The following options can be selected from 

the pop-up menu row: 

• Zoom In: zooms by one unit so that the centre of zooming will be the point at which the mouse button was 

pressed (this will be in the centre). 

• Zoom Out: zooms out by one unit so that the centre of zooming will be the point at which the mouse button 

was pressed (this will be in the centre). 

• Zoom to Selected: zooms the selected element to the size of the full screen. 

• Pan: moves by one unit so that the centre of movement will be the point at which the mouse button was 

pressed (this will be in the centre). 

The desired procedure is executed after the mouse button was released. It is important to note not to use the icon 

row of the main menu for navigation during drawing (icons 25, 26 and 27 in Figure 5.1) because this will cause 

the termination of the drawing (breaking of the line)! 

In order to finish line drawing a double left click is necessary - this time the line remains in the highlighted state 

(5.1 animation). 

In case we want to save the drawing in its current state use the Edit → Stop Editing command. The software 

asks for confirmation (Figure 5.15). Remember that the theme has to be active for the construction procedures 

that will be discussed below. 
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Figure 5.15: Finishing line drawing 

 

5.1. animation: Line drawing 

4.3.1.2. Modifying the nippers 

Make sure that the layer (theme) of the line to be edited is open for editing. This is indicated by dashed lines 

enclosing the symbol indicating the switched on state of the theme - grey rectangle with a tick in it - or by the 

active state of the Stop Editing menu item in the Theme menu. If not, the line will be taken off the layer at the 

first step of editing! 

Select the Vertex Edit icon (icon 23 in Figure 5.1) then click on the line to be modified with the left mouse 

button. The nippers occur in the vertex points (grey rectangle) (Figure 5.16). For modifying the vertex point 

move the cursor above the nipper (or very near): the cursor will change its shape from an empty arrow into a 

cross. Then pressing and holding the left mouse button the vertex point can be moved to the desired new place 

which is accepted by releasing the mouse button. 

For creating a new vertex point, move the cursor above the line segment where the vertex will be placed: the 

cursor will change its shape from an empty arrow into a circle with a cross in it. Then clicking with the left 

mouse button the vertex point is created. 

When straight lines are drawn it is practical to fill in the attribute table right away - at least with the few data 

required for identification because the later identification of the elements is very difficult or even impossible - 

for more details on this see chapter 7. 



 Environmental Informatics  

 107  
Created by XMLmind XSL-FO Converter. 

 

Figure 5.16: Line to be edited with nippers 

4.3.1.3. Merging lines 

The first step of line merging is to place the end points of the lines to be merged on each other. Without this 

lines can be merged but they will form a united line only seemingly, they will not form a single line. For the 

procedure the theme has to be active. 

For placing the end points onto each other, the Snap function has to be activated otherwise the end points will be 

on each other only seemingly (at great zoom it will be visible that they do not cover each other). For this press 

and hold the right mouse button. In the pop-up window move the cursor above the Enable General Snapping 

command and activate the function by releasing the mouse button (Figure 5.14). At this time the Snap icon row 

appears in the main menu (Figure 5.17) between the Draw and Seed icons (icons 33 and 34 in Figure 5.1). 

Snap function means that a point created newly or moved within a given distance (tolerance) will be placed on 

the closest existing vertex point within the given distance. This tolerance has to be set optimally: in the case of 

too small tolerance snap is difficult (as the cursor has to be very close to the other point and that is not always 

possible) while if the tolerance is too great several points will be within it and snap may places the point onto 

not the desired point but on another. 

 

Figure 5.17: Snap menu bar (1. General Snapping, 2. Interactive Snapping) 

For setting the tolerance of Snap select icon 1 from the Snap menu bar (Figure 5.17) then move the cursor by 

pressing and holding the left mouse button: a circle will be opened, this shows the tolerance. When the 

appropriate size is reached release the mouse button: the circle will disappear and setting is done. This can be 

changed at any time later in the same way. 

For placing the end point on each other, select the Vertex Edit icon (icon 23 in Figure 5.1) then click on the line 

to be modified with a left click. At this time nippers (grey square) will appear at the vertex points (Figure 5.16). 

Move the cursor above the nipper at the end of the line then press and hold the left mouse button: the circle 

appearing around the nipper shows the tolerance of Snap. Move the nippers to the end point of the other line so 

that it gets within the tolerance (image 1 in Figure 5.18) then complete the movement by releasing the mouse 

button: the moved end point is now on the other end point (image 2 in Figure 5.18). Snap can be performed onto 
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any vertex point not only onto the end point - therefore make sure to place the end point really onto the other 

end point! 

 

Figure 5.18: Placing end points onto each other (1. moving the nipper when Snap is switched on, the circle 

shows the tolerance zone, 2. End points placed onto each other) 

The final step of merging lines is the real merging of the line segments. Select the lines to be merged: use the 

Pointer icon for this (icon 22 in Figure 5.1), highlight the lines (with a left click one by one or framing them). 

Then select the Edit → Union Features command and merging is completed. In the case of this type of merge 

the new united line inherits the attributes of the line segment that was the first to be highlighted in the course of 

merging. 

4.3.1.4. Splitting lines 

The Theme has to be active for the procedure. In the course of the procedure the first line (to be split) is divided 

by the second (auxiliary) line. 

For the procedure select the Draw Line to Split Feature icon from the draw icon row (icon 7 in the Figure 5.13). 

Then draw the auxiliary line similarly to line drawing (by lift clicks and double left click at the end). The 

auxiliary line shall cross the line to be divided. As a result two lines are formed seemingly but in reality four 

lines are created that meet at the intersection - i.e. the first line is divided into two while the second line is 

created in two pieces (Figure 5.19). The auxiliary line may consist of any number of vertex points and has the 

same characteristics as the line drawn using the Draw Line command. In case we do not need the auxiliary line 

anymore it can be deleted. 
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Figure 5.19: Steps of line cutting (1. Original line, 2. Drawing the auxiliary line, 3. The original line cut at the 

intersection) 

4.3.1.5. Deleting lines 

Only the content of the active layer can be deleted at any time. If the layer of the object to be deleted is not 

active make it active using the Theme → Start Editing menu item then press the Select button (icon 22 in Figure 

5.1) and select the object by a left click. Eight black squares will appear around the object at the corners and side 

centres of the - virtual - rectangle enclosing the object indicating that it is selected. Finally, press the Del (delete) 

button on the keyboard and the command is executed. 

If the appropriate theme is not active before drawing the line it will be placed outside the layers. For deletion, 

finish editing (Theme → Stop Editing) and select the line and delete it as described above. 

4.3.2. Polygon 

Simplest way of creating polygons (areas) is selecting the polygon object type already during vectorizing. 

Although construction of polygons and building topologies for them is also possible from lines later but this 

would require more work and newer version of the software. 

4.3.2.1. Drawing of the first or an individual polygon 

Drawing can be started with establishing a new theme (chapter 5.3) or opening and making active of an already 

existing theme. 

For starting the drawing select the Polygon icon from the drawing tools (icon 6 in Figure 5.13) as in the case of 

map digitizing the areas are generally irregular. The area is drawn along its boundary by clicking on the vertex 

points (similar to line drawing) then when we arrive back near the starting point the drawing is finished by a 

double left click to the point where we want to place the last vertex point (5.2. animation). During drawing the 

cursor is connected to the starting point. The polygon is filled with the colour of the theme, however, this can be 

changed freely (chapter 12.1 of Geoinformatic Applications). Changing the place of the nippers, creating a new 

vertex are the same as described at editing lines (chapter 5.3.1.2). 

 

5.2. animation: Drawing polygon 

4.3.2.2. Drawing adjacent polygon 

Drawing an adjacent polygon to an already existing polygon requires no void space or overlapping between the 

two objects. In case the creation of the new element is made as described in the previous chapter (drawn as an 
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individual element) meeting these criteria would be difficult: would require great care even if the Snap function 

is on to re-draw each existing vertex points along the adjacent sides. Using the Adjacent polygon drawing 

element is much simpler as only the missing sides have to be drawn the building of the topology (completing the 

polygon) is automatic. 

So, start drawing by selecting the Adjacent polygon icon (icon 9 in Figure 5.13). Make sure that the line of 

drawing crosses the border of the polygon to which we want to connect the object - the line segment hanging 

into the neighbouring polygon will be cut automatically when the procedure is completed (image 1 in Figure 

5.20). The last point should also hang into the existing polygon and after a double left click the new element is 

completed (image 2 in Figure 5.20). 

 

Figure 5.20: Drawing adjacent polygon (1. During drawing, 2. The result) 

4.3.2.3. Splitting polygons 

In case we need to divide an already existing polygon into smaller parts this can be achieved using the Split 

polygon function. In the process the new line segment has to be drawn within the polygon to be divided the 

building of the topology of the new polygons is automatic. 

Drawing is started by selecting the Split polygon icon (icon 8 in Figure 5.13). Make sure that the line of 

drawing crosses the border of the polygon to be divided - the line segment hanging out will be cut automatically 

when the procedure is completed (image 1 in Figure 5.21). The last point should also hang out of the polygon to 

be divided and after a double left click the two new elements are created (image 2 in Figure 5.21). 

 

Figure 5.21: Split of polygons (1. During drawing, 2.The result) 

4.3.2.4. Joining of polygons 

The opposite of the previous procedure is the joining of polygons. As a first step select the polygons to be united 

using the Select Tool icon (icon 22 in Figure 5.1) then apply the Edit →Union Features command and the 

procedure is executed (Figure 5.22). 
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Figure 5.22: Uniting polygons (1. Starting conditions, 2. The result) 

4.3.2.5. Subtracting polygons 

In the course of preparing digital map a very frequent problem is presented by the handling of drawing islands. 

Drawing islands are polygons within another polygon so that it is not part of the enclosing polygon and has no 

borders to any other polygon. A few examples without completeness are the followings: 

• In petrologic maps a rock type within the surrounding homogeneous areas composed of a different rock. 

• The so called enclaves on public administration maps. A few illustrations are the following: 

• Budapest on the county map of Hungary (since the capital is not part of Pest county), Berlin on the 

provincial map of Germany (as it is not part of Brandenburg province). 

• Countries or country parts can form enclaves (e.g. former Western Berlin in the German Democratic 

Republic, Lesotho in the Republic of South Africa). 

In case we neglect this and just draw a smaller polygon into a greater one then significant errors may occur in 

the data and of course in calculations as well. As for the example of Budapest if we want to know the area of the 

public administration units: if Budapest is not extracted from Pest county then the area of Pest county will be 

greater than in reality (as the software counts the area of Budapest into it). In this way if we sum the areas of all 

of the public administration units (19 counties and Budapest) the result will be greater than the area of the entire 

country! 

For subtraction of polygons, a polygon within a greater polygon is required that were drawn as described before 

(sub-chapter 5.3.2.1). Select the smaller polygon using the Select Tool icon (icon 22 in Figure 5.1) - the greater 

polygon will also be selected automatically. Then apply the Edit → Subtract Features command and the 

procedure is executed (image 1 in Figure 2.23). Seemingly nothing has changed but in the case of successful 

execution the subtraction has been performed. This can be visualized best if the smaller polygon is deleted: a 

hole will remain in the greater polygon (image 2 in Figure 5.23). (If the procedure is unsuccessful then the 

greater one will remain united with no hole in it.) 

 

Figure 5.23: Subtraction of polygons (1. Drawing island, 2. Drawing island removed) 

4.3.3. Point 
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This function can be applied only in the case of point type theme. Only the Point function is active in the draw 

icon row (icon 1 in Figure 5.13). After the icon was selected points can be placed by left clicks. The position of 

the points can be modified later (see chapter 12.3 in Geoinformatic Applications). The point that was drawn last 

remains highlighted until the creation of the next point (or until any other command) that is indicated by four 

black squares around the point (Figure 5.24). 

 

Figure 5.24: Drawing a point (the last is highlighted - right lower point) 

The commands and operation of the pop-up window (Figure 5.25) appearing when the right mouse button is 

pressed and held during the active state of point drawing (Figure 5.25) are partly the same as described in the 

case of line drawing (chapter 5.3.1) therefore they are not discussed here. 

 

Figure 5.25: Options that can be selected in the course of drawing a point 

Controlling questions 

Self controlling questions: 

How is the georeferenced raster file inserted in ArcView? 

How are polylines drawn and edited in ArcView? 

How are polygons drawn and edited in ArcView? 

Test: 

Which function means alignment? 

a, Pan 

b, Snap 

c, Edit 
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What does drawing island mean? 

a, Area surrounded by water from every direction. 

b, Smaller polygon within a greater one and it has no common border with other polygons. 

What does the procedure Union Features mean? 

a, Joining of objects 

b, Attributing data to objects 

5. Controlling geometrical and attribute data 

Both this textbook and the Geoinformatic Applications textbook recommend the software AutoCAD for the 

preparation of vector maps due to its usefulness and practical characteristics (for such advantages see the related 

chapters of the textbooks). However, it is not suitable for more complex geoinformatic tasks therefore further 

analyses have to be performed in different software. In order to solve the task successfully certain modifications 

have to be made in the content and structure of the AutoCAD file. These are discussed in this sub-chapter. 

5.1. Determination of the measurement unit system 

When a new file is formed in AutoCAD the measurement unit system has to be determined that can be either 

metric or Anglo-Saxon (chapter 3.2 of Geoinformatic Applications). In Hungary it is sensible to select the 

metric system. 

The next step is the setup of the length of the unit. It is practical to choose a scale with which the default unit in 

the software will be the round multiple of a real distance, i.e. practically 1 unit equals 1 metre or 1 kilometre 

(chapter 10.3 of Geoinformatic Applications). This data will be required for further analyses in different - 

geoinformatic - software as scale has to be set in that software as well (chapter 11.2 of Geoinformatic 

Applications). Generally it does not matter whether metre or kilometre setting is applied, however, there are 

exceptions. Therefore, for example if the work was performed in kilometre unit but the software requires metre 

unit the vector base map has to be transformed in AutoCAD. This means that the size of the map has to be 

increased a thousandfold so that the base point of increase is the 0,0 co-ordinate (chapter 8.2 of Geoinformatic 

Applications). Make sure that all layer closings are terminated (Layer - On/Off - chapter 7.1 Geoinformatic 

Applications) otherwise the size of only the open layers will be increased making the file useless. EOTR maps 

are generally in the metre system. 

5.2. Handling layers 

Handling elements associated with each other can be solved differently in each geoinformatic software. In 

certain cases - as in the case of AutoCAD - all data are saved into one file. In other cases, each layer is stored in 

separate files as in the case of Arcview. Therefore several types of conversions are required in the course of 

exporting data. Regarding these conversions the handling of layers is described in this subchapter. 

5.2.1. Dividing the base file into thematic layers 

The architecture and file structure of AutoCAD and ArcView are different: the former stores every content in 

one file divided into layers (only the raster base file is not contained only its name and insertion parameters). 

The latter stores each layer in a separate thematic file and the parameters of the layers are described in a project 

file (in .apr or .prj format) (for details see chapter 11.1 of Geoinformatic Applications). Therefore when the 

AutoCad file is exported into ArcView it has to be transformed: the logically related contents have to be saved 

into separate files. Always the content determines which layers are saved into one file. It is a rule of thumb that 

only one type of object can be stored in one file as ArcView can handle them only in this way. 

In certain cases a new file is composed of one layer (practically by deleting the rest of the layers). For example 

triangulation points are generally stored in one layer. 
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Contents of several layers can be and should be saved in one file if they are related thematically. In this case the 

separate layers should be kept because they could be the basis of classification later. Some examples for fusion 

(and separately for layers) are the following: 

• Contour lines: each contour line should remain on the layer of their value. Practically the name of the layer is 

the value of the contour (e.g. â€ś300”). Avoid any further addition to the name (e.g. the â€ścontour_300m” is 

not recommended) as the height value of the contour line is deduced from the layer name in ArcView and if 

this name is not a simple number the procedure will not be possible (chapter 7). 

• Water-courses: arrange them into several layers according to their size. Follow the legend of the map, i.e. 

water-courses marked by a single line and double lines (thinner and wider rivers) should be saved in two 

layers. Natural and artificial waters could be also distinguished, however, this classification may cause 

significant difficulties: for example in Hungary there are hardly any natural water-courses, most rivers have 

artificial channels in shorter or longer sections. If natural and artificial beds are separated the logic of the 

software will separate certain sections of the same river making certain procedures almost impossible. For 

example for a simple length calculation either all sections have to be selected - with the risk of missing some - 

or markers have to be used (making data analysis more difficult). 

• Roads, railways: separate them into separate layers according to their order and quality (e.g. motorways, 

primary, secondary roads, etc.). 

5.2.2. Colour of objects 

Vectorizing is made easier if colours are attributed to different object types (layers will receive different colours, 

individual colour setup is not recommended - for details see chapter 7.1 of Geoinformatic Applications). In the 

course of vectorizing it does not matter which colours are applied as they will not be applied on the final maps - 

they will be determinable in the geoinformatic software later. Therefore in case the visibility of the map is 

improved colours different from the original ones of the map can be also applied. 

In the cases when analyses are based directly on the vector version, the colour of layers has no further 

significance. For example in the course of exporting to ArcView from AutoCAD, information related to the 

layer colour will be preserved among the attributes of the shape file, however, it has no significance here (see 

Figure 91 in chapter 11.4 Geoinformatic Applications textbook). 

In the case of other geoinformatic software raster files have to be prepared from the vector files first and this 

will be interpolated later (e.g. for constructing a digital elevation model) - considering the better known 

softwares the IDRISI, mentioned in this textbook operates according to this principle. In this case, data related 

to the original layers are lost and thus data can be attributed to colours. 

Difference between the two methods can be visualized with the following example in the case of a digital 

elevation model. In the first case the name of the layers contains the height value, i.e. contour lines with the 

height of 300 metres above sea level are stored in the layer called â€ś300” and its value is attributed to the layer 

by transforming its name into number (for examples in ArcView see chapter 7). In the second case, a colour 

code is attributed to the height values. For example colour code 50 is attributed to 300 metres and height values 

can be attributed to it later based on the colour (for example in IDRISI). We have to note, however, that the 

number of colour codes is limited, generally 256 colours can be used - therefore height values cannot be used as 

colour codes automatically (simply there is no colour code for 300). Colour codes changed according to the base 

contour lines can be one solution: for example if the base contour interval is 5m then height between the contour 

lines changes 5 metres but colour code changes only one value (0m represents 1, 5m represents 2, 10m 

represents 3 and so forth). 

Practically the colours applied have no significance regarding the aim of the analysis as not the colours used in 

vectorizing will appear but they can be attributed to the contours in the given software. 

5.3. Determination of the co-ordinate system 

In order to make the analysed area located in space - not just hanging in the World - attribution of co-ordinates 

is necessary. For this the georeferenced raster base map should be used (for details see chapters 2 and 4). In 

certain cases, however, applying simpler methods can be enough as well. EOTR is a plane co-ordinate system, 

i.e. practically a rectangular network in which the location of a point can be defined with great accuracy with the 

help of the kilometre network. Procedures required for placing a map segment into its appropriate location are 
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discussed on chapter 10.3 of the Geoinformatic Applications textbook. (When we want to determine the co-

ordinates take care that values X and Y are replaced! If this is ignored a map rotated by 90° will be the result at 

insertion.) 

5.4. Controlling object type 

Object types can be used relatively freely in the course of digitizing (vectorizing) in AutoCAD. Virtually 

anything can be included in a layer (point, line, polygon, text) and even the replacement of any sub-type (e.g. 

line segments instead of line chains) causes no problems. In special geoinformatic softwares - like the ArcView 

- certain types are strictly defined and cannot be replaced by each other. The software permits for example only 

one type of object in one layer (theme) and misused line types causes significant problems as well. Therefore 

these have to be controlled and fixed if necessary in the case of files imported from AutoCAD. Frequently 

occurring cases are discussed in the following sub-chapters. 

5.4.1. Point (symbol) 

In AutoCAD point objects are frequently marked by symbols as real points can be hardy seen (see chapter 9.2 of 

Geoinformatic Applications). However, these have to be transformed into real points (or they should be used 

from the beginning) prior to import into ArcView. Without this symbols will be interpreted as polygons - with 

spatial extent - and not as points. And the actions characteristic for points cannot be executed (chapter 12.3 of 

Geoinformatic Applications) and the size of the symbol also changes with increasing the size of a map! 

5.4.2. Line 

Difference between the line types was shown when AutoCAD was used (chapter 5.1 of Geoinformatic 

Applications). Make sure that Ployline type is used as in the case of line segments (Line) the line is only 

seemingly united, in reality it is composed of separate segments the end-points of which are located on each 

other. As a result attribute data have to be attributed to all segments after exporting into ArcView: this on the 

one hand increases file size and data input time by several magnitudes and on the other hand impedes or makes 

difficult several operations. For example for a line composed of several thousand points (e.g. for the drawing of 

a road) not only one but several thousand data have to be given (e.g. road number). Using the Spline option 

should also be avoided as problems may in measurements and illustrations arise due to curved lines. 

5.4.3. Polygon 

In AutoCAD polygons are constructed from Polylines with closing at the end or after drawing (chapter 5.3 of 

Geoinformatic Applications). Occasionally this step is missed, however, this causes significant problems in later 

data analyses. This error is revealed right away when the file is imported into ArcView: although the polygon 

type is selected (chapter 11.2 of Geoinformatic Applications) the conversion of only the real polygons will take 

place and that of Polylines not. Figure 6.1 shows the result when only a few elements are wrong: in this case its 

surroundings occur (with the fill appropriated to the polygon) while at the place of the defective element a hole 

remains. Figure 6.1 shows a map depicting 19 counties of Hungary on which Heves county was vectorized by 

polyline instead of polygon: an empty hole is found in the place of it and only 18 polygons can be seen. 
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Figure 6.1: Deficient object type (polyline instead of polygon) 

It is possible that the polygon (e.g. a lake or a parcel, etc.) is cut by the margin of the map segment, i.e. it is 

continued on the neighbouring sheet. In the course of vectorizing that is performed by segments lines are 

frequently completed (cut) along the margin of the section: therefore no polygon but lines are produced. To 

avoid this, the line shall be drawn in the margin of the map contents. In case the polygon is crossed only by one 

side the connection of the starting and end points (chapter 5.3 of Geoinformatic Applications) is enough. But if 

several sides cross the polygon place digitalization points on the corner points as well, without them the 

connection of the starting and end-points cuts the corner! Then after importing into ArcView make sure to unify 

polygons related to the same element (chapter 5.3.2.4) 

Controlling questions 

Self controlling questions: 

Why is the division of the dwg file necessary prior to the import into ArcView? 

How the dwg file is divided prior to the import of the file in ArcView? 

Which are the most frequent errors in the course of using the objects. 

Test: 

How many layers of the dwg file shall be placed into the separate file prior to the import into Arc View. ? 

a, Always only one 

b, It can be several depending on the content 

c, Division of the dwg file is not necessary. Why is it required in AutoCAD to which colours cannot be added? 

a, In order to achieve better overview. 

b, Attributing parameters can be made based on the colour code in different geoinformatic softwares. 

What indicates the import of the .dwg file into ArcView if vectorizing included poliline instead of polygon? 

a, A „hole” remains at the place of the faulty object 
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b, An error message is received in the course of importing. 

6. Connecting geometrical and attribute data 

The previous chapters described the establishment mainly of geometrical datasets (map elements) and this 

chapter gives an overview of a few frequently used method of filling the data table. 

6.1. Data table filling during vectorizing 

In case vectorizing takes place in ArcView the most practical way of data table filling is to fill in the data of 

elements - or several elements of similar value - right after digitizing them. Forming the data table is described 

in chapter 11 of the Geoinformatic Applications textbook. 

Realization in practice includes the following steps (keywords are in brackets as reminders): 

1. Digitizing the first object (chapter 5). 

2. Opening the theme table 

3. Making the table editable (Table → Start Editing) 

4. Forming new column (Edit → Add Field…) 

5. Entering the data of the object (the table is updated from top to bottom, i.e. the dataset of the latest object is 

found bottommost) then saving. 

6. Making the theme editable that is vectorized. 

7. Drawing new elements. 

Mostly it is sensible to write at least one data after forming the new element in order to make future 

identification easier. For example in the case of a cadastral map if all of the polygons are drawn it would be 

extremely difficult to attribute the land register reference to them and it is very difficult to find the elements on 

which the dataset is relevant (for more details see chapter 11 of the Geoinformatic Applications). The same 

applies to the contour lines - emphasized more - as well. 

6.2. Creating data generated partly automatically based on 
imported data 

Imported maps can contain several types of data from which new attributes can be generated in the 

geoinformatic system. This method is presented on the basis of attributing values to the contours of topographic 

maps. 

First of all the appropriately prepared vector maps (e.g. dwg format) map is imported. Preparation in this case 

means that only the contour lines from the original map are stored in a separate file (for details see chapter 

6.2.1). The initial step for importing (using the command View → Add Theme) is discussed in detail in chapter 

11.2 of the Geoinformatic Applications textbook. Make sure that contour lines are imported as Lines! (Do not be 

confused by the totally different meaning of the same expression in different surroundings: Line means line 

segment type in AutoCAD.) The aim of the procedure is to convert the vector file into shape (shp) format. 

Following this when the command Open Theme Table is selected the data table of the vector file appears. The 

default data of the table are the following (Figure 7.1): 

• Shape: object type of the shape file (it can be Point - point, PolyLine - line and Polygon - area). 

• Entity: the object type from which the given element is composed (in the present case the polygon is 

composed of closing a polyline). 

• Layer: layer of the object in the original vector file. 

• Elevation: default value of elevation above sea level is 0. Determination of the real value will be the next step. 
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• Thickness: value of line thickness. If not defined separately it is 0. The default 0 value is practical for future 

analyses when line thickness is important. 

• Color: colour of the object (indicated by a code). 

 

Figure 7.1: Original data table of contour lines 

With the Table → Start Editing command the data table can be edited (this is indicated by that the letters of the 

column captions become normal). Deleting unnecessary columns is not essential but recommended for better 

arrangement. Click on the caption of the column to be deleted. Successful highlighting is indicated by white 

letters with grey background in the caption (as can be seen in the case of column named Elevation in Figure 

7.2). With the command Edit → Delete Field the column will be deleted. Any column can be deleted except for 

the one describing the type of the object (Shape). Note, that delete cannot be reversed therefore rather delete less 

data than miss any important ones later! When digital elevation models are prepared the Layer column has to be 

retained as contour lines were taken in the layers according to their values in the original vector file. Retaining 

the Elevation column is also practical as contour line values will be placed here in the next step (Figure 7.2). 

 

Figure 7.2: Modified data table of contour lines (only the unnecessary columns were deleted) 

The next step is to determine the elevation value of the contour lines. In the case of a properly prepared vector 

file (see chapter 6.2.1) this is a relatively easy and fast procedure. According to the recommended method, in the 

imported vector file the name of the Layer means the value of the contour and this can be found in the data 

Table of shape (Layer column). Here, however, the value is regarded to be text (this is indicated by their left 

alignment - like for example in Microsoft Excel). This has to be converted into number. The procedure can only 

be successful if there are no other characters than numbers and decimal points - as the English regional setting is 

active. In case underlining (or any other character) indicated the decimal point (as is recommended in the course 

of vectorizing, for more details see chapter 6.2.1) it has to be replaced by point before conversion. This cannot 

be done automatically for all characters in ArcView, we have to open the data table and re-write the characters 
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one-by-one (see chapter 11.4 of Geoinformatic Applications). It is much faster if we open the dbf format 

(database) file associated with the shape in a software suitable for editing tables (e.g. Microsof Excel) and 

replace the characters. Make sure all characters are replaced otherwise completing the following steps will not 

be possible. 

Converting the name of the layers into numbers is next. For this highlight the column that will contain the 

values of elevation above seal level. This can be the (already existing) Elevation column but new columns can 

be formed as well (for more details see chapter 11.4 of Geoinformatic Applications). Then when the Field → 

Calculate…command is given the Field Calculator window will appear. It contains the following parts (Figure 

7.3): 

• Fields (column): The column from the data of which calculation is made. 

• Type: Data type of the column containing the data. This can be Number, String (text) or Date. 

• Request: List of the possible procedures 

The columns into which data will be entered can be seen above the procedure window on the left bottom (the 

white, rectangle shape part). This can be seen in black colour in the grey background and cannot be changed in 

this phase of the procedure (the Elevation column in our example). The procedure window shows the requested 

procedure series for which select first the column the data of which are used from the Fields part: it will appear 

in the procedure window after a double left click. Then highlight the original data type in the Type part (left 

click) - this will not appear in the procedure window. Finally choose the demanded procedure from the Request 

part: this will also appear in the procedure window after a double left click. In our current example the following 

procedures are selected (Figure 7.3): 

• Fields (column): Layer - elevation values are contained by the name of the layer. 

• Type: String - the layer name is text (it cannot be number). 

• Request: AsNumber - this is the command transforming text into number. (Paying attention to that it contains 

only numbers and decimal points as discussed above!) 

 

Figure 7.3: The Field Calculator window 

As a result of the procedure the elevation values of the contour lines will appear in the Elevation column. 

Number data type is indicated by their right alignment in the cells (like in Microsoft Excel) (Figure 7.4). 
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Figure 7.4: Modified data table of contour lines with the elevation values 

In case any data was not in the appropriate format in the Layer column (i.e. contained not only numbers and 

decimal points) an error message appears (Figure 7.5). 

 

Figure 7.5: Conversion error message 

Conversion is executed but improperly: the software stops the process after the first failed row (Figure 7.6). In 

this way, apparently this is unsuitable for further procedures. The mistake has to be corrected (by replacing the 

faulty characters). 
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Figure 7.6: Modified data table of the contour lines with the elevation values in the case of faulty original data 

It is very important to eliminate all highlighting at the end of construction using the Edit → Select None 

command as any object that remained highlighted will not be presented when the thematic map is constructed! 

Closing the construction and saving the data are made by the Table → Stop Editing command. At this time a 

warning appears in the Stop Editing pop-up window (Figure 7.7) asking whether we want to save the changes 

(Save Edits?): apparently select Yes if the changes are regarded to be appropriate. 

 

Figure 7.7: Warning before saving the data table 

6.3. Adding the data table to the already existing map data table 

In the course of both vecorizing and importing apart from the graphical content (shp file) a data table is created 

automatically as well (dbf format file with the same name as the shp - see previous sub-chapters): in this a row 

is associated with every element. In both cases the addition of the data of a separate data table is possible and 

the process of this is discussed in this sub-chapter. 

The first phase is the creation of the new map. This process has been discussed in detail in chapter 11 of the 

Geoinformatic Applications textbook as well as chapter 5 of the present textbook. Either the map is imported or 

vectorized in ArcView it is necessary to create an individual identification (ID) for every element (in a new 
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column) in the data table of the map generated automatically. This can be of any format (number, text or the 

combination of the two). Figure 7.8 shows the partially transformed table of the county map of Hungary: 

• The unnecessary columns created in the course of import have been deleted (Entity, Layer, Elevation, 

thickness, Width, Color). 

• Input of new data has been performed (Name, Area, Population) - for details on the process see chapter 11 of 

the Geoinformatic Applications textbook. 

• The column containing the identifier (ID) essential for later additions has been created. 

 

Figure 7.8: Original data table of the map 

Requirements considering the identification code: 

• Every object have to have an individual identification (doubling will be impossible). 

• Every element have to be associated with an identification, the value cannot be empty. 

• The identification can be of any format (number, text or the combination of the two). However, simplicity and 

clear structure are important. Therefore it is practical to avoid too many characters (for example the name of 

the county can be the identification in theory but it is not practical) and accented letters (they increase the 

possibility of mistyping). 
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In the next step the new data table to be added to the map is required. This has to include the new data and the 

individual identification code of the elements. Its creation can be performed in two ways: importing an already 

existing table or creating a new one. 

For importing a data table, open the summarising window of the project (Figure 7.9) then open the file editing 

window using the Add button and select the database to be opened. This has to have the dbf format as the xls 

format (Excel) - at least in this software version - is not supported. 

 

Figure 7.9: Data tables of the project 

There is the possibility of creating a new data table as well in ArcView. For this, select the New button in the 

summarising window of the project (Figure 7.9). The new table is empty containing neither columns nor rows 

(Figure 7.10). It filling with data is performed as discussed before (chapter 11 of Geoinformatic Applications). 
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Figure 7.10: Creating a new data table 

Figure 7.11 shows the already filled table. Required fields are the ID and the new data (the Székhely /Centre/ 

column in the present example). Apart from these, such data that are found in the data table of the map can be 

included as well (the Név /Name/ column in the present example): for better understanding this name column is 

present in the example, however, this may cause problems later (see later). 
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Figure 7.11: The new data table filled with data 

Important requirements regarding the new data table: 

• Same number of data rows as in the data table of the map. Either more or less adding will not be possible. 

• Identifications have to be the same. In case they do not match perfectly adding again will not be possible. 

The next step is to add together the two tables. For this both tables have to be seen (do not close editing) and the 

column containing the identification has to be selected (caption is white with grey background) - in the case of 

our example this column is named ID. The table into which data are inserted has to be active (clicking on the 

caption will make its colour darker blue) - the data table of the map in the present example (Figure 7.8). Finally, 

by selecting the Table → Join command or the corresponding icon (icon 12 in Figure 7.12) joining is completed 

(Figure 7.13). 

 

Figure 7.12: Icon row of the table 
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Figure 7.13: The joined table 

Note that the inserted content cannot be modified (deleted, re-written) - this is indicated by that the caption of 

the inserted content remains italic when the table is made editable again (Table → Start Editing) indicating that 

this part of the table cannot be changed! Therefore in case we would like to avoid unnecessary doubling (for 

example the Név /Name/ is present in Figure 7.13) unnecessary columns have to be deleted before adding the 

tables together. (The Név /Name/ column was kept in the example only to visualize the process and logic of 

joining the two tables and make it controllable.) 

Controlling questions 

Self controlling questions: 

How is data attributed to objects in the course of digitizing in ArcView? 

How can we obtain new attributes from the layer structure of the original (dwg format) file? 

What is the procedure of adding to data tables together in ArcView? 

Test: 

In the case of displaying contour lines which is the best layer name type (regarding future conversions)? 

a, Szintvonal_300_meter 

b, 300_m 

c, 300 

Which is the appropriate relation if we would like to acquire number data from the name of the layer containing 

the contour lines? 

a, Elevation As Number. 

b, Layer As Number 

Which command adds two data tables together? 

a, Join 

b, Summarize 

c, Merge 
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7. Creating digital elevation models 

The chapter reviews the creation, display settings and associated functions of digital elevation models with 

special focus on the characteristics of the TIN model. 

7.1. The TIN model 

The TIN (Triangulated Irregular Network) model covers the surface with triangles of irregular shape and size. 

Its advantage is that it adjusts well to the landforms that are irregular as well in reality. 

7.1.1. Creating TIN 

The base of the digital elevation model is a vector file the establishment of which was discussed in chapter 7.2. 

The initial map is of line object type containing the elevation data (in the Elevation column) as well. 

When starting the procedures make sure to highlight the theme. When the Surface → Create TIN from 

Features… command is given the Create new TIN window will appear the elements of which are the following 

(Figure 8.1). 

• Active feature themes: themes applicable for creating the elevation model (layers) 

• Class: the type of lines in the initial file (regarding our example this is PolyLine) 

• Height source: the column containing the elevation values of contour lines 

• Input as: input line type 

• Value field: the column containing the values (in the case of a GRID model) 

 

Figure 8.1: Setting the input data of TIN 

After setting the appropriate parameters and clicking OK the Output TIN Name pop-up window appears (Figure 

8.2) where the location of saving can be set. It is practical to use the folder of the actual work. The files of the 

elevation model appear in a new sub-folder the name of which is given in the TIN Name part of the window. 
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Figure 8.2: Giving the save location of the TIN 

Processing is generally a longer procedure (depending of course on the hardware parameters of the computer). 

In the meantime a script in the left bottom corner (Adding Lines to Feature TIN) indicates the ongoing process. 

The resultant TIN model appears as a new theme presented in Figure 8.3 with the default settings. 
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Figure 8.3: The TIN digital elevation model with default settings 

7.1.2. Changing the parameters of the TIN model 

The parameters of the TIN model can be edited in the TIN Legend Editor (Figure 8.4) window that appears after 

a double left click on the name of the model (can be seen on top of the theme list in Figure 8.3). The elements of 

the Legend Editor are the following: 

• Theme: theme on which the elevation model is based 

• Points window part: for setting the point objects 

• Lines window part: for setting the line objects 

• Faces window part (surface): for setting the filling of the surface 

 

Figure 8.4: Parameters of the elevation model 

7.1.2.1.  Lines window part 

In the Lines menu item the contour lines that give the basis for the elevation model can be displayed the 

parameters of the contours can be given in the pop-up window (Figure 8.5) appearing after clicking on the Edit 

button found in this window part. 
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Figure 8.5: Setting the contour lines of the elevation model 

Parts and settings of the Legend Editor window: 

• Theme: theme on which the elevation model is based - should remain unchanged. 

• Legend Type: category type of lines can be given. In the present case this can be only Unique Value (nothing 

else is offered). 

• Values Field: Breaklines setup should remain unchanged. 

• Symbol - Value - Label show the actual settings of the category, the Count show the number of elements in 

the given category. 

• Color Schemes: predefined colour distribution according to the character of the content. 

For more detailed discussion of the display see chapter 12 of the Geoinformatic Applications textbook. In case 

we would like to display the contour lines differently (basic, main and subsidiary contours) this option has to be 

switched off by clicking into the square left of the Lines script. Switched off state is indicated by the 

disappearing tick. Then drag the theme on which the elevation model is based above the elevation model in the 

list (otherwise it remains covered) and open it and attribute settings to it (colours, line thickness - for the 

procedure of this see chapter 12.2 of the Geoinformatic Applications). 
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7.1.2.2. Faces (surface display) part of the window 

The parameters of surface display can be given in the Faces part of the window. Its parts are the following: 

• Label: text in the caption of the legend. The Elevation Range text can be rewritten if needed (for example in 

the case of constructing a Hungarian map it could be rewritten into „MagassĂˇg” - as this cannot be changed 

elsewhere /e.g. when the map is finalized/). 

• Legend: colour distribution appropriate for the elevation model can be selected. Possibilities are the 

following: 

•  

• Illuminate faces: in switched on state (indicated by a tick in the square left of the script) the surface will be 

displayed with hillshade, or without it if the function is switched off (Figure 8.6). 

 

Figure 8.6: Relief display without (left) and with (right) relief shadowing 

Selecting the Edit… button in the Faces frame the Legend Editor window pops-up (Figure 8.7) the elements of 

which are the following: 

• Theme: layer of the actual TIN model 

• Legend Type: type of filling can be determined. In this analysis only the Graduated Color option can be 

selected. 

• Classification field (column of classification): Column of data used for calculating the TIN model. 

• Normalyze by: in the case of any calculation only one member of it can be selected 

• Below the Symbol - Value - Label captions the current settings of the actual layers can be seen. 

• Color Ramps: pre-defined colour distributions according to the character of the content, i.e. palettes can be set 

here for the determination of the digital height colours. Note that the colour grades generated automatically by 

the software are not always the same as those applied traditionally in mapping (8.1. animation). The author 

recommends the Red Monochromatic and the Beige to Brown types. Since the two extreme values of the 

colour grades are adjusted to the extreme values of the given area it is possible that the - otherwise adequate - 

green-brown will cause problems as well: because independent from the absolute height above sea level white 

will be attributed to the highest parts! Therefore people will have the feeling that the highest regions are 

covered by eternal snow - even if the areas are much lower! (For example in the case of the elevation model 

of Hungary the highest areas of the MĂˇtra and the Bükk appear in white!) Without the definition of an 

individual palette - as it is a lengthy process with numerous potential errors - this problem can be solved by a 

simple solution: set the categories so that no areas are included in the highest one. Considering the Hungarian 

example this means that the lower boundary of the highest category would be 1015 metres (or a value slightly 
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above it). Moreover, completely unique colour distribution is also possible, for more details see chapter 12 of 

Geoinformatic Applications. 

 

Figure 8.7: Automatic setting of the height colouring of the elevation model 
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8.1. animation: The elevation model with various palettes 

When the TIN model is created not only one but eight pieces of adf format file are also created that can be found 

in a sub-folder within the folder of the work - the name of the sub-folder had to be given in the initial phase of 

TIN creation (Figure 8.2) 

7.1.3. Handling templates 

As discussed above the classification generated automatically by the software is mostly inappropriate as the 

number of categories is standard and category intervals are obtained by the equal division of the range between 

the two extreme values. Therefore in different maps - as the extreme values of height above sea level can be 

equal only accidentally - the same elevation is marked by different colours making their comparison difficult. 

Therefore it is sensible to use similar categories (and colour distribution) in the case of areas with roughly 

similar characteristics (vertical extent). In the case of Hungary - due to the relatively small heights - two 

category systems are enough: one for the hills and mountains and another for the lowland areas (to make the 

landforms of plains displayable, for example the ancient river beds in a once waterlogged area). 

7.1.3.1. Creating a template 

In the first step the classes have to be defined. For this select the Classify button in the construction window of 

the TIN model (Figure 8.7). In the Classification window (Figure 8.8) the setting of three classification 

parameters can be made. These are the following: 

• Type: method for defining class limits in the case of automatic re-categorizing. The scroll down window 

allows only the Equal Interval option. 
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• Number of classes. 

• Round values at: number of decimal values, the d letters after d. indicate their number. It is practical to 

choose round values (d). 

When the classes are defined the followings have to be considered: 

• Try to find the golden mean regarding the number of classes: the content is lost if they are too few, however, 

if they are too many the colour difference between the neighbouring classes will be too small and they will 

blend (making the reading of the map difficult). 

• It is practical to define the class limits when the number of classes is known. Choose round or half round 

values for simplicity. This is 25 metres in our example. 

In practice the number of classes can be changed until the intervals will be near the chosen ones. For practical 

reasons leave the values below the chosen interval if they are not the same exactly. 

 

Figure 8.8: Defining the value intervals of the elevation model 

In our example the rounding of values is a round value (d) and the number of classes is 20 (Figure 20). 
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Figure 8.9: Intervals after defining the number of classes 

In the next step the class limits shall be defined. For this we have to click in the cell to be modified in the Value 

column in the Legend Editor window. Then type in the demanded value. When the interval is defined from-till 

format have to be used (e.g. 200-225). Figure 8.10 presents the appropriate intervals. 
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Figure 8.10: Intervals appropriate for the purpose of the work 

Finally, save categorization in a template file (avl format). This will contain the class values and the fillings 

associated with them (colour and pattern). For this choose the Save… button in the Legend Editor window 

(Figure 8.10). After setting the location of saving and pressing OK the template is saved. 

7.1.3.2. Loading template 

Following the creation of the digital elevation model when the appropriate template is loaded the classification 

is completed. For this open the TIN Legend Editor window (Figure 8.4) by a double left click on the theme. 

Select the Edit button from the Faces frame. In the appearing Legend Editor window select the Load… button 

and then choose the demanded template (Figure 8.11). 
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Figure 8.11: Selecting the template load 

After clicking OK, the loading parameters of the template can be defined in the appearing Load Legend window 

(Figure 8.12) - accept the default settings. 

 

Figure 8.12: Defining the loading parameters of the template 

7.2. Interpolating contour lines from the digital elevation model 

The inverse of the above procedures is also possible, i.e. construction of a contour map from the digital 

elevation model. 

In the Contour Parameters window (Figure 8.13) appearing after the Surface → Create Contours… command 

the required parameters can be set: 

• Contour interval and 

• Base contour 

values are meant in metre. 
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Figure 8.13: Defining the parameters of contour construction 

The data table of the shape (Figure 8.14) containing the new contours is different from the one we described at 

discussing the import of the vector contour map (Figure 7.1). The contents of this one are the following: 

• Shape (object type): in this case it is apparently line 

• ID (Identification Number): every line receives an individual identification code. Contours are created in a 

row of increasing values, this is reflected by the numbering of the ID. 

• Contour: height value of the contours (in metre). Virtually the same as the shape Elevation column created 

when the vector maps were imported. 

 

Figure 8.14: Data table of automatically generated contours 

Figure 8.15 shows that every conversion results in data loss and accuracy decrease. Black lines represent the 

originally vectorized contour lines while red ones were prepared from the TIN model interpolated on the basis 

of the original contour lines. The difference between the original and the back interpolated contour lines is 

apparent. Repeated conversion cuts the protruding parts (e.g. summits) and makes the finer forms disappear. 
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Figure 8.15: The original (black) contour lines and those interpolated from the digital elevation model (red) 

7.3. The GRID model 

The GRID is an elevation model composed of evenly (squared) located grid elements (pixels). The Grid can be 

constructed either directly from field measurements or from the TIN model by interpolation. This textbook 

presents the latter method. 

7.3.1. Creating GRID from TIN 

First, select the theme of the TIN model (left click on the name of the TIN) then apply the Theme → Convert to 

Grid… command. In the pop-up window define the location for saving the GRID (Figure 8.16) and accept it by 

clicking OK. 
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Figure 8.16: Setting the location for saving the GRID 

In the appearing Conversion Extent window (Figure 8.17) determine the parameters of the GRID. These 

parameters can be the following: 

• Output GRID Extent: the size of the GRID can be defined compared to an already existing character. 

Possibilities are the following: 

• Same As View: size same as the view (map) 

• Same As Display: size as the actual window 

• Same As … (TIN model): size same as that of the TIN model on which the GRID is based - this is the 

practical selection 

• Same As …shp (name of theme): size same as that of the theme (shp) 

• Output Grid Cell Size: If this is reduced resolution will be increased, however, the size of the database also 

increases squarely 

• Number of Rows: number of rows in the GRID model 

• Number of Columns: number of columns in the GRID model 
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Figure 8.17: Parameters of the GRID 

After clicking OK the procedure may take longer depending on the selected resolution. The current state of the 

process can be seen in the Interpolating GRID belt in the bottom of the window that can be seen only in this 

stage. The execution of the process is followed by a question whether we want to add the new file to the already 

existing ones or not (Figure 8.18). Select Yes. The GRID model accepted with the default settings is presented 

in Figure 8.19. 

 

Figure 8.18: Confirmation of adding the GRID 
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Figure 8.19: The GRID (with the default settings) 

Re-classification is made similarly to that discussed in the case of the TIN model (sub-chapter 8.1.2) with the 

difference the only the Value can be selected in the Field zone. When the GRID model is created not only one 

but five adf format files are created also that are found in a sub-folder within the folder of the work - the name 

of this had to be given in the initial phase of the creation of the GRID (Figure 8.16). 

7.3.2. Comparison of the TIN and the GRID 

Difference between the GRID and the interpolation of the TIN is presented in Figure 8.20. The TIN follows the 

unevenness of the surface better, however, the GRID has fewer mistakes with no unnaturally sharp changes. 
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Figure 8.20: Comparison of the GRID (above) and the TIN (bottom) models 

7.4. Errors of the digital elevation model 

This subchapter discusses a few errors made frequently in the course of digital elevation model construction. 

7.4.1. Errors from mistakes made during digitization 
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It is possible that false height value is associated with the contour line during the vectorizing of the base map. 

There can be many reasons for this, some of the - more important - error sources are the following: 

• When a new contour line is vectorized the actual layer is not changed - this may occur during the work in 

AutoCAD. 

• False value is written in the data table - frequent during digitization in ArcView. 

The digital elevation model created from faulty contours or data tables will be faulty as well therefore the 

correction of the problematic parts is fundamental. Differences can range from slight to serious faults. In all 

cases the creation of a â€śrough” DEM is practical where colour grades have to be given with the same value of 

the base contour interval of the digitized map because in this way one contour interval will receive one colour 

and the original contours have to be displayed as well. For example on the map in Figure 8.21 the base contour 

interval was 25m. When the contour line with the false value is identified it has to be corrected in the data table 

(for more details regarding identification see chapter 11 of the Geoinformatic Applications textbook). 

Correcting the value of the contour lines in ArcView is relatively simple, however, labour consuming. The steps 

of this are the following (8.2. animation): 

1. Prepare the elevation model based on the raw data in the way described above. 

2. Display the elevation model and the theme containing the contour lines above it. Adjust the view window so 

that it occupies the greater part of the screen. 

3. Open the data table of the theme containing the contour lines and adjust it so that it occupies the smaller part 

of the screen and does not cover the view window. 

4. Open both for editing (Start Editing). 

5. Select the highlight icon (icon 22 in Figure 5.1). 

6. Determine the correct value of the wrong contour line (by identifying the surrounding contours). 

7. Click on the identified wrong contour line. Data of the selected contour line appears highlighted by yellow 

colouring in the data table of the contour. Highlighting the table (clicking on its caption) select the edit icon 

(icon 21 in Figure 7.12) from its icon row then re-write it by clicking into the cell of the value to be corrected 

in the table. 

8. Continue with the identification and correction until all faults are corrected. 

9. When completed, close the editing of both the map and the data table (Stop Editing) and save the changes. 

10. Delete the elevation model constructed on the basis of faulty values (since the correction of the contour 

lines does not update the elevation model because they are independent from each other). 

11. Create the elevation model - now on the basis of the contour lines containing the corrected values - 

again. 

In Figure 8.21 a trench seems to be visible near the top of a ridge running NW-SE due to a false contour value. 
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Figure 8.21: Elevation model interpolated from a faulty vector base map 

 

8.2. animation:  Correcting the false value of the contour lines 

7.4.2. Errors of the interpolation procedure of the software 



 Environmental Informatics  

 147  
Created by XMLmind XSL-FO Converter. 

Significant errors may arise due to the interpolation method of the software. Most frequent problems are the 

following: 

• In the case of an area with irregular shape (e.g. a map segment) data belts impossible to interpret occur in 

those parts that lack of data. The solution can be the masking out of the unnecessary areas or the cut of the 

area. 

• Even in the case of very differing data density interpolation errors may occur. Most frequent of them appears 

when less dissected areas are found in-between strongly dissected surfaces. For example when a wide valley 

crosses a mountainous area. In such cases there are few data in the slightly dissected area (contours are fewer 

by around a magnitude than in the surrounding area) and as a result false values will occur for these areas. In 

Figure 8.22 weird stripes are seen in the valleys - marked by red colouring. 

• The previous two are combined in the problem of water surfaces: the extended flat surface is not displayed as 

flat but the relief of the surrounding - dry land - areas is extended over the water surfaces. As a result the 

water surface will not be flat but almost â€śwaving”. 

 

Figure 8.22: False interpolation in the digital elevation model 

Controlling questions 

Self controlling questions: 

How the TIN model is created from the vector file? 

How is it possible to construct contour lines from TIN models? 

How a GRID model is constructed from a TIN model? 

Test: 

What does the term TIN mean? 

a, Irregular Triangle Network 

b, Square network 

What does the Illuminate Faces option mean at displaying the TIN model? 
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a, displaying contour lines 

b, hillshade 

In which frame of the TIN model construction window is it possible to define the parameters of the colour fill of 

the surface? 

a, Points 

b, Lines 

c, Faces 

8. Creating thematic maps from digital elevation 
models 

The chapter overviews the construction of a few important thematic maps based on digital elevation models. 

The basis for our examples is the TIN model. It is important to have the parameters of the map set appropriately 

(see chapter 11.2 in Geoinformatic Applications) otherwise serious errors may arise. For example, if the height 

unit is set for metre instead of kilometre the vertical distortion will be 1000-fold as for example 200 metres of 

rise is counted for 1metre horizontal distance instead of 200 metres rise in the horizontal distance of 1 

kilometre! 

8.1. 9.1. Slope category map (Slope) 

The slope category map shows the slope angle values of the land. Initially select the Surface → Derive 

Slope…command that opens the window for defining the parameters (Figure 9.1). 

 

Figure 9.1: Setting the parameters of the slope category map 

In the Output Grid Specification window (Figure 9.1) the following characteristics can be defined: 

• Output GRID Extent: the size of the deduced map can be determined compared to any of the existing layers. 

Options are the following: 
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•  

•  

•  

• Cell Size: the output (result) cell size. Reducing the pixel size increases resolution and increases the size of 

the database quadratic. 

• Number of Rows: number of rows in the model. 

• Number of Columns: number of rows in the model. 

Following the determination and acceptance of the parameters the calculation process may take - depending on 

the selected resolution - a long time. In the meantime the belt beside the Interpolating grid script at the bottom of 

the screen shows the actual stage. The slope category map appears as a new theme in the top of the theme list at 

the end of the procedure (i.e. contrary to the creation or import of a new theme it does not have to be added to 

the project). Figure 9.2 presents the displayed slope category map with default settings (categories, colour 

palette). 

 



 Environmental Informatics  

 150  
Created by XMLmind XSL-FO Converter. 

Figure 9.2: Slope category map with categories generated automatically (Orange monochromatic palette) 

Categorization in the slope category maps applied in practice is different depending on their purpose. Categories 

applied most frequent in geomorphology are: 0% - 5% - 12% - 17% -25% - 40%. Since the ArcView uses 

degrees for slope steepness they have to be converted before setting the categories: slope angle (percent) - tg 

slope angle (degree) x 100. Conversion of categories is presented in Table 9.1. Figure 9.3 shows the 

categorization of the model area with geomorphological - discussed above - purpose. Constructing the 

categories is mostly the same as discussed in the case of TIN model construction and re-categorization (chapter 

8.1) - with the difference that the number of categories is known here right from the beginning (6 in our 

example) - therefore it is not discussed here. Easy overview shall be achieved when the filling pattern (colours) 

is defined: if possible select only one colour with its shade where lighter shades represent smaller and darker 

shades the higher values. If different colours are associated with each categories the map will be almost 

impossible to read (Figure 9.4)! 
 

Slope angle in percentage Slope angle in degrees 

5 2.8624 

12 6.8427 

17 9.6480 

25 14.0326 

40 21.8010 

Table 9.1: Percentage - degree conversion 



 Environmental Informatics  

 151  
Created by XMLmind XSL-FO Converter. 

 

Figure 9.3: Slope category map with categories generally applied in geomorphology (Orange monochromatic 

palette) 
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Figure 9.4: Slope category map with categories generally applied in geomorphology (Full spectrum palette) 

8.2. Slope aspect map 

The slope aspect map presents the classification of the surface according to orientation towards the points of the 

compass. The number of the categories has to be determined first and this depends primarily on the resolution of 

the base map (elevation model): 

• 4: only the main points of the compass (N, S, E, W), where the width of the categories is 90°. It is generally 

applied in the case of small resolution maps where small landforms cannot be presented therefore more 

detailed categorization is pointless. 

• 8: main and auxiliary points of the compass (N, NE, E, SE, S, SW, W, NW), where the width of the 

categories is 45°. It is applied in the case of detailed maps. This is the most frequently used categorization. 

• 16: main, auxiliary and subsidiary points of the compass (N, NNE, NE, ENE, E, ESE, SE, SSE, S, SSW, SW, 

WSW, W, WNW, NW, NNW), where the width of the categories is 22.5°. It can be used in the case of 

detailed maps where micro-forms can be seen as well. It is used rarely as the high number of categories 

makes the reading of the map more difficult. 
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Please, note that the first category extends into both directions from the starting orientation (which is generally 

north). For example in the case of 4 categories North extends from 315° till 360° and from 0° till 45°. Therefore 

not only 4 but 5 orientation categories have to be defined in the course of re-categorization (0°-45°, 45°-135°, 

135°-225°, 225°-315°, 315°-360°) where the first and last categories mean the same and they have to be 

displayed similarly as well! ArcView considers this when its default settings are used therefore it has to be 

regarded only at re-categorizing. 

Always make sure that one more categories are required than the number of the points of the compass: because 

plain areas have to be excluded from the categorization as slope aspect has no meaning in their case. (For 

example the least dissected landscape of Hungary is the HortobĂˇgy where the land rises 50 cm by 1 km on 

average resulting in a slope angle of 0.05% - in theory the western aspect of the eastern part of the landscape 

could be determined /as it ascends towards the east) but it has no sense in an area practically flat like a table.) 

Land-use greatly determines what is regarded to be a flat area: mostly 1°, 2°, or 5° are regarded to be the upper 

limits. 

For creating slope aspect maps select the Surface → Derive Aspect… command that opens the Output Grid 

Specification window (Figure 9.5) where the following characteristics can be determined: 

• Output GRID Extent: the size of the deduced map can be determined compared to any of the existing layers. 

Options are the following: 

• Same As View: size similar to that of the view (map). 

• Same As Display: size similar to that of the actual display. 

• Same As … (TIN modell): size similar to that of the TIN model on which the slope category map was 

based – this is the practical option. 

• Same As … shp (name of Theme): size similar to that of the theme (shp) 

• Output Grid Cell Size: on the deduced map the pixels size can be determined. 

• As Specified Below: : it can be determined with the following three characteristics (Cell Size, Number of 

Rows, Number of Columns). This is to be selected if we have no deduced map yet the parameters of which 

we would like to copy (the analysis is completely new) or we wish not to use the already existing 

parameters. 

• Same as… (the layer of the deduced map): copying the parameters of an already existing map that is based 

on the TIN model. It can be selected only if one is existing (e.g. slope aspect, hillshade – for details see 

later). 

• Cell Size: the output (result) cell size. Reducing the pixel size increases resolution and increases the size of 

the database quadratic. 

• Number of Rows: number of rows in the model. 

• Number of Columns: number of rows in the model. 
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Figure 9.5: Setting the parameters of the slope aspect map 
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Figure 9.6: Slope aspect map with 8 categories 

Following the determination and acceptance of the parameters the calculation process may take - depending on 

the selected resolution - a long time. In the meantime the belt beside the Interpolating grid script at the bottom of 

the screen shows the actual stage. The slope category map appears as a new theme in the top of the theme list at 

the end of the procedure (i.e. contrary to the creation or import of a new theme it does not have to be added to 

the project). Figure 9.6 presents the displayed slope aspect map with default settings (categories, colour palette). 

Constructing the categories is mostly the same as discussed in the case of TIN model construction and re-

categorization (chapter 8.1) - with the difference that the number of categories is known here right from the 

beginning (6 in our example) - therefore it is not discussed here. Easy overview shall be achieved when the 

filling pattern (colours) is defined stick to the golden mean: using the shades of one colour is not practical as 

they would be difficult to read (only if greyscale is required in a publication), however, too many colours also 

make the reading of the map difficult. Most frequently four colours are used for the four main points of the 

compass and in the case of 8 or 16 categories the shades of these four colours are applied. Colour selection is 

determined by both tradition and subjective feelings as well: 

• Northerly slopes are blue as they are known (and felt) to be colder than the rest. 

• Southerly slopes are red as they are the hottest. 
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• Easterly slopes are in-between the previous two receiving a neutral colour: generally yellow. 

• Westerly slopes are also transitional but warmer than the easterly ones therefore they are generally green. 

8.3. Shaded relief 

The basis for hillshade is that the - theoretically - homogeneous surface is enlightened by parallel light rays 

coming from a defined horizontal direction and vertical angle. Brightness of the surface therefore depends on 

the amount of incoming light: surfaces with less light will be darker while those receiving more light will be 

lighter: resulting in a greyscale image practically. It is clear that it is not a quantitative display regarding land 

morphology: similar shades mean not similar heights above sea level, slope angle or slope aspect. For example, 

in the case of low angle illumination flat areas will be darker than the slopes facing the source of light. This is a 

thematic map that serves primarily illustration as it is a very spectacular form of display. 

For starting hillshade select the Surface → Compute Hillshade… command. The position of the source of light 

has to be given in the Compute Hillshade pop-up window (Figure 9.7) that is the following: 

• Azimuth: horizontal direction of the source of light. Its value ranges between 0° and 360° (9.1. animation). 

• Altitude: vertical angle of the source of light. Its value ranges between 0° and 90° (9.2. animation). 

 

Figure 9.7: Determination of the position of the source of light 

In the Output Grid Specification window (Figure 9.8) appearing after determining and accepting the parameters 

the characteristics of the deduced map are defined: 

• Output GRID Extent: the size of the deduced map can be determined compared to any of the existing layers. 

Options are the following: 

• Same As View: size similar to that of the view (map). 

• Same As Display: size similar to that of the actual display. 

• Same As … (TIN modell): size similar to that of the TIN model on which the slope category map was 

based – this is the practical option. 

• Same As …shp (name of Theme): size similar to that of the theme (shp) 

• Output Grid Cell Size: on the deduced map the pixels size can be determined. 

• As Specified Below: it can be determined with the following three characteristics (Cell Size, Number of 

Rows, Number of Columns). This is to be selected if we have no deduced map yet the parameters of which 

we would like to copy (the analysis is completely new) or we wish not to use the already existing 

parameters. 

• Same as… (the layer of the deduced map): copying the parameters of an already existing map that is based 

on the TIN model. It can be selected only if one is existing (e.g. slope aspect, hillshade – for details see 

later). 

• Cell Size: the output (result) cell size. Reducing the pixel size increases resolution and increases the size of 

the database quadratic. 
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• Number of Rows: number of rows in the model. 

• Number of Columns: number of rows in the model. 

 

Figure 9.8: Setting the parameters of the hillshade map 

Following the determination and acceptance of the parameters the calculation process may take - depending on 

the selected resolution - a long time. In the meantime the belt beside the Interpolating grid script at the bottom of 

the screen shows the actual stage. The slope category map appears as a new theme in the top of the theme list at 

the end of the procedure (i.e. contrary to the creation or import of a new theme it does not have to be added to 

the project). Figure 9.9 presents the displayed hillshade map with default settings (categories, colour palette). 
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Figure 9.9: Hillshade map with default settings 



 Environmental Informatics  

 159  
Created by XMLmind XSL-FO Converter. 

 

9.1. animation: Hillshade map with changing light direction 
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9.2. animation: Hillshade map with changing light altitude 

Control questions 

Self control questions: 

How is the slope category map constructed from the TIN model? 

How is the slope aspect map constructed from the TIN model? 

How is the hillshade map constructed from the TIN model? 

Test: 

What does the Output Grid Extent parameter mean at the presented thematic maps? 

a, Size of the thematic map 

b, Type of the thematic map 

What does the Cell Size parameter mean at the thematic maps? 

a, file size 

b, pixel size 

How many categories on average are found on a general slope aspect map? 

a, 8 
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b, 8 + 1 

c, 10 + 1 

9. Spatial visualization 

The digital elevation model is suitable not only to construct maps displayed in a plane but also for spatial 

models as well. This chapter describes the possibilities of 3 dimensional display and application. 

9.1. 10.1. Attributing elevation data to the theme 

In order to display in 3D themes with elevation data are required. The digital elevation model (TIN or GRID - 

their creation is described in chapter 8) contains the data, however, most of the layers (for example the elements 

of landcover: water, infrastructure, borders) do not. Therefore these layers have to be attributed with elevation 

data. If these acre missing they will occur in a useless way under the appearing digital elevation model. 

As a first step highlight and make active the theme to be transformed into 3 dimensional (in our example the 

layer containing the riverbeds) and then execute the Theme → Convert to 3D Shapefile… command. Source 

types of the elevation values can be given in the Convert pop-up window (Figure 10.1). 

• Surface: height data are from a digital elevation model - this is selected in our example. 

• Attribute: height data are from data sources. For example if we would like to display the contour lines of the 

topographic map of the area presented in the textbook in space this option has to be selected and then choose 

the Elevation column in the next step. 

• Constant: constant value. 

 

Figure 10.1: Defining the source type of eight data 

When the Surface option is selected the list of those themes that contain height data appear in the next window. 

In our example the elevation models (TIN, GRID) presented above and the thematic maps (slope category, slope 

aspect, hillshade) can be seen. Selecting the original elevation model is practical and in our example this is the 

TIN model (Figure 10.2). 
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Figure 10.2: Defining the theme containing the height data 

After the theme is selected the name and saving location of the new - 3D - themes has to be given (Figure 10.3) 

and its adding to the theme list has to be confirmed as well (Figure 10.4). 

 

Figure 10.3: Defining the name and saving location of the 3D theme 
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Figure 10.4: Confirmation of the addition of the new theme to the theme list 

9.2. Visualization in 3D 

Since we have the themes containing the height values their 3D visualization is next. Apply the View → 3D 

Scene… command and select the appropriate type in the appearing 3D Scene window (Figure 10.5): 

• Themes: a real 3D model is created - select this one in our example. 

• Image: a plane that can be rotated in space is created. 

 

Figure 10.5: Type of 3D display 

If Theme is selected and accepted several new elements occur in the ArcView working window (Figure 10.6): 

• 3D Scene menu item in the main menu 

• 3D Scene Viewer in a separate window (Figure 10.7) 

• 3D Scene theme list. 
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Figure 10.6: Working window of ArcView in the course of 3D visualization 
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Figure 10.7: Window in which the 3D model is constructed 

 

Figure 10.8: Icon row of 3D visualization 

In the new theme list (3D Scene1) the themes can be switched on and off in the usual way (tick in the box at the 

top left corner of the theme) and they occur accordingly in the 3D display window as well. In this all themes 

appear, however, only the 3D ones will appear in reality (see the previous sub-chapter) the rest will be placed 

below them in one plane, i.e. they will be invisible (popping out a little along the margins)! 

The following functions are available from the icon row in the top part of the 3D Scene1-Viewer window: 

1. Identify: identification of an object, operates only in the case of contents outside the elevation model. 

2. Select Features: objects can be highlighted, operates only in the case of contents outside the elevation model. 

3. Select Graphics: element groups can be highlighted, operates only in the case of contents outside the 

elevation model. 

4. Navigate: function to rotate the 3D model. Moving the cursor with the left mouse button pressed the vertical 

angle of the view while moving the cursor left-right the horizontal angle of the view change. In default 

settings this is the active icon. 

5. Zoom to Full Extent: zooming in or out the entire 3D model so that it occupies the full 3D view window. 

6. Zoom to Active Theme(s): zooming in or out the active theme so that it occupies the full 3D view window. 
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7. Zoom to Selected: zooming in or out the selected object within the theme so that it occupies the full 3D view 

window. 

8. Zoom In: unit zooming in (compared to the centre of the view). 

9. Zoom Out: unit zooming out (compared to the centre of the view). 

10. Rotate Viewer: rotates the 3D model completely (for several times as well). Rotation is not continuous. 

It is performed by a unit angle. He command is continuous, i.e. it lasts until the user stops it using the Stop 

button in the right bottom part of the ArcView working window. 

11. Save as Image: saves the actual view as a raster image file. After setting the command the file type of 

the raster image has to be given first (Figure 10.9) that is very limited in the older software version. Only one 

uncompressed (bmp) and one compressed (jpg) format can be selected. 

 

Figure 10.9: Defining the file type of the raster image of the 3D model 

The next step is to define the resolution (Figure 10.10). In the course of this the width (in pixels) of the image 

has to be given, the height will be adjusted to it automatically. With increasing resolution the quality of the 

image will be better, however, file size also increases quadratic. 

 

Figure 10.10: Defining the resolution of the raster image of the 3D model 

Finally, the saving location has to be given (Figure 10.11) with the acceptance of which the raster image is 

created. 
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Figure 10.11: Defining the saving location of the raster image 

Animation 10.1 shows the 3D motion picture of the model area composed of 73 pieces of image with one unit of 

rotation between the phases. 

 

Animation 10.1: 3D model of the model area 

9.3. Determination of height distortion 

The model constructed based on the default settings contains proportional values in all three directions. This 

results in less striking images in the case of greater areas or smaller height differences. In our example the 

model area has an extension of 18x18 km and the greatest height difference is 420 metres: this landscape seems 

to be very flat with real data (Figure 10.7). Therefore it is a common practice in geomorphology to apply height 

distortion, i.e. distortion of the height values. The magnitude of this depends on the relief: in the case of a more 
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dissected area it can be 5-10 times while in the case of a flat area it can be several ten times. This method has to 

be handled carefully though: selecting a too great value will disturb the viewer - the gentle hills may become 

high peaks of a mountain with a value of one hundred for example (10.2. animation)! 

 

Figure 10.12: Parameters of 3D visualization 

For defining the vertical distortion apply the 3D Scenes → Properties command that opens the 3D Scene 

Properties window (Figure 10.12) in which the following parameters can be given: 

• Name: name of the 3D model. Its filling is not compulsory, any name can be given. 

• Creator: name of the creator. Its filling is not compulsory, any name can be given. 

• Creation date: date of the creation of the 3D model. It is generated automatically, it cannot be modified. 

• Map units: unit system of the theme, i.e. the distance of the unit has to be given here. The value of the theme 

from which the 3D model was created is offered automatically. (For details on the setting of the unit system 

and its significance see chapter 6.) 

• 2D projection: the projection system of the theme can be set. The type of the theme from which the 3D model 

was created is offered automatically. 

• Vertical exaggeration factor: value of distortion can be given here from the scroll down menu. 

• Background color: colour of the area surrounding the 3D model. The desired value can be selected by 

clicking on the Select… button. 
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• Sun azimuth: direction - horizontal - of illumination. It can be given from the scroll down menu based on the 

points of the compass or by giving a concrete angle value in the „at … degrees” window part. 

• Sun altitude: height of illumination. It can be given in degrees or by giving a concrete angle value in the „at 

… degrees” window part. 

• Comments: any comments can be made on the model, however, its filling is not compulsory. 

Figure 10.12 displays the model area with five-fold vertical distortion and with angles of illumination offered 

automatically. 

 

Figure 10.12: 3D model of the model area with fivefold vertical distortion 
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10.2. animation:  3D model of the model area with changing vertical distortion 

Controlling questions 

Self controlling questions: 

How is the 2D theme attributed with height values? 

How is a 3D model created from a TIN model? 

How can be vertical distortion given? 

Test: 

Which option shall be selected if height values are from a digital elevation model? 

a, Surface 

b, Attributes 

c, Constant 

What new menu item occurs in the main menu when the 3D display command is selected? 

a, Elevation 

b, 3D Scene 

What happens if we would like to display a theme without height data? 

a, We receive an error message 

b, Nothing happens 

c, The theme will occur in the theme plain 

10. Operations with raster files 

The chapter discusses a few important queries from raster files and their preparation necessary for the queries. 

10.1. Simple map queries 

Regarding the content of raster files it is possible to obtain answers for simple questions (yes/no) and display the 

results using the Map Query function. 

In our example the extent of an area above or under a given height is determined based on the digital elevation 

model, however, the procedure is the same in the case of any raster file. Following the Analysis → Map 

Query… command the parameters of the query can be defined in the appearing window (Figure 11.1). 
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Figure 11.1: Window of map query at the beginning 

Parts of the Map Query window (Figure 11.1): 

• Layers: the raster themes - containing spatial data - are found here that are suitable for this type of operation; 

layers containing vector object type (point, line or polygon) are missing (e.g. layers of contour line, drainage 

network, infrastructure). 

• Upper middle part: relational operations that will be active only after the selection of the appropriate values. 

• Unique Values: values of the theme to be selected later. They are empty at the beginning. After selecting the 

theme it will change to the script Sample Values. 

• Update values: when switched on (indicated by a tick) the calculated values are updated corresponding to the 

changes in the database on which the calculation is based. 

• Lower part: the desired operations (will be presented later). 

• Evaluate: accepting the procedure, the command for the execution of the calculation. 

First, select the theme on which the calculation is based (left click on the appropriate name in the Layers part, 

black background indicates it) then the associated values appear in the Sample Values part. In our example uses 

the GRID elevation model therefore values represent height above sea level (Figure 11.2). 
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Figure 11.2: Map query window after selecting the theme 

Then give the parameters of the query, paying attention to the adequate punctuation characters and selection 

methods: 

• Double left click and simple left click are necessary on themes, values and on relations respectively. 

• In the case of complex queries the positioning of the brackets can cause problems. Figure 11.3 shows a 

relation composed of two parts. Both of them have to be in brackets so that we have to click after each part 

and then select brackets. Correct order of input is presented in animation 11.1 where the aim is to show the 

areas above 305-410 metres above sea level based on a digital elevation model (GRID format). 

After determining the formula, select the Evaluate command. In the case of inadequate format either an error 

message (Figure 11.4) or a completely wrong map will appear (for example the entire map will be classified 

into one class). 
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Figure 11.3: Conditions of map query 

 

Figure 11.4: Syntax error 
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Animation 11.1: Using the map query 

The results will be displayed on a map on which the pixels can take three values (Figure 11.5): 

• False: the pixel does not meet the given conditions. 

• True: the pixel meets the given conditions. 

• No Data: those parts that are outside the map are meant by it generally. 

Not only maps can present the results (Figure 11.5) but concrete values can be determined as well. For the latter 

open the edit window of the result theme (double left click) - the number of pixels in the categories can be seen 

when categorizing (Figure 11.6). From this only percentage can be calculated directly, however, spatial extent 

depending on the pixel size can be determined as well (chapters 8 and 9). 
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Figure 11.6: Result of map query 
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Figure 11.7: Edit window of the result map of the map query 

10.2. Re-classification 

Either separately or as a part of a more complex operation series (e.g. preparing coverages) the re-classification 

of the values of the raster map may become necessary. This is more than the - already presented - classification 

of the original data. In the course of a simple classification the calculated values are not changed they are placed 

in a new category only during display. In contrast, when values are re-classified new values are attributed to the 

new categories (and to the pixels belonging to the category). In our examples the process is described via the re-

classification of - raster - thematic maps prepared on the basis of two different digital elevation models (slope 

category, slope aspect - for the creation of these see chapter 9) and the process is similar in the case of any raster 

theme. 

10.2.1. Re-classification of slope category maps 

The aim of the re-classification of the slope category map (chapter 9.1) in our case is the creation of a map that 

classifies the area into only two categories: gentle sloping (0-5%) and sloping (above 5%). 

As a first step select the theme to be re-classified (in our example the slope category map) since no changes can 

be made later. Then apply the Analysis → Reclassify… command: new categories and the associated values can 

be defined in the Reclassify Values pop-up window (Figure 11.8) 
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Figure 11.8: Window of re-classification with the values offered automatically 

Parts and setting of the Reclassify Values window are the following: 

• Classification field: the column on the basis of which re-classification is made. In our example only the Value 

column belongs to the slope category map therefore nothing else can be selected. 

• Classify…: selecting re-classification 

• Table: in the centre of the window categories can be seen in a table. The original values (in degrees in the 

example) of the initial map are contained in the Old Values column. These are not the same necessarily as the 

values seen in the display - because as it was mentioned the classification does not change the original values 

in the course of the display! New values can be given in the New Value column. 

• Puss button: new data set can be added to the table. 

• X button: dataset can be deleted. For this click first in the empty field (small field to the left) in front of the 

dataset. In this way the entire row is highlighted (characters appear with black background) - if we click on 

the value field itself selection is not active. 

• Load: already existing classification cliché can be loaded (for handling see chapter 8.1.3). 

• Save: classification values modified or created as new can be saved into a cliché. 
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First, select the Classify… command that will open the Classification window (Figure 11.9) where a few 

characteristics of the re-classified categories can be given (similar to the palette editing presented in chapter 

8.1.3): 

• Type: method of category boundary change in the case of automatical re-classification. The roll down 

window in our example offers only the Equal Interval option. 

• Number of classes. 

• Round values at: number of decimal values d letters after d. indicate their number. 

 

Figure 11.9: Defining the value distance of re-classification 

Define two categories in our example with four decimal rounding. After accepting this we get back to the 

Reclassify Values window where the limits (Old Values column) of the new categories can be given together 

with the new values (New Values column) attributed to them in the table. In our example the software calculates 

slope category in degrees while we give the value in percent (2.824° = 5%). Figure 11.10 shows the new values. 
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Figure 11.10: Reclassification window with the new values 

After accepting the parameters the raster result map will appear as a separate theme (Figure 11.11). In our 

example value 1 displayed in green represents those parts of the area that meet the criteria (i.e. have a sloping of 

0%-5%) while yellow represents the rest of the area. In the current example blue colouring - as an information - 

marks the elements of hydrography that can be found in a separate layer, i.e. it does not influence the result, it 

can be switched off at any time. 
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Figure 11.11: Result of the re-classification of the slope category map (for explanation see the text) 

10.2.2. Re-classification of the slope aspect map 

The aim of the re-classification of the slope aspect map (chapter 9.2) in our example is to create a map on which 

the area is divided into three categories: northern, neutral (eastern and western) and southern aspect - this is an 

agricultural view of classification (as northern slopes receive the least amount of insolation while southern 

slopes receive the most amount of insolation while eastern and western slopes are in-between the two and 

receive more-or-less equal amount of sunlight). 

As an initial step select the theme to be re-classify (the slope aspect map in our case) and apply the Analysis → 

Reclassify… command. The Reclassify Values pop-up window new categories and associated values (Figure 

11.12) can be determined as presented before (chapter 11.2.1). 
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Figure 11.12: Window of re-classification with the automatically offered values 

Provide six categories in our example (with round values). Though the result will be three categories the 

following technical problems can be solved only by defining six: 

• Determination of the southern direction is simple as it is situated symmetrically in both directions from the 

southern direction, lasting from 135° till 225°. 

• In the result there will be only one category from the northern direction, however, as it ranges into two 

directions from 0° it can be given only in two parts - in two rows - from 0° to 45° and from 315° to 360°. 

• The eastern slopes can also be given without separation (45°-135°), however, the same value will be 

attributed to it as to the western slopes. 

• To the western slopes (225°-315°) the same values are attributed as to the eastern ones. 

• Note that the flat areas are not classified on a slope aspect map (there is no point to talk about slope aspect) 

therefore a new category is required where slope aspect takes (due to technical reasons) the values between -

1° and 0°. The new values attributed to this are determined by the purpose. If appropriate from the final 

criteria point of view this property may have values higher than zero but if not it will receive 0. For example 

in the case of an agricultural assessment both the completely flat and gentle sloping areas are advantageous 

therefore they can have higher values but in the current example, taking the conditions more strictly (no slope 

aspect can be determined in the case of a flat area) these are taken out of classification (receiving the value 0). 
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It is clear in the case of the slope aspect map that the values following each other (increasing) may not be 

increasing any more in the case of re-classification. The starting direction of the original scale ranging from 0° 

to 360° will have the (northern) value of 0, the southern direction in the middle of the scale receive 0 value and 

the southern slopes in between the two receive value 2 and the neutral values receive value 1. Figure 11.13 

presents the new values. 

 

Figure 11.13: Window of re-classification with the new values 

Following the acceptance of the parameters the resultant map will appear as a separate theme (Figure 11.14). In 

our example the areas represented by value 2 are the best southern aspect, the pink (value 1) colouring 

represents the less beneficial eastern and western aspect while the non beneficial conditions of the northern 

slopes (value 0) are represented by yellow colouring, including also the flat areas taken out of classification. In 

our example blue colouring - only for providing information - indicate hydrographical elements included on 

separate layers, i.e. the result is not influenced by them, they can be switched off at any time. 
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Figure 11.14: Result of the re-classification of the slope aspect map (for explanation see text) 

10.3. Complex queries (coverages) 

For the operations the re-classified maps based on the original themes could be required the creation of which is 

presented in chapter 11.2. Various mathematical operations can be executed between the themes that are 

obtained from the relations of the pixels of each theme (mostly addition and multiplication). It is important to 

have maps as the bases for the operation with similar co-ordinate systems, similar areas and parameters (e.g. 

pixel size) as they can be covered by each other only in this way. In our example the aim is to create a map that 

presents the gentle sloping parts facing south of the area (e.g. in order to determine the ideal production area of a 

plant). For this two re-classified maps are required: 

• Slope category map where value 0 represents the sloping (above 5%) while value 1 represents the gentle 

sloping (0%-5%) areas (for details see sub-chapter 11.2.1). 

• Slope aspect map on which three categories are determined (0 - northern and flat, 1 - eastern and western, 2 - 

southern slopes) - (for details see sub-chapter 11.2.2). 
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The number of initial maps is not limited. In our example not only the mentioned two factors (steepness and 

aspect) can be considered on an agricultural map but for example soil, precipitation and temperature conditions 

as well. 

Why re-classified maps are necessary? In the course of the queries the themes are categorized (re-classified) and 

values are attributed top them in accordance with the aims. The operations are performed between the pixel 

values of the covered areas. In other words if two areas contain only two types of values (an area is appropriate 

or not, indicated by values 1 and 0). A common value has to be calculated from the areas covering each other 

(for example by multiplication): 

• If both are appropriate the result is reasonable. 

• If only one of them is appropriate, the result is apparently not appropriate. 

• If neither are appropriate then naturally the result is not appropriate. 

Illustrating the process on a simple example: we would like to determine the optimal location of planting a plant 

and consider only sloping and aspect. The area is only appropriate if the values are appropriate separately. If 

only one of the two is appropriate the result will not be appropriate. For example if the slope faces the optimal 

direction but too steep plantation is not possible on the slope due to erosion. The new values calculated from the 

original ones without re-classification would not be interpretable: for example if the 5% slope is multiplied with 

the 160° of slope aspect nothing will be obtained! 

The first step of creating the coverage is the Analisys → Map Calculator… command that opens the Map 

Calculation window (Figure 11.15). 

 

Figure 11.15: Map calculation window 

Parts of the Map Calculation window: 
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• Layers: raster theme, the basis of the calculation. 

• Upper central part: numerical keyboard and operational marks for expressions. 

• Right top roll down menu: types of operations: 

•  

• Bottom frame: commands of the desired operations appear. 

• Evaluate: acceptance of the menu and command for executing the menu bar. 

Select the theme for the calculation to establish coverages. Note that although all themes appear twice they are 

not the same (they cannot be viewed better due to the width of the window) with the same number: 

• The top ones end as „tin”, this is the optimal selection for us. 

• The lower ones end as „count”. 

The theme is selected by a left click on it. It will appear in the bottom frame (the complete name of the theme 

can be seen now). Then select the desired operation type (from the drop down menu) and the concrete operation 

as well - in our example this is multiplication. Finally select the second unit of the expression from the Layers 

list similarly to the first one. Figure 11.16 presents the map calculation window with the desired calculation. 

Naturally the expression can have several members if several themes or operations are required. Using relational 

signs similar conditions has to be noted as in the case of re-classification (chapter 11.2) - appropriate use of 

brackets has to be considered primarily! Calculation is preformed after applying the Evaluate command. 

 

Figure 11.16: Map calculation window 

After accepting the calculation parameters the raster result map will appear as a separate theme (Figure 11.17). 

The three colours indicate the sum values (suitability): 



 Environmental Informatics  

 186  
Created by XMLmind XSL-FO Converter. 

• Green colour (value 2) represents the most suitable areas. This received the maximum values on both maps - 

i.e. southern gentle slopes. 

• Pink colour (value 1) represents areas where both initial values were at least adequate (both had value 1 - in 

this case gentle eastern or western slopes). 

• Yellow (value 0) represents areas where at least one of the values was not adequate - i.e. any of the two 

conditions was not adequate the area received 0 value independent of the other (due to the multiplication). 

In the present case blue colouring represents - only to give some information - hydrographic elements that can 

be found in a separate layer, i.e. it does not influence the result and can be switched off at any time. 

 

Figure 11.17: Result map of the coverage operation 

Naturally the map calculation command enables the possibility of numerous other operations but their detailed 

presentation is not possible in this textbook. 

Controlling questions 

Self controlling questions: 
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How is it possible to show an area above a certain level from an elevation model? 

How is re-classification made? 

What is the process of coverage creation? 

Test: 

Which is the command for simple map query? 

a, Map Query 

b, Map Calculator 

What is the difference between re-classification and categorization applied at visualization? 

a, Pixel values are changed in the course of categorization at visualization 

b, Pixel values are changed at re-classification 

Which is not a condition of executing a coverage operation between themes? 

a, Similar projection system 

b, Similar colouring 

c, Similar pixel size 

11. Queries from vector and raster files 

The chapter presents a few important queries and transformation from vector and raster files. 

11.1. Spatial statistics based on TIN model 

With the help of the application the spatial extent of an area above or under a certain height above sea level can 

be determined based on the TIN model. 

In the Area and Volume Statistics window (Figure 12.1) appearing following the Surface → Area and Volume 

Statistics… command enter the base height from which areas and volume will be calculated. The value is height 

above sea level in metres (if the view is in metre scale). 

 

Figure 12.1: Defining the base height 

In the next step the position of the area is determined compared to the height defined previously (above or 

below) (Figure 12.2). 
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Figure 12.2: Determination of the sense of calculation (volume) 

Following the setting and accepting of the parameters the desired values appear in text format in a new window 

the content of which is the following (Figure 12.3): 

• Planimetric Area: plane extent (projection) of the determined area (in m2). 

• Surface Area: real extent of the surface of the determined area (in m2). This considers the relief conditions as 

well (it is apparent that the horizontal projection of a slope is smaller than the real area of the slope). 

• Volume: volume of the determined area 

The base height and the sense of measurement are also included as a reminder (Calculated ABOVE base height 

of 200). 

The window disappears when the OK is pressed. Data are not saved (it has to be made manually). 

 

Figure 12.3: Concrete values of area and volume 

11.2. Vector set operation 

The sub-chapter discusses a few vector operations used frequently in which interaction takes place within the 

themes or between them. Operations may be based on geometric data, attributes or both. 

Operation types can be accessed via the GeoProcessing window opened by the View → GeoProcessing 

Wizard… command (this first step is not mentioned later). 

11.2.1. Dissolve 
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The operation aggregates separate objects into a greater unit based on one of their attributes. 

In our example the initial map is the public administration map of Hungary from 1941 on which the smallest 

units are the districts. Display can be based on either the districts (Figure 12.4) or only the counties (Figure 

12.5). In this latter case the border of the districts can be seen as well and in certain cases their elimination may 

be required (for example in a smaller volume the map could become overcrowded). Therefore the aim is the 

fusion of the spatial units: fusion of districts into counties. Basis of the dissolve is the column containing the 

name of the counties in the data table (as all districts are attributed with the county in which they are located). 

 

Figure 12.4: Map selected for fusion, display is based on districts 

 

Figure 12.5: Map selected for fusion, display is based on counties 

In the Geoprocessing window select the Dissolve features based on attribute option (Figure 12.6) then click 

Next to proceed to the next window. 
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Figure 12.6: Selecting dissolve 

Parameters of fusion can be determined in the next window (Figure 12.7): 

• Select theme to dissolve: highlight the theme the objects of which are to be dissolved (offers the active theme 

as a default setting). 

• Select an attribute to dissolve: give the data column on the basis of which dissolution takes place (county 

/„megye”/ in the current example). 

• Specify the output file: name and saving location of the theme to be formed can be given in the window 

appearing when the folder sign is clicked. 

Proceed with clicking Next. 
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Figure 12.7: Defining the parameter of dissolve 

In the last step (Figure 12.8) the list of those data can be defined - not compulsory - that we would like to retain 

in the new file. Calculation takes longer or shorter time after pressing Finish. A clock and a text describing the 

process can be seen in the meantime. 
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Figure 12.8: Determining auxiliary data 

Figure 12.9 presents the new theme in which the objects have been changed: in our example the smallest unit 

became the county. 

 

Figure 12.9: Result of dissolve 

11.2.2. Merging 
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Using the merge function the contents of several themes can be merged into one single theme in which the 

attributes are inherited according to the data of one of the selected themes. This function can be very useful 

when map parts vectorized separately - and in several files - are joined. 

In our example the merging of four parts of a map segment digitised separately are joined (Figures 12.10 and 

12.11). (As a matter of fact, the map parts can be merged directly in AutoCAD as well as shown in chapter 4.8.) 

 

Figure 12.10: Contour lines of the initial map segment vectorized in four parts (according to the colours) 
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Figure 12.11: Errors in the joining points along the border of the four parts 

Select the Merge themes together object in the GeoProcessing window (Figure 12.12) then proceed clicking 

Next. 
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Figure 12.12: Selecting merge 

In the next window the parameters of merge can be determined (Figure 12.13): 

• Select at least two themes to merge: selection of the themes to be merged. Click on the themes to be merged 

in the list with the left mouse button and with pressing Shift. 

•  

• Specify the output file: clicking on the folder sign a window appears in which the name and saving location of 

the theme to be formed can be given. 

The command is executed pressing the Finnish button and the new theme is formed. After the merge the joining 

and merging of the line ends along the connection is practical (for line editing see chapter 5). 
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Figure 12.13: Defining the parameters of the themes to be merged 

11.2.3. Clip 

The clip function can take a part of a theme if a theme containing a polygon covering the area to be taken is 

available: as a result of the operation the clipped area is taken into a new theme while the original one remains 

unchanged. This function is used generally when the area to be analysed and the map are not the same. The base 

map is frequently - around - rectangular while the model area can be of different shape (e.g. a public 

administration area or an area adjusted to a natural unit - a country, a county, a catchment area, etc.).The objects 

of the unchanged area inherit the original attributes. Our example present the clip of the catchment area of a 

river from a contour map (on Figure 12.14 the red line shows the part of the catchment area that is located on the 

given map segment). 
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Figure 12.14: Base map of clip with the border line 

For the operation select the ’Clip one theme based on another’ option in the GeoProcessing window (Figure 

12.15) then proceed to the next window by clicking Next (Figure 12.16). 
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Figure 12.15: Selecting Clip 

Parts of the GeoProcessing window appearing second are the following (Figure 12.16): 

• Select input theme to clip: selecting the theme from which Clip takes place - in the default setting this is the 

active theme. 

• Select a polygon overlay theme: selecting the theme containing the polygon covering the area to be Clipped. 

In case the theme contains more than one polygon every area covered by them will be Clipped at the default 

setting - except for the application of „Use Selected Features Only” because in this case only the areas will be 

Clipped that are covered by the selected objects. 

• Specify the output file: name and saving location can be given in the window appearing when the folder sign 

is clicked on. 
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Figure 12.16: Defining the parameters of Clip 

After defining the parameters the operation is executed by clicking on the Finish button. The new theme is 

presented in Figure 12.17. 
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Figure 12.17: Result of Clip 

11.3. Buffer zone 

The buffer zone means a zone within a certain distance from an element. Display is in a map. 

In our example the aim is to determine the one kilometre wide zone of roads in an area. For the operation use the 

Theme → Create Buffers… command that opens the first window of Create Buffers (Figure 12.18) in which the 

objects can be identified around which the buffer zone is to be created (What do you want to buffer?): 

• The graphics in your view: comparison will be made to a newly created object. 

• The features of a theme: at default settings the calculation of the buffer zone is made from all of the elements 

of the theme selected from the dropdown menu. In our example this is to be selected (the theme containing 

the roads). 

• Number of features: number of objects in the theme selected in the previous point. 
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• Number of features selected: one or several objects can be selected as bases for the calculation (selection is 

made in the next point). 

• Use only the selected features: in case one or several objects are selected (the number is indicated in the 

previous point) this option enables calculation to be made only in relation to these. 

Proceed with clicking Next. 

 

Figure 12.18: First window of creating buffer zone 

In the second window (Figure 12.19) of creating a buffer zone the size of it can be given. Three options can be 

selected: 

• At specified distance: size of the zone can be determined by entering a concrete value. The value is in the unit 

defined in the bottom of the window! In our example this one is selected. 

• At a distance from an attribute field: distance calculated from the values of one of the columns of the data 

table. The value can be determined in the dropdown window. 

• As multiple rings: In the case of the previous two options only one zone will be created. Using this option 

several zones can be formed parameters of which are the following: 

•  

• Distance units are: unit system can be defined by selecting from the dropdown menu. 

Proceed with clicking Next. 
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Figure 12.19: Second window of creating a buffer zone 

In the third window of creating a buffer zone (Figure 12.20) the characters of the buffer zone can be given: 

• Dissolve barriers between buffers?: in case the buffer zone is defined around several elements in this menu 

their joining (Yes or No) can be decided. In our example select Yes. 

• Where do you want the buffers to be saved?: the format of the buffer zone can be given, the options include: 

•  

The operation is executed by pressing the Finish button and the result is shown in Figure 12.21. 
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Figure 12.20: Third window of creating a buffer zone 
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Figure 12.21: Result of the buffer zone calculation (with a relief background and with highlighting the roads 

providing the basis for the calculation) 

Controlling questions 

Self controlling questions: 

How are the areas above or under a given level are selected on the basis of the elevation model? 

How are features merged based on their attributes? 

How can be a buffer zone created? 

Test: 

A Which GeoProcessing operation merges themes together? 

a, Dissolve features based on an attribute 

b, Merge themes together 

c, Intersect two themes 
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Regarding GeoProcessing operations what does the „Clip one theme based on another” option mean? 

a, Joining 

b, Cutting with copy 

In the course of buffer zone calculation in which case will be the result polygon object type? 

a, When it is displayed in the view 

b, When it is displayed as a separate theme 
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